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Getting Started
Supported Platforms

This page shows the supported platforms for Crucible 2.10.x and its minor releases.

Key: B = Supported; EJ = Not Supported

Java Version

JRE / JDK 1.6
1.7

Operating Systems

Microsoft Windows

Linux

Apple Mac OS X

Databases

MySQL MySQL Enterprise Server 5.x
MySQL Community Server 5.x

Crucible requires Java Runtime (J
DK or JRE), version as noted.
Pre-release/Early access versions
of the Java Runtime are not
supported.

You can download a Java Runtime
for Windows/Linux/Solaris. On
Mac OS X, the JDK is bundled
with the operating system.

We highly recommend that you
use the Oracle JVM (or use the
default Mac OS X JVM), as other
implementations have not been
tested.

Please note:

® Once you have installed the
JDK, you need to set the JAVA_
HOME environment variable.
See Installing Crucible on
Windows or Installing Crucible
on Linux and Mac for details.

® |f you are using a 64-bit JVM,
please ensure that you've set
your max heap size (- - Xnx) to
a reasonable value, considering
the RAM requirements of your
system.

Crucible is a pure Java application
and should run on any platform
provided the requirements for the
JRE or JDK are satisfied.

FishEye supports a number of
external databases, as listed. See
the Crucible Database
documentation for further details.
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PostgreSQL
Oracle

SQL Server

HSQLDB (2)

Web Browsers

Microsoft Internet Explorer

Mozilla Firefox

Safari

Chrome

Version Control Systems

Subversion (SVN)

CVS (and CVSNT)
Perforce (P4)
Git

Mercurial (Hg)

8.2,8.3,8.4
119
2005, 2008, 2008 R2

Bundled; for evaluation use
only

8.0,9.0
6.0 and 7.0 are not supported

Latest stable version supported

3.6, 4.0

Latest stable version supported

[

Latest stable version supported

Server 1.1, 1.2, 1.3, 1.4, 1.5,
1.6.1.7

All versions

Client version 2007.3 or later
Server version 2005.1 or later

1.7.1.1 or later

1.5.1 or later

Deployment Notes for Source Code Repositories

For MySQL:

® For 5.0, version must be 5.0.21
or later

® For 5.1, version must be 5.1.10
or later

The Crucible built-in database,

running HSQLDB, is somewhat
susceptible to data loss during

system crashes.

We recommend that you do not
use HSQLDB for production
systems.

External databases are generally
more resistant to data loss during
a system crash and are more
suited for production use.

The client uses SVNKit or native
JavaHL.

The Server must support the ztag
tagged protocol.

Mercurial 2.1 has a bug that
makes it incompatible with
Crucible. Please use Mercurial
2.1.1 or later.
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Crucible can also store uploaded files in its own database, removing the need for any kind of repository. A
number of external databases are supported when Crucible is used with FishEye. See the FishEye Supported
Platforms.

End of Support Announcements for Crucible

This page contains announcements of the end of support for various platforms and browsers when used with
Crucible. This is summarised in the table below. Please see the sections following for the full announcements.

End of Support Matrix for Crucible

Platform Crucible End of Support
MySQL 5.0 January 2012

PostgreSQL 8.0 and 8.1 January 2012

IBM ClearCase (all versions) 4 April 2012 (announcement)

The table above summarises information regarding the end of support announcements for upcoming Crucible
releases. If a platform (version) has already reached its end of support date, it is not listed in the table.

i ] Why is Atlassian ending support for these platforms?

Atlassian is committed to delivering improvements and bug fixes as fast as possible. We are
also committed to providing world class support for all the platforms our customers run our
software on. However, as the complexity of our applications grows, the cost of supporting
multiple platforms increases exponentially. Each new feature has to be tested on several
combinations of application servers, databases, web browsers, etc, with setup and ongoing
maintenance of automated tests. Moving forward, we want to reduce the time spent there to
increase Crucible development speed significantly.

On this page (most recent announcements first):

Deprecated Database Support for Crucible (4 October 2011
Deprecated Web Browsers for Crucible (21 March 2011)
Deprecated Java Platforms for Crucible (21 March 2011)
Deprecated SCM Repository Support for Crucible (4 April 2011)

Deprecated Database Support for Crucible (4 October 2011)

This section announces the end of Atlassian support for certain databases for Crucible.

We will stop supporting older versions of databases as follows:

® For the next major version of Crucible, in January 2012, support for MySQL 5.0, PostgreSQL 8.0 and 8..
will end.

Please refer to the Supported Platforms for more details regarding platform support for Crucible. If you have
questions or concerns regarding these announcements, please email eol - announcenent at atl assi an

dot com
Database Support End Date
MySQL 5.0 January 2012
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PostgreSQL 8.0 and 8.1 January 2012

End of Support Notes for MySQL 5.0 and PostgreSQL 8.0 and 8.1:

® Atlassian intends to end of life support for MySQL 5.0, PostgreSQL 8.0 and 8.1 in January 2012. The
release of Crucible after January 2012 will not support MySQL 5.0, PostgreSQL 8.0 or 8.1.

®* As mentioned above, the releases of Crucible before January 2012 will contain support for MySQL 5.0
and PostgreSQL 8.0 and 8.1.

Deprecated Web Browsers for Crucible (21 March 2011)

This section announces the end of Atlassian support for certain web browsers for Crucible.

We will stop supporting older versions of web browsers as follows:

® From Crucible 2.6, due in May 2011, support for Internet Explorer 7 will end.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for
Crucible. If you have questions or concerns regarding this announcement, please email eol - announcenent
at atlassian dot com

End of Life Announcement for Web Browser Support

Web Browsers Support End Date

Internet Explorer 7 When Crucible 2.6 releases (target May 2011)

Internet Explorer 7 Notes:

® Crucible 2.5 is the last version to officially support Internet Explorer 7.

® Crucible 2.6 is currently targeted to release in May 2011 and will not be tested with Internet Explorer 7.
After the Crucible 2.6 release, Atlassian will not provide fixes in older versions of Crucible for bugs
affecting Internet Explorer 7.

Deprecated Java Platforms for Crucible (21 March 2011)

This section announces the end of Atlassian support for certain Java Platforms for Crucible.
We will stop supporting the following Java Platforms:
® From Crucible 2.6, due in May 2011, support for Java Platform 5 (JDK/JRE 1.5) will end.

We are ending support for Java Platform 5, in line with Sun's Java SE Support Road Map (i.e. "End of Service
Life" for Java Platform 5 dated October 30, 2009). We are committed to helping our customers understand this
decision and assist them in updating to Java Platform 6, our supported Java Platform.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for
Crucible. If you have questions or concerns regarding this announcement, please email eol - announcenent
at atl assian dot com

End of Life Announcement for Java Platform Support

Java Platform Support End Date
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Java Platform 5 (JDK/JRE 1.5) When Crucible 2.6 releases, due May 2011

Java Platform 5 End of Support Notes:

® Crucible 2.5 is the last version to officially support Java Platform 5 (JDK/JRE 1.5).

® Crucible 2.6 is currently targeted to release in May 2011 and will not be tested with Java Platform 5
(JDK/JRE 1.5). After the Crucible 2.6 release, Atlassian will not provide fixes in older versions of Crucibl
for bugs affecting Java Platform 5 (JDK/JRE 1.5).

Deprecated SCM Repository Support for Crucible (4 April 2011)

This section announces the end of Atlassian support for certain SCM repositories for Crucible. End of support
means that Atlassian will remove all functionality related to certain SCM repositories past the specified date.
Releases before that date will contain the functionality that supports the SCM, however, Atlassian will fix only
critical bugs that affect functionality for that SCM, and will not add any new features for that SCM. After the
specified date, Atlassian will not support the functionality in any version of Crucible.

Please refer to the Supported Platforms for more details regarding platform support for Crucible. If you have
questions or concerns regarding these announcements, please email eol - announcenent at atl assi an

dot com
SCM Repository Support End Date
IBM ClearCase (all versions) 4 April 2012

IBM ClearCase End of Support Notes:

® Atlassian intends to end of life IBM ClearCase functionality on 4 April 2012. The release of Crucible afte
4 April 2012 will not contain any IBM ClearCase functionality.

* As mentioned above, the releases of Crucible before 4 April 2012 will contain support for IBM ClearCast
However, we will only be fixing critical bugs related to IBM ClearCase and will not be adding any feature

® After 4 April 2012, Atlassian will not support IBM ClearCase functionality in any version of Crucible

End of Support Announcement for IBM ClearCase

Support in Crucible for IBM ClearCase ended on April 4th 2012. Crucible 2.8, and later versions, do not have
support for ClearCase.

We have made these decisions to reduce the testing time required for each release and to help us to deliver
market-driven features faster.

You can stay on older versions of Crucible to support your existing installations with ClearCase. However,
Atlassian will not be providing any ClearCase-related support for any Crucible version after 4 April 2012, and ha
s removed all functionality related to ClearCase from Crucible versions released after April 4th 2012. We are
committed to helping our customers understand this decision and to assist you in migrating to a different SCM, if
needed.

For more details about the announcement, please refer to this page: End of Support Announcements for
Crucible.

Installing Crucible on Windows

Hey! We're going to perform a clean install of Crucible on Windows. There are a few steps involved, but we think
you'll find it easy to follow along.

If you already have FishEye installed, you should read Upgrading from FishEye to Crucible instead.

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
http://www-01.ibm.com/software/awdtools/clearcase/
https://confluence.atlassian.com/display/CRUCIBLE/Upgrading+from+FishEye+to+Crucible

User Guide for Crucible 2.10

1. Check supported platforms

Better check the Supported Platforms page first; it lists the application servers, databases, operating systems,
web browsers and JDKs that we have tested Crucible with, and that we recommend.

Atlassian only officially supports Crucible running on x86 hardware and 64-bit derivatives of x86 hardware.

Related pages:

Running Crucible as a Windows service
Upgrading from FishEye to Crucible
Installing Crucible on Linux and Mac

Starting to use Crucible
Supported Platforms

2. Check your version of Java

In a command prompt, run this:

..............................................................................................................................................................................

The version of Java should be 1.6.0 or higher. If you intend to Running Crucible as a Windows service, using the
Java Service Wrapper, you should use 32-bit Java (even on a 64-bit machine), and the JDK rather than the JRE
(so as to take advantage of the - ser ver parameter).

¥ If you don't see Java 1.6.0 or higher, then get Java...
Download and install the Java Platform JDK from Oracle's website.

The Java install path should not contain spaces, so don't install into C:\Program Files\Java\.
Instead, use a path like C:\Java.

Now try running 'j ava - ver si on' again to check the installation. The version of Java should be
1.6.0 or higher.

3. Check that Windows can find Java

Windows uses the JAVA_HOME environment variable to find Java. To check that, in a new command prompt,
run:

..............................................................................................................................................................................

You should see a path to the Java install location that does not contain spaces. We recommend that
JAVA_ HOME should point to the Java executable in your PATH.

¥ If you don't see a path without spaces...
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® If you see a path with spaces, like C:\ Program Fi | es\ Java\, then sorry, but go back
to 2. and reinstall Java to a location that doesn't have spaces.

® |f you don't see a path at all, or if you just see %JAVA HOME%, then set JAVA_HOME as
follows:

For Windows 7:

1. Go to Start, search for "sys env" and choose Edit the system environment variables.

2. Click Environment Variables, and then New under 'System variables'.

3. Enter "JAVA_HOME" as the Variable name, and the absolute path to where you installed
Java as the Variable value. Don't use a trailing backslash. We recommend that
JAVA HOME should point to the Java executable in your PATH.

4. Now, in a new command prompt, try running '%ad AVA_HOVE% bi n\j ava -version'. You
should see the same version of Java as you saw above.

4. Create a dedicated Crucible user (recommended)

For production installations, we recommend that you create a new dedicated Windows user that will run Crucible
on your system. This user:

¢ Should not have admin privileges.

® Should be a non-privileged user with read, write and execute access on the Crucible home (install)
directory and instance (data) directory. These directories are described below.

® Should only have read access to your repositories.

If you created a dedicated Crucible user, ensure you are logged in as this user to complete the remaining
instructions.

5. Now it's time to get Crucible

Download Crucible from the Atlassian download site.

Extract the downloaded file to an install location:

® Folder names in the path to your Crucible executable should not have spaces in them. The path to the
extracted directory is referred to as the <Fi shEye home di rect ory> in these instructions, for
compatibility with the FishEye install instructions.

® |f you expect to have a large number of users for this Crucible installation, and Crucible will be connected
to an external database, consider installing Crucible on a different server from the one running the
external database, for improved performance.

6. Tell Crucible where to store your data
The Crucible instance directory is where your Crucible data is stored.

You should not locate your Crucible instance directory inside the <Fi shEye hone directory> — these
should be entirely separate locations. If you do put the instance directory in the <Fi shEye hone directory>
it will be overwritten, and lost, when Crucible gets upgraded. And by the way, you'll need separate Crucible insta
nce directories if you want to run multiple copies of Crucible.

Create your Crucible instance directory, and then tell Crucible where you created it by setting a FI SHEYE | NST
environment variable, as follows:

For Windows 7:

1. Go to Start, search for "sys env" and choose Edit the system environment variables.
2. Click Environment Variables, and then New under 'System variables'.
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3. Enter "FISHEYE_INST" as the Variable name, and the absolute path to your new Crucible instance
directory as the Variable value. Don't use a trailing backslash.

4. Now copy the newly extracted <Fi shEye hone directory>\config.xnm file to the root of your new
FishEye instance directory.

@ Note that if Crucible is run as a Windows service using the Java Service Wrapper, Crucible-specific
environment variables such as FI SHEYE_| NST are ignored — these must be set in the wrapper.conf file. See Ru
nning Crucible as a Windows service .

If you have a large number of repositories, we recommend you increase the default number of files that Crucible
is allowed to open. See the following knowledge base article for more info: Subversion Indexer Paused with "Too
many open files" Error.

7. Start Crucible!

In a command prompt, change directory to <Fi shEye hone di r ect or y> and run this:

..............................................................................................................................................................................

After a few moments, in a web browser on the same machine, go to http://localhost:8060/ (or, from another
machine, type htt p: / / host nane: 8060/ , where host nane is the name of the machine where you extracted
Crucible).

Enter your license, then an admin password, to finish the setup.

You can postpone setting up JIRA integration until later if you wish; see Configuring JIRA integration in the
Setup Wizard.

8. Connect to an external database (recommended)

If you intend to use this Crucible installation in a production environment, it is highly recommended that you use
one of the supported external databases. See Migrating to an external database.

If you are evaluating Crucible, or don't wish to do this now, Crucible will happily use its embedded database, and
you can easily migrate later.

9. Set up your mail server

Configure the Crucible email server so that users can get notifications from Crucible. See Configuring SMTP.

10. Add users and repositories

Now is the time to set up your users in Crucible, and to tell Crucible about any existing repositories you have.
Please read Starting to use Crucible for the details.

Crucible will perform an initial index of your repositories, during which it accesses, indexes and organises a view
of your repositories (including all historical items) back to the earliest commits. If you are evaluating Crucible, we
suggest that you index a single project, so you can use Crucible as soon as possible. If you choose to index your
entire repository, be aware that this can take a long time (possibly days) for massive or complex repositories and
can be more complex to set up (especially for Subversion). The basic process is slightly different for each SCM

type.

11. Stop Crucible (optional)

In a command prompt, change directory to <Fi shEye home direct ory> and run this:
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..............................................................................................................................................................................

Running Crucible as a Windows service
Crucible can be run as a service under Microsoft Windows using a Java Service Wrapper.

The service wrapper provides the following benefits:

® Allows Crucible, which is a Java application, to be run as a Windows Service.

* No need for a user to be logged on to the system at all times, or for a command prompt to be open and
running on the desktop to be able to run Crucible.

® The ability to run Crucible in the background as a service, for improved convenience, system performance
and security.

® Crucible is launched automatically on system startup and does not require that a user be logged in.

® Users are not able to stop, start, or otherwise tamper with Crucible unless they are an administrator.

®* Provides advanced failover, error recovery, and analysis features to make sure that Crucible has the
maximum possible uptime.

Please note that:

® This page should be read in conjunction with Installing Crucible on Windows.

® You should use 32-bit Java to run the service wrapper provided via the link in the install instructions
below, even on a 64-bit machine.

® You should use the Java JDK, rather than the JRE, to take advantage of the - ser ver parameter,
provided in the Wrapper configuration of wrapper.zip, which enables the Java HotSpot(TM) Server VM.
See the note below for details.

On this page:

® |nstalling the Java Service Wrapper
® Setting Crucible environment variables for Windows Services

® Troubleshooting
® Extracting files from wrapper.zip

® \Warning when using 64-bit Java JDK
* \Wrapper configuration and "-server" parameter

Related pages:

¢ |nstalling Crucible on Windows

Installing the Java Service Wrapper

To install the Java Service Wrapper on Windows:

1. Download wrapper.zip from here.

2. Unzip the wrapper zip file into your <Fi shEye hone di r ect or y> (that is, the directory into which
Crucible was originally installed). Note, the resulting folder structure should be <Fi shEye hone
di rect or y>\ wr apper, <Fi shEye hone directory>\w apper\bi n, etc and NOT <Fi shEye
hone directory>\w apper\w apper, <Fi shEye home directory>\w apper\w apper\ bi n.
The location of the wrapper directory is important.

3. Tell the wrapper where to find the Java JDK by editing the <Fi shEye hone
di rect or y>\ wr apper\ conf\ w apper. conf file, replacing this:
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# Java Application
wWr apper . j ava. conmand=j ava

with the following, and comment out the option you don't wish to use:

# Java Application

# Option 1: If you have JAVA HOMVE defined in your Wndows system
envi ronment variabl es, then you can use:
wr apper . j ava. command=%JAVA HOVE% bi n/ j ava

# Option 2: If you have multiple JDKs installed, and you don't want to use
a Wndows environnment variable to specify which one to use, provide the
absol ute path to where the JDK is installed (e.g.
C:./Javal/jdkl.7.0_05/bin/java):

wr apper . j ava. command=C: /<path to Java | ocation>/bin/java

To get confirmation in the wrapper log that the wrapper is using the correct Java JDK, add the following
lines to the wr apper . conf file:

# Tell the Wapper to log the full generated Java conmand |i ne.
wr apper . j ava. command. | ogl evel =l NF

You can find the logs at <Fi shEye hone di rectory>\var\l og\w apper. | og.

4. Setthe FISHEYE_INST environment variable (and other Crucible-specific environment variables) in the <
Fi shEye home directory>\w apper\conf\w apper. conf file, following the instructions below.
5. Install Crucible as a service as follows:
a. Open an Administrator command prompt by searching for ‘Command prompt' in the Windows Start
menu, right-clicking on Command Prompt and then choosing Run as administrator.
b. Change directory to <Fi shEye home direct ory>\w apper and run bi n\Fi sheye- I nst al |
- NTSer vi ce. bat . If you run into any problems starting the wrapper, you'll find its logs in <Fi shE
ye hone directory>\var\l og\w apper.| og.
6. Start the Crucible service (which has the name 'Fisheye') from the Windows Control Panel; you can
search in the Start menu for 'services', and in the list of services, right-click on the 'Fisheye' item and
choose Start. You can also stop the Crucible service in this way.

i Please note that:

® |f you make changes to the wrapper.conf file, having already started the service, you need to stop and
then restart the service for it to make use of the changed configuration.

® |f in future you move the FishEye home directory, you will need to uninstall (using Fi sheye- Uni nst al |
- NTSer vi ce. bat ) and then reinstall the Crucible service.

Setting Crucible environment variables for Windows Services

Please note, that if you run Crucible as a Windows service, any Crucible-specific environment variables must be
setin your <Fi shEye hone directory>\w apper\ conf\w apper. conf file.

If you run into any problems starting the wrapper, you'll find its logs in <Fi shEye hone
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di rectory>\var\|l og\w apper. | og.

If there are other Java parameters you wish to add, then you will need to add them under the additional
parameters section, e.g.

# JDK Additional Paraneters for jnx

wWr apper. j ava. addi ti onal . 4=- Dcom sun. nanagenent . j nxr enot e

wr apper. j ava. addi ti onal . 5=- Dcom sun. nanagenent . j nxr enot e. port =4242

wr apper. j ava. addi ti onal . 6=- Dcom sun. nanagenent . j nxr enot e. aut henti cat e=f a
| se

wr apper. j ava. addi ti onal . 7=- Dcom sun. nanagenent . j nxr enot e. ssl =f al se

wr apper. j ava. addi ti onal . 8=- Dcom sun. nanagenent . j nxr enot e. aut henti cat e=f a
| se

wr apper . j ava. addi ti onal . 9=- Dcom sun. managenent . j nxr enot e. password. fi |l e=.
/ wr apper/j nxrenot e. password

wWr apper. j ava. addi ti onal . 10=- Dwr apper . nbean. nane="wr apper : t ype=Java
Service Wapper Control"

To add the FISHEYE_INST environment variable, the Java MaxPermSize parameter, or the -Xrs options, use
the following:

wr apper. java. addi ti onal . 11=-Df i sheye. i nst="c:/ pat h/ t o/ Fl SHEYE | NST"
wr apper. j ava. addi ti onal . 12=- XX: MaxPer n5i ze=128m
wr apper.java. additional . 13=-Xrs

Note that the the -Xrs options should be used when running Crucible as a service under Windows to prevent the
JVM closing when an interactive user logs out.

Your memory settings can also be found in this file:

# Initial Java Heap Size (in MB)
wr apper.java.ini t menory=256

# Maxi mum Java Heap Size (in MB)
wWr apper. j ava. maxnmenor y=1024

Increase these values if you have a large repository or expect to use more memory (init of 256, and a max of
1024 are the default values).

In Fisheye/Crucible 1.6.4 and higher, you can check the JVM input arguments by clicking System info, under
'System Settings' in the admin area.

Troubleshooting

Extracting files from wrapper.zip

Some customers have reported trouble running the wrapper. These can be avoided by:

® Uncompressing wrapper.zip with Winzip or WinRar rather than using the Extract All command in the
Windows right-click contextual menu.
® |f the wrapper.zip filename appears green instead of black in Windows Explorer, decrypt it, prior to
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unzipping its contents, by right-clicking on the file, choose Properties, click the Advanced button, then
clear the Encrypt contents to secure data checkbox.

Warning when using 64-bit Java JDK

When using a 64-bit Java JDK with the wrapper obtained via the link in the install instructions above, you may
see the following in the wrapper.log file:

WARNING - Unable to load the Wrapper's native library ‘wrapper.dil'. The file is located on the path
at the following location but could not be loaded:
C:\installs\service\fisheye28\wrappenlib\wrapper.dll.

Please verify that the file is readable by the current user and that the file has not been corrupted in
any way. System signals will not be handled correctly.

This is caused by using a 64-bit JDK (even on a 64-bit machine). Changing to a 32-bit version of the JDK will
prevent this warning. Community Edition versions of the 64-bit Windows Java Service Wrapper are not currently
available.

Wrapper configuration and "-server" parameter

Please note that the wrapper configuration provided above uses the - ser ver parameter to enable the Java
HotSpot(TM) Server VM. This feature is only available if you use the JDK. If you use the JRE you will likely get
the following error in your logs:

INFO | jvm 1] 2010/12/20 18:19:28 | Error: missing “server' JVM at "C:\Program
Files\Java\jre6\bin\server\jvm.dll'.

A common issue is that customers remove the - ser ver parameter from the wr apper . conf file. Please note
that if you do this, the wrapper script will ignore any of the following JVM parameters in the file unless you
change the sequence to be in order, starting from wr apper . j ava. addi ti onal . 1. This is an issue with the
Wrapper application.

In this situation it's best to install and run Fisheye/Crucible with the JDK to get all the advantages of the - serve
r functionality. You also need to force the wrapper to use the JDK by specifying the path to the Java JDK in the
wr apper . conf file, as described in the installation instructions above.

Installing Crucible on Linux and Mac

Hey! We're going to install Crucible on a Linux box, or a Mac. There are a few steps involved, but we think you'll
find it easy to follow along. If you already have FishEye installed, you should read Upgrading from FishEye to
Crucible instead.

1. Check supported platforms

Better check the Supported Platforms page first; it lists the application servers, databases, operating systems,
web browsers and JDKs that we have tested Crucible with, and that we recommend.

Atlassian only officially supports Crucible running on x86 hardware and 64-bit derivatives of x86 hardware.
Related pages:

® |nstalling Crucible on Windows

® Starting to use Crucible
® Supported Platforms

2. Check your version of Java
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In a terminal, run this:

..............................................................................................................................................................................

The version of Java should be 1.6.0 or higher.

-

If you don't see Java 1.6.0 or higher, then get Java...
Download and install the Java Platform JDK from Oracle's website.

Now try running 'j ava - ver si on' again to check the installation. The version of Java should be
1.6.0 or higher.

3. Check that the system can find Java

In a terminal, run this:

..............................................................................................................................................................................

You should see a path something like:

OSX / Syst eni Li br ary/ Framewor ks/ JavaVM f r ane
wor k/ Ver si ons/ Cur r ent JDK/ Horre/
Linux [usr/lib/jvnidefault-java

If you don't see a path to the Java location, then set JAVA_HOME...
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Linux Mac

Do either of the following:

. L Insert the following in your ~/ . profi | e file:
* |f JAVA HOME is not set, log in with 'root'

level permissions and run: JAVA HOVE=" pat h/ t o/ JAVA HOVWE"
----------------------------------------------------------------- ; export JAVA HOVE

echo where pat h/ t o/ JAVA_HOVE may be like: / S

JAVA_HOVE="pat h/t o/ JAVA_HO | yst em Li br ary/ Framewor ks/ JavavM fr

ME" >> [etc/environnent amewor k/ Ver si ons/ Cur r ent JDK/ Horre/

Refresh your ~/.profile in the terminal and
where pat h/ t o/ JAVA_HOVE may be like: /  confirm that JAVA_HOVE is set:

usr/lib/jvmdefault-java
* |f JAVA HOMVE needs to be changed, open source ~/.profile
the / et c/ envi ronnment file in a text  $JAVA_HOVE/ bi n/ j ava
editor and modify the value for JAVA_HOM [ -version
E to: i
JAVA_HOVE="pat h/ t o/ JAVA_HOVE" You should see a version of Java that is 1.6.0

or higher, like this:

It should look like:
java version "1.6.0_24"

JAVA HOVE=/ usr/1ib/jvni def aul t - j
ava

4. Create a dedicated Crucible user (recommended)

For production installations, we recommend that you create a new dedicated user that will run Crucible on your
system. This user:

¢ Should not have admin privileges.

® Should be a non-privileged user with read, write and execute access on the Crucible home (install)
directory and instance (data) directory. These directories are described below.

® Should only have read access to your repositories.

If you created a dedicated Crucible user, ensure you are logged in as this user to complete the remaining
instructions.

5. Now it's time to get Crucible

Download Crucible from the Atlassian download site.

Extract the downloaded file to an install location:

® Folder names in the path to your Crucible executable should not have spaces in them. The path to the
extracted directory is referred to as the <Fi shEye home di rect ory> in these instructions, for
consistency with the FishEye documentation.

® |f you expect to have a large number of users for this Crucible installation, and Crucible will be connected
to an external database, consider installing Crucible on a different server from the one running the
external database, for improved performance.

6. Tell Crucible where to store your data
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The Crucible instance directory is where your Crucible data is stored.

1. Create your Crucible instance directory.
2. Tell Crucible where you created it by adding a FISHEYE_INST environment variable as follows:

Linux Mac
Openthe /etc/environnent fileina Openthe ~/ . profi | e file for the current
text editor and insert : user in a text editor and insert:

FI SHEYE_| NST="pat h/ t o/ <Cr uci bl e FI SHEYE | NST="pat h/ t o/ <Cruci bl e
i nstance directory>" i nstance directory>"
export FI SHEYE | NST

3. Now copy the newly extracted <Fi shEye hone directory>\config.xm file to the root of your new
FishEye instance directory.

You should not locate your Crucible instance directory inside the <Fi shEye home di r ect or y>—they
should be entirely separate locations. If you do put the instance directory in the <Fi shEye hone directory>
it will be overwritten, and lost, when Crucible gets upgraded. And by the way, you'll need separate Crucible insta
nce directories if you want to run multiple copies of Crucible.

If you have a large number of repositories, we recommend you increase the default number of files that FishEye
is allowed to open. See the following knowledge base article for more info: Subversion Indexer Paused with "Too
many open files" Error.

7. Start Crucible!

In a terminal, change directory to <Fi shEye hone di r ect or y> and run this:

..............................................................................................................................................................................

After a few moments, in a web browser on the same machine, go to http://localhost:8060/ (or, from another
machine, type htt p: / / host nane: 8060/ , where host nane is the name of the machine where you extracted
Crucible).

Enter your license, then an admin password, to finish the setup.

You can postpone setting up JIRA integration until later if you wish; see Configuring JIRA integration in the
Setup Wizard.

8. Connect to an external database (recommended)

If you intend to use this Crucible installation in a production environment, it is highly recommended that you use
one of the supported external databases. See Migrating to an external database.

If you are evaluating Crucible, or don't wish to do this now, Crucible will happily use its embedded database, and
you can easily migrate later.

9. Set up your mail server

Configure the Crucible email server so that users can get notifications from Crucible. See Configuring SMTP.
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10. Add users and repositories

Now is the time to set up your users in Crucible, and to tell Crucible about any existing repositories you have.
Please read Starting to use Crucible for the details.

Crucible will perform an initial index of your repositories, during which it accesses, indexes and organizes a view
of your repositories (including all historical items) back to the earliest commits. If you are evaluating Crucible, we
suggest that you index a single project, so you can use Crucible as soon as possible. If you choose to index your
entire repository, be aware that this can take a long time (possibly days) for massive or complex repositories and
can be more complex to set up (especially for Subversion). The basic process is slightly different for each SCM

type.

11. Stop Crucible (optional)

In a terminal, change directory to <Fi shEye hone directory> and run this:

bi n/ st op. sh

Configuring JIRA Integration in the Setup Wizard

This page describes the 'Connect to JIRA' screen of the Crucible setup wizard.

You can connect your application to a JIRA server, to manage your users via JIRA and share information with
JIRA. When you are installing the application, the setup wizard gives you the opportunity to configure the JIRA
connection automatically. This is a quick way of setting up your JIRA integration with the most common options.

You can also configure the JIRA connections via the application administration screens. In that case, you will
need to set up connections individually. There are two parts to the integration process:

® A peer-to-peer link between JIRA and the application for sharing information and facilitating integration
features. This link is set up via Application Links.

® A client-server link between the application and JIRA for delegating user and group management to your
JIRA server.

Requirements: You need JIRA 4.3 or later.
On this page:

® Connecting to JIRA in the Setup Wizard

® Troubleshootin
®* Notes

Related pages:

® User Management Limitations and Recommendations
® JIRA integration in Crucible

Connecting to JIRA in the Setup Wizard

To configure JIRA integration while running the Crucible setup wizard:

1. Enter the following information on the 'Connect to JIRA' step of the setup wizard:
* JIRA Base URL- The web address of your JIRA server. Examples:
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http://ww. exanpl e. com 8080/ jiral
http://jira. exanpl e.com

Admin Username and Admin Password — The credentials of a user with the 'JIRA System
Administrators' global permission in JIRA.

FishEye/Crucible Base URL — Click '‘Advanced Options' to see this field. JIRA will use this URL to
access your FishEye/Crucible server. The URL you give here will override the base URL specified
in your FishEye/Crucible administration console, for the purposes of the JIRA connection.

Groups to synchronize — Click 'Advanced Options' to see this field. Select at least one JIRA
group to synchronize. The default group is j i r a- user s. JIRA will synchronize all changes in the
user information on a regular basis. The default synchronization interval is 1 hour.

Admin Groups — Click 'Advanced Options' to see this field. Specify a JIRA group whose members
should have administrative access to FishEye/Crucible. The default group is j i r a- adm ni str at
ors.

2. Click the 'Connect to JIRA' button.
3. Finish the setup process.
4. Configure the following setting in JIRA: Allow remote API access.

Screenshot: Connecting to JIRA in the FishEye/Crucible setup wizard

1. License

2. Inclusions

3. Connect to JIRA If you have JIRA 4.3 or later, Crucible can use JIRA for user management. This

Connect to JIRA

is not recommended for more than 500 users. Learn more here.

JIRA Base URL:

For example: http://jira.mycompany.com or
http://mycompany.com/jira

Admin Username:

This username must have system administrator rights on your
JIRA server.

Admin Password:

Advanced
Options...

Connect to JIRA | | Skip |

Troubleshooting

™ Click to see troubleshooting information...

This section describes the possible problems that may occur when integrating your application with JIRA via
the setup wizard, and the solutions for each problem.

Symptom Cause Solution

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
https://confluence.atlassian.com/display/JIRA/Configuring+JIRA+Options#ConfiguringJIRAOptions-options

User Guide for Crucible 2.10

The setup wizard displays one of
the following error messages:

® Failed to create application link
from JIRA server at <URL> to
this <application> server at
<URL>.

® Failed to create application link
from this <application> server
at <URL> to JIRA server at
<URL>.

® Failed to authenticate
application link from JIRA
server at <URL> to this
<application> server at <URL>.

® Failed to authenticate
application link from
<application> server at <URL>
to this JIRA server at <URL>.

The setup wizard displays one of
the following error messages:

® Failed to register <application>
configuration in JIRA for
shared user management.
Received invalid response from
JIRA: <response>

® Failed to register <application>
configuration in JIRA for
shared user management.
Received: <response>

The setup wizard displays the
following error message:

® Error setting Crowd
authentication

The setup wizard displays the
following error message:

® Error reloading Crowd
authentication

The setup wizard failed to
complete registration of the
peer-to-peer application link with
JIRA. JIRA integration is only
partially configured.

The setup wizard failed to
complete registration of the
client-server link with JIRA for
user management. The
peer-to-peer link was
successfully created, but
integration is only partially
configured.

The setup wizard successfully
established the peer-to-peer link
with JIRA, but could not persist
the client-server link for user
management in your conf i g. xm
| file. This may be caused by a
problem in your environment,
such as a full disk.

The setup wizard has completed
the integration of your application
with JIRA, but is unable to start
synchronizing the JIRA users
with your application.

Remove the partial configuration
if it exists, try the 'Connect to
JIRA' step again, and then
continue with the setup. Detailed
instructions are below.

Remove the partial configuration
if it exists, try the 'Connect to
JIRA' step again, and then
continue with the setup. Detailed
instructions are below.

Please investigate and fix the
problem that prevented the
application from saving the
configuration file to disk. Then
remove the partial configuration if
it exists, try the 'Connect to JIRA'
step again, and then continue
with the setup. Detailed
instructions are below.

Restart your application. You
should then be able to continue
with the setup wizard. If this
solution does not work, please
contact Atlassian Support.
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The setup wizard displays the
following error message:

® An error occurred:

java.lang.lllegalStateException:

Could not create the
application in JIRA/Crowd
(code: 500). Please refer to the
logs for details.

No users can log in after you
have set up the application with
JIRA integration.

The setup wizard has not
completed the integration of your
application with JIRA. The links
are only partially configured. The
problem occurred because there
is already a user management
configuration in JIRA for this
<application> URL.

Possible causes:

® There are no users in the
group that you specified on the
'‘Connect to JIRA' screen.

® For FishEye: There are no
groups specified in the 'groups
to synchronize' section of your
administration console.

® For Stash: You may not have
granted any JIRA groups or
users permissions to log in to
Stash.

Remove the partial configuration
if it exists, try the 'Connect to
JIRA' step again, and then
continue with the setup. Detailed
instructions are below.

Go to JIRA and add some
usernames to the group.

For FishEye: Go to the FishEye
administration screens and
specify at least one group to
synchronize. The default is 'jira
-users'.

For Stash: Grant the Stash
User permission to the relevant
JIRA groups on the Stash Glob

al permissions page.

If this solution does not work,

please contact Atlassian Support.

Solution 1: Removing a Partial Configuration — The Easiest Way

If the application's setup wizard fails part-way through setting up the JIRA integration, you may need to
remove the partial configuration from JIRA before continuing with your application setup. Please follow the
steps below.

Remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the
setup wizard:

1. Log into JIRA as a user with the 'JIRA System Administrators' global permission.
2. Click the '‘Administration’ link on the JIRA top navigation bar.
3. Remove the application link from JIRA, if it exists:
a. Click 'Application Links'in the JIRA administration menu. The 'Configure Application Links'
page will appear, showing the application links that have been set up.
b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For
example:
® |f you want to remove a link between JIRA and FishEye, look for the one where the 'Appl
ication URL' matches the base URL of your FishEye server.
® |f you want to remove a link between JIRA and Confluence, look for the one where the 'A
pplication URL' matches the base URL of your Confluence server.
® If you want to remove a link between JIRA and Stash, look for the one where the '‘Applic
ation URL' matches the base URL of your Stash server.
c. Click the 'Delete' link next to the application link that you want to delete.
d. A confirmation screen will appear. Click the ‘Confirm' button to delete the application link.
4. Remove the user management configuration from JIRA, if it exists:
a. Go to the JIRA administration screen for configuring the applications that have been set up to
use JIRA for user management:
® In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the
JIRA administration screen.
® In JIRA 4.4: Select 'Administration’ > 'Users' > 'JIRA User Server'.
b. Look for a link to your application. It will have a name matching this format:
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<Type> - <Host Nanme> - <Application |ID>

For example:

Fi shEye / Crucible - Iocal host -
92004b08- 5657- 3048- b5dc- f 886e662bal5

Confl uence - | ocal host -
92004b08-5657- 3048- b5dc- f 886e662bals

If you have multiple servers of the same type running on the same host, you will need to match
the application ID of your application with the one shown in JIRA. To find the application ID:
® Go to the following URL in your browser:

<baseUr| >/ rest/applinks/ 1.0/ manif est

Replace <baseUr | > with the base URL of your application.
For example:

http://1 ocal host: 8060/ rest/applinks/ 1.0/ manifest

® The application links manifest will appear. Check the application ID in the <i d> element.
c. In JIRA, click 'Delete' next to the application that you want to remove.
5. Go back to the setup wizard and try the 'Connect to JIRA' step again.

Solution 2: Removing a Partial Configuration — The Longer Way

If solution 1 above does not work, you may need to remove the partial configruration and then add the full
integration manually. Please follow these steps:

1. Skip the 'Connect to JIRA' step and continue with the setup wizard, to complete the initial configuration
of the application.
2. Log in to JIRA as a user with the 'JIRA System Administrators' global permission.
3. Click the '‘Administration’ link on the JIRA top navigation bar.
4. Remove the application link from JIRA, if it exists:
a. Click 'Application Links'in the JIRA administration menu. The 'Configure Application Links'
page will appear, showing the application links that have been set up.
b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For
example:
® If you want to remove a link between JIRA and FishEye, look for the one where the 'Appl
ication URL' matches the base URL of your FishEye server.
* |f you want to remove a link between JIRA and Confluence, look for the one where the 'A
pplication URL' matches the base URL of your Confluence server.
* |f you want to remove a link between JIRA and Stash, look for the one where the 'Applic
ation URL' matches the base URL of your Stash server.
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c. Click the 'Delete’ link next to the application link that you want to delete.
d. A confirmation screen will appear. Click the ‘Confirm' button to delete the application link.
5. Remove the user management configuration from JIRA, if it exists:
a. Go to the JIRA administration screen for configuring the applications that have been set up to
use JIRA for user management:
® In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the
JIRA administration screen.
® In JIRA 4.4: Select 'Administration’ >'Users' > 'JIRA User Server'.
b. Look for a link to your application. It will have a name matching this format:

<Type> - <Host Nane> - <Application | D>

For example:

Fi shEye / Crucible - |ocal host -
92004b08- 5657- 3048- b5dc- f 886e662bals

Or:

Confl uence - | ocal host -
92004b08- 5657- 3048- b5dc-f 886e662bals

If you have multiple servers of the same type running on the same host, you will need to match
the application ID of your application with the one shown in JIRA. To find the application ID:
® Go to the following URL in your browser:

<baseUr| >/ rest/applinks/ 1.0/ manif est

Replace <baselr | > with the base URL of your application.
For example:

http://1 ocal host: 8060/ rest/appl i nks/ 1. 0/ mani f est

® The application links manifest will appear. Check the application ID in the <i d> element.
c. In JIRA, click 'Delete’ next to the application that you want to remove.
6. Add the application link in JIRA again, so that you now have a two-way trusted link between JIRA and
your application:

a. Click 'Add Application Link'. Step 1 of the link wizard will appear.

b. Enter the server URL of the application that you want to link to (the ‘'remote application’).
c. Click the 'Next' button.

d. Enter the following information:

® 'Create alink back to this server' — Tick this check box to add a two-way link between
the two applications.

® 'Username' and 'Password’' — Enter the credentials for a username that has
administrator access to the remote application.
Note: These credentials are only used to authenticate you to the remote application, so
that Application Links can make the changes required for the new link. The credentials
are not saved.
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® 'Reciprocal Link URL' — The URL you give here will override the base URL specified in
your remote application's administration console, for the purposes of the application links
connection. Application Links will use this URL to access the remote application.
e. Click the 'Next' button.
f. Enter the information required to configure authentication for your application link:
® 'The servers have the same set of users' — Tick this check box, because the users are
the same in both applications.
® 'These servers fully trust each other' — Tick this check box, because you trust the
code in both applications and are sure both applications will maintain the security of their
private keys.
For more information about configuring authentication, see Configuring Authentication
for an Application Link.
g. Click the 'Create’ button to create the application link.
7. Configure a new connection for user management in JIRA:
a. Go to the JIRA administration screen for configuring the applications that have been set up to
use JIRA for user management:
® In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the
JIRA administration screen.
® InJIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
b. Add an application.
c. Enter the application name and password that your application will use when accessing JIRA.
d. Enter the IP address or addresses of your application. Valid values are:
® Afull IP address, e.g. 192. 168. 10. 12.
® Awildcard IP range, using CIDR notation, e.g. 192. 168. 10. 1/ 16. For more
information, see the introduction to CIDR notation on Wikipedia and RFC 4632.
® Save the new application.
8. Set up the JIRA user directory in the application.
® For Confluence:
a. Go to the Confluence Administration Console.
b. Click 'User Directories' in the left-hand panel.
c. Add a directory and select type 'Atlassian JIRA'.
d. Enter the following information:
®* Name — Enter the name of your JIRA server.
® Server URL — Enter web address of your JIRA server. Examples:

http://ww. exanpl e. com 8080/ jiral
http://jira. exanpl e.com

® Application name and Application password — Enter the values that you
defined for Confluence in the settings on JIRA.

e. Save the directory settings.

f. Define the directory order by clicking the blue up- and down-arrows next to each
directory on the 'User Directories' screen.

For details see Connecting to Crowd or JIRA for User Management.
® For FishEye/Crucible:

a. Click Authentication (under 'Security Settings’).

b. Click Setup JIRA/Crowd authentication. Note, if LDAP authentication has already
been set up, you will need to remove that before connecting to JIRA for user
management.

c. Make the following settings:

Authenticate against Select a JIRA instance
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Application name and password Enter the values that you defined for your
application in the settings on JIRA.

JIRA URL The web address of your JIRA server.
Examples:

http://ww. exanpl e. c
om 8080/jiral
http://jira.exanmple.
com

Auto-add Select Create a FishEye user on
successful login so that your JIRA users
will be automatically added as a FishEye
user when they first log in.

Periodically synchronise users with Select Yes to ensure that JIRA will

JIRA synchronize all changes in the user
information on a regular basis. Change
the value for Synchronise Period if
required.

When Synchronisation Happens Select an option depending on whether
you want to allow changes to user
attributes from within FishEye.

Single Sign On Select Disabled. SSO is not available
when using JIRA for user management
and if enabled will make the integration
fail.

d. Click Next and select at least one user group to be synchronised from JIRA. If
necessary, you could create a new group in JIRA, such as 'fisheye-users', and select this
group here.

e. Click Save.

® For Stash:

a. Go to the Stash Administration Console.

b. Click 'User Directories' in the left-hand panel.

c. Add a directory and select type 'Atlassian JIRA".

d. Enter the following information:

®* Name — Enter the name of your JIRA server.
® Server URL- Enter web address of your JIRA server. Examples:

http://ww. exanpl e. com 8080/ jiral
http://jira. exanpl e. com

® Application name and Application password — Enter the values that you
defined for Stash in the settings on JIRA.
e. Save the directory settings.
f. Define the directory order by clicking the blue up- and down-arrows next to each
directory on the 'User Directories' screen.
For details see Connecting to JIRA for user management.
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Notes

When you connect to JIRA in the setup wizard, the setup procedure will configure Trusted Applications
authentication for your application. Please be aware of the following security implications:

® Trusted applications are a potential security risk. When you configure Trusted Applications
authentication, you are allowing one application to access another as any user. This allows all of the
built-in security measures to be bypassed. Do not configure a trusted application unless you know that all
code in the application you are trusting will behave itself at all times, and you are sure that the application
will maintain the security of its private key.

Starting to use Crucible

This page will guide you though the basics of using Crucible. By the end of it you should know how to:

® Add a repository.
® Create a project.
® Create and perform reviews.

Assumptions

This page assumes that:

® You have installed and started the latest version of Crucible. See the details at Installing Crucible on
Windows or Installing Crucible on Linux and Mac.
® You are using a supported browser.

Add arepository
In this section we're going to add a repository to Crucible.

Click on Add Existing... in the Repositories listing of the Administration area.

()] Log In

Dashboard Source! * Projects! * Peoplei =

fo' Admin
ER

Repositories RepOSItO!’leS

Native Repository Access (0
Smart Commits H & ©

Web Hooks FishEye natively supports Subversion, CVS, Perforce, Git and Mercurial repositories @
= Project Settings
Projects Add Existing Create New Refresh Page 1 of 1
= User Settings
Users Name Type Description Location State Last Actions
User Mappings Update
B Avatars No
= Security Settings repositories
Change Admin Password configured.
Authentication
Administrators
Groups
Permission Schemes

Choose the repository type and fill in the name and description.
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Add Repository - Page 1 of 3

Basic Details

Reposiory Type:

Name: * | jgplot @

Description: |le charts library| (€

Back) (Next) (Add) (CanceD

In the repository configuration put the location of your repository. Fill in the authentication details if necessary.

Add Repository - Page 2 of 3

Mercurial Connection Details

Repository Location: * Ihltps:Hbilbucket,org;cleonelloquplot | @

Mercurial Authentication

Authentication Style: [ No authentication

FishEye will not add any icati ication will be transparently by the SCM.

) Show advanced setlings Tac PO Tection Add

Finally indicate whether or not you would like diff indexing should be turned on and if the repository should not
be indexed right away then click Add to finish the process.
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Add Repository - Page 3 of 3

Final Settings
Store Diff Info: O @

Enable Repository ® ()
After Adding:

Next) (Add) (CanceD

Your repository is now created in Crucible and the indexing should have started.

Repositories
Native Repository Access (1) | Plugins (4)

Crucible natively supports Subversion, CVS, Perforce, Git and Mercurial repositories @

Add Existing... Create New... Refresh Page 1 of 1
Name Type Description Location State Last Actions
Update
| jgplot Mercurial JS charts library hittps://bitbucket.orgicleonello/jgplot! Running G~
d o Info

Cloning repository

Create a project in Crucible

Crucible comes with a default project with the key CR but you will most likely have to create your own projects
that will contain your reviews. This is achieved in a couple of steps.

Click on Add a new project in the Projects listing of the Administration area.

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.

29


http://creativecommons.org/licenses/by/2.5/au/

User Guide for Crucible 2.10

(;) Admin

= Repository Settings :
Repositories PrOJGCtS @]

Defaults ) ) »
A project is a set of Crucible content.

Smart Commits

Key Name Default Repository Default Moderator Def

Default
Project
User Mappings CAdd a new pmject)
Avatars === === === —=

= Security Settings
Change Admin Password
Authentication
Administrators
Groups
Parmission Schemes

= Global Settinas

Fill in the form with the default settings for the project and hit Save.

Edit Project e

ldentification

Name | JO Reviews

Key |jaR|
Content

Default Repository | jgplot

™ Store the contents of files in reviews

Permissions Scheme @

FPermission Scheme | default #

Moderator @

™ Enable the Moderator role for this project

Default Moderator Start typing a user name then press enter to select.

Default Reviewers @

[ By default, allow anyone to join reviews after creation

Users Start typing a user name then press enter to select.

You should then be taken back to the Projects listing where you can see your new project has been created.
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G) Admin

= Repository Settings

Reposiories Projects e
Defaults S~ =
: A project is a set of Crucible content.

Smart Commits

Web Hooks Key Name  Default Repository Default Moderator Default Reviewer Users Default Revie
= Project Settings

Projects cr Default
= User Settings Project

Users Ja :

User Mappings JOR Loliews fapiot

Avatars
S Socudty Selings

Change Admin Password e

Authentication

Administrators

Groups

Permission Schemes

Create areview

Now that you have your own project it is possible to create reviews in it.

You need to be logged in to create reviews.

From the Dashboard click on Create review to open the review creation form.

Y7 iv JohnDoe |~

+ Create Snippet  + Create Review
I

B Tools ~

All Commits Reviews Expand all Show My Activity

Choose the project in which you want to create the review.
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Select Project for New Review

Select Project

QR

(Create Review)  ( Cancel)

In the next screen click on Browse Changesets to see the list of changesets available to create the review.

Add Content to Review JQR-1

Browse Changesets
Browse recent changes for revisions to add to this review

B= Explore Repositories
D Use a directory tree to find files

Search for Files
Use Crucible's search to find revisions to add to this review

Pre-commit
Upload a patch file to be reviewed - diffs of files will be extracted

Attachments
Upload a file to be reviewed

IR

(Edit Details)  (Abandon Review)  (Start Review)  (Done)

Select the changesets that you would like to be reviewed and then click on Edit Details to add reviewers.
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Add Content to Review JQR-3

Repository: - Author:

japlot
Branch: - Tag:

Add to Review as:

@ Earlier Changesets Go to changeset:

Remove all revisions from review

Changes in jgplot
Monday 13 Aug
Chris Leonello <chris.leonello @gmail.com>

» [El 1118:0d4d1a4fe522 changed 1 file ¥ defaul @ JOR-1 JOR-2
Fix for horizontal waterfall plots.

ridaly 10 Aug

Chris Leonello <chris.leonello@gmail.com>
b [ 1117:658794324deb changed 1 file § default @ JOR-1| JOR-2
Fixed examp!e.

QcabbdbBa changed 47 files ¥ default
Updated versiofagd copyright.

+ [El 1115:9e15b8bB4ed changed

Fixed some lint.

» [El 1114:da13ae5eb3b2 changed 2 fles ¥ default

(Add More Cnment) (Edit Details) (Ahandnn Review) (Start Review)

Once you have chosen your reviewers and updated the review information you can click on Start Review to
begin the review process.

Edit Review Details JQR-3
Project: JQR

Title: Fix for horizontal waterfall plots.

Author: John Doe Maoderator: John Doe

Reviewers: nar = | Suggest reviewers.. O Allow anyone to join

& sean Carter

% Donald Glover

Objectives: | please check if the CSS modifications are IE compliant]

5]

Due Date:
Linked Review: Link
Invited Reviewers:

('Add Content)  (‘Abandon Review)

The review is now created and the reviewers will have been notified that a review is pending.
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] Y¥ri~ JohnDoe'~

Dashpoard  Projects| *  People | v [EEELERRS

+ Create Snippet  + Create Review
JQ Reviews , JQR-3

& EditDetais @ Summarize £ Tools ~
Fix for horizontal waterfall plots.

Under Review for a few seconds Author & Moderator Reviewers
o .
JOR-3 FEE O @B - Pres~ S Fiter &0m
Details Detalls "
Objectives
General Comments Participant Role Time Spent Comments Latest Comment
& % John Doe Author & Maderator om
= examples
[©] blockPiotphp <& Donald Glover Reviewer - 0% complete
E= sre/fplugins ——
[2] jqplot.barRenderer.js S sean Carter Reviewer - 0% complete
Total om o
Files: 2
Objectives cait
Please check if the CSS modifications are IE compliant
General Comments
There are ne general comments on this review. Add a general comment.

In order to close a review where you are the moderator you need to click on Summarize in the top right and then
close the review from the modal window.
Summarize Review

Summarize the review outcomes (optional)
There's a bug with FF1 but an issue has been created for it.

(Continue Without Closing) | ( Close Review)

Using Crucible

This page is an index of the content in the Crucible User's Guide. Click on a link below to see the desired page.

® The Crucible workflow
® Using the Crucible Screens

® Browsing All Reviews
® Browsing Source Files
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Using the Dashboard
Crucible Icons
Searching Crucible
Viewing people's statistics in Crucible
Browsing Projects
* Viewing Project Statistics
®* Viewing Reports
® Review Coverage Report
® Changeset discussions
® Changing your User Profile
® Roles and Status Classifications
® Conducting a Review
® Creating a Review
® (Creating a Patch Review
Creating a Review within Crucible
Creating a review from FishEye
Creating a review from JIRA
Creating a Review from a URL
Creating a Snippet Review
® Selecting the Files for the Review
® |terative Reviews
® Adding Reviewers
® |ssuing a review
® Performing the review
®* Adding comments
Flagging Defects
Creating JIRA issues from the review
Completing your review
Sending a review's comments via Email
Using JIRA Integration in Crucible Reviews
Using the Review History Dialog
Tracking Crucible Review Metrics
® Using Progress Tracking
® Using Time Tracking
Summarising and Closing the Review
Transitioning JIRA issues
Moving a Review to Another Project
Deleting a review
® Defining your Workflow
Viewing Your Favourites
® Using Favourites
Using Keyboard Shortcuts in Crucible
Using RSS Feeds in Crucible
Using Wiki Markup in Crucible

Using gadgets in Crucible
Using Review Reminders

e o o o o

The Crucible workflow

This page contains a overview of Crucible workflows, followed by a simple example showing a code review
between two people.

Crucible is a flexible application that caters for a wide range of team sizes and work styles. You will need to
know about the basic roles used in Crucible.

Roles:
There are several roles that review participants can take up:
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® authors: Usually the creator of the code; the person who will act on the review's outcome.

® reviewer: A participant that will comment on the source files in the review, raising points and discussion
on the work that was done.

® moderator: Usually the person who starts the review and is responsible for deciding the outcomes and
closing it. The moderator is disabled for the "agile" permission scheme to simplify workflow.

You will also need to understand how workflow is conducted in Crucible. This is configurable, but the most basic
example follows.

Crucible Workflow:
There are a number of different ways in which you can use Crucible for code reviews. The following diagram
shows the basic workflow that applies to most Crucible code reviews.

On this page:

Example workflow: Two participant code review
1. The author starts the review
2. The reviewer comments on the code
3. The author responds to the comments
4. The author closes the review

Diagram: Workflow for One-to-One Reviews

Reviewer(s) Author Author
?ritggs ' . responds . closes
- on the code to the the review
the review comments

Need more information? Read more about the different forms of workflow in Crucible.

Next, we explore an example workflow for a two-person code review in Crucible.

Example workflow: Two participant code review

This section describes a one-to-one review involving two people. In this example, the code author wears "two
hats", acting as review creator, and code author, managing the review process as well as taking final
responsibility for closing the review. The second person is the reviewer.

@ For instructions on Crucible workflow with more than two people, see this page.

1. The author starts the review

To begin, the code author sets up the review. There are a number of ways to do this, but for this example, the
author starts from the FishEye Source view of the file he wants to review:

Screenshot: Opening a review from the FishEye Source view
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FE ! trunk
|
build.xml
Activity Revisions Users Reports Source
[& 107905 - 107905 - Changeset Raw  Annotation Highlighting~  Columns -,

<project name="fiszheye" defanlt="code'

Tom Davies (20878 )
] Create Review

Matt Quail 2
ﬂ Conor MacHeill <!-- See https://extranet.atlassian. 13y 1
Sek Ruiz 4 <property name="bunild.release.num" value="2.4.0-M5"/

Conor MacNeill

E] Matt Quail & <property name="jvm.level" valone="1.5"/>

Conor MacNeill 57093 ] <property name="source.level" valuse="1.5"/>
Matt Quail 43022 8 <property name="compile.bootclasspath" location="1libj
Matt Quail 51318 3

From the FishEye Source view, the author chooses Reviews > Create Review. If there are multiple projects, the
Select Project dialogue opens.

Screenshot: The Select Project dialogue

Select Project for New Review
Select Project
CR-EM Build Monitor
CR-CLOV Clover
CR-CEP Claver Eclipse Plugin E
CR-CIP Clover IDEA plugin
CR-CH Confluence Hosted
CR Drefault Project
CR-FE FishEve =™
[ Create Review ] [ Cancel ]

In the Select Project dialogue, you are prompted to choose a project for this review from the drop-down list.
Once the selection is made, the author clicks Create Review. The Edit Review Details dialogue opens, where
the author can create and issue the review.

Screenshot: Creating a review in the Edit Review Details dialogue
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Edit Review Details TEST-115
Project: TEST
Title: CLOV-909: fixing build. reference binding variable correctly.

Author: Andrew Lui

Reviewers v | Suggest reviewers... Allow anyone to join

Geolf Crain

Objectives: ; Please ensure you add an acceptance test to your review comments
278411: CLOV-809: fixing build. reference binding variable correctly.

ol

Due Date:
Send Reminder: Add a reminder
Linked Review: | [ Link

Linked Issue: Link | link to CLOV-809

Add Content Abandon Review Start Review Done

In the Edit Review dialogue, the author enters information needed for the review. This includes entering a title
and description for the review, selecting reviewers, a due date and the key for a related JIRA issue (if any). The
project and author are pre-selected.

The author can also add more content to the review, if they wish, by clicking Add Content. See Selecting the
Files for the Review.

When finished, the author clicks Done. The review will now be created in a draft form.

Screenshot: A new Crucible review

Testing Project » TEST-115 &’ Edit Details 4 Share () Close o Tools ~
CLOV-909: fixing build. reference binding variable correctly.
Under Review for a few minutes Author Reviewers
TEST-115 AX @] - Prefs~ 57 Fher (9 3m
Details Details
Objectives
General Comments Participant Role Time Spent Comments Latest Comment
= trunk m Andrew Lui Author
2] atiassian-Ide-plugin xm! E Gecoff Crain Reviewer - 0% complete 3am
Total 3m 0
Files: 1

Objectives Eedi

Please ensure you add an acceptance test to your review comments
278411: CLOV-909: fixing build. reference binding variable correctly.
General Comments

There are no general comments on this review. Add a general comment.

The draft review opens. In the draft stage, the author can check the contents of the review files to ensure they
are correct and put in any notes for reviewers as comments. During the draft phase, no notification emails are
sent out to reviewers. Once the author is finished with the draft phase, he clicks Start Review.

The review will now be started and a natification email will go out to all participants. This lets them know that the
review is under way and prompts them to take action, providing a URL for direct access to the review.

2. The reviewer comments on the code

The reviewer will receive an email from Crucible with a link that they can follow to the review.
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Screenshot: A Crucible review notification email

[Crucible] State changed to Review: (CR-FE-6848) FECRU-2561 RIC: Use modal dialog for RIC popupins... & =

Inbox x  eaccru x

Val Trubnikov fisheye@atiassian.com 6:28 PM (20 hours ago) - v
tome |~

@ FECRU-2561 RIC: Use modal dialog for RIC popup instead of inline dialog.
CR-FE-6848

The state of CR-FE-6848 has been changed:

+ Val Trubnikov changed it to Review

Participants
A Val Trubnikov Author
[
":: Geoff Crain Reviewer
Objectives

210b6d97ee1ead62a5905b43d93fb345e375bf7f: FECRU-2561 RIC: Use modal dialog for RIC popup instead
of inline dialog.

Sent by Atlassian Crucible 2.9.0-rc1

When the reviewer clicks the link in the notification email, the Crucible Review screen opens.

Screenshot: The Crucible Review screen

Testing Project » TEST-115 & Edit Details [ Share () Complete &3 Tools ~
CLOV-909: fixing build. reference binding variable correctly.
Under Review for 38 mins Author Reviewers
3 =]
TEST-115 = @] v+ Pl | Y Filer | @ 6m
Details [#] /trunk/atlassian-ide-plugin.xml < Changed View = FishEye File Quidated~ 3|
Objectives 56453 [ Mark as Read
General Comments o)

Add a file comment. Click on source lines to add an inline comment.

[ trunk Nick Pellow 33805 <atlassian-ide-plugin>
[©] atlassian-ide-plugin.xml <project-configuration>
<servers>
<bamboo>
<server-id>a67c6dac-7cid-4811-930d-badblefb6foe</server-id>
<name>BEAC</name>

<url>https://bamboo.extranet.atlassian.com</url>

is this the correct server?

Lol

s

L) [ Defect| Post || keep as Draft | Discard | Quote Source

<use-favourites>true</use-favourites>
<bamboo2>true</bamboo2>

Nick Pellow alse</i
Nick Pellow 33805 <plans />
Wichael Studman [EEEII <isBamboo24>false</isBanboo24>

On the Crucible Review screen, the code changes under review are displayed. The reviewer clicks file names to
expand the code for in-line reviewing. As the reviewer reads the changes, they can simply click on any line to
enter a comment there (multiple lines can be selected by clicking and dragging).

The reviewer clicks Post when each comment is finished.

The reviewer repeats this process for all files in the review. Reviewers can leave the session and resume it later;
their work is automatically saved.

When the reviewer has finished their code review work, they click Complete.

© By default, an email is sent to participants every time a comment is posted. This is an
individual setting. Each reviewer can configure their own profiles to adjust the list of events
that will trigger email notifications.
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3. The author responds to the comments

During the review process, the author can also make contributions, responding to reviewer comments and
making corrections.

Screenshot: Comment threads in Crucible

Testing Project » TEST-115 ¢ EditDetails 4 Share (§) Close % Tools ~
CLOV-909: fixing build. reference binding variable correctly.
Under Review for 41 mins Author Reviewers
TEST-115 ] 0 - Prefs ~ % Filter ) am
Details [] 7trunk/atlassian-ide-plugin.xml < Changed| 2 View v FishEye~  File Quidated~ M|
Objectives 56453 [ Mark as Read

General Comments

Add a file comment. Click on source lines to add an inline comment.

[ trunk Nick Pellow 33805 <atlassian-ide-plugin>
[#*] atlassian-ide-pluginxml 2 <project-configuration>
<servers>
<bamboo>
<server-id>a67cédac-7cid-4811-930d-badblefbffce</server-id>
<name>BEAC</name>

<url>https://bambeo.extranet.atlassian.com</url>

Geoff Crain says:

is this the correct server?

Reply Edit Delete

ol

P

CJ [ Past || Keep as Draft | Discard | Quote Source

<use-favourites>true</use-favourites>
tryes

4. The author closes the review

When all reviewers have "Completed" their reviews, the author is notified via email. The author clicks the link in
the notification email, returning to the Review screen.

The author will then add any final comments, then click Close when finished.
This closes the review, signalling the end of work. A final email notification will be sent to the review participants,
informing them that the review is now closed. The closed review screen will load, archiving the completed review

as read-only.

Screenshot: Viewing a closed review

Testing Project » TEST-116 @ Reopen 4 Tools ~
CLOV-909: Test Review for Documentation
Closed at 20:09 Author Reviewers
&
= @
3
TEST-116 2 [#] v Pelsv |V Fitr ®em
Details Details s
Objectives
Summary Participant Role Time Spent Ci Latest C
General Comments *"?:' Andrew Lui Author 13m 2 what should the {Visitor}i..
i - Yes.
= trunk =] Reviewer - 100% complete 23m 4 (2 defects) Yes.
d atlassian-ide-plugin.xml 2 Total 41m 6 (2 defects)
Files: 1 =
Objectives

Please ensure you add an acceptance test to your review comments
278411: CLOV-909: fixing build. reference binding variable correctly.

Summary
The review was a great success.
General Comments

There are no general comments on this review.

If the author ever needs to resume work on the closed review, they can simply click Reopen when viewing this
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screen. Doing this will return the review's status to "open".

For more information on workflow in Crucible and best practices for code reviews, see Requesting and
Conducting a Review.

Using the Crucible Screens

This page contains an overview of the Crucible interface and the actions that can be carried out in the
application.

On this page:

® Tour of the Crucible Interface
® | eft Navigation Sidebar
® Related Links

Tour of the Crucible Interface

When you first log in to Crucible, the Dashboard Screen opens, as shown in the screenshot below. This view
shows recent general activity in Crucible.

Screenshot: The Dashboard Screen in Crucible

i~ Andrew Luii~

DEELVEIGE Source!~ Projectsi~ Peoplei v Reviewsi~r + Create Snippet  + Create Review
' & Tools ~
“& Dashboard i
My Reviews Commits ~ Reviews  Issues Expand all Show My Activity <«
i Today
Inbox (12}
To Review (4) Joe 24 mins ago
To Summarize (1) W ©) Re: CR-FE-5416 replied o & Adam Anmed
InDraft (7) hhmm - good question
Require My Approval (0)
Outbox (0] Seb Ruiz 29 mins ago
Out For Review (0) L) Re: CR-FE-5285 replied to . Seb Ruiz
Completed (0) | fixed the one actual breakage
Archive (5)
Closed (5) Adam Ahmed 1hrago
Abandoned (0) ) Re: CR-FE-5416 commented on review
The bug was that edges would trace back to the focused changeset, but would continue the current path,
My Snippets even if we already found a known unrelated changeset.
Also, my path wasn't storing the traversed path correctly, so sometimes the wrong edge would be marked
Iy Open Snippets (1) as related/unrelated, and duplicate changesets would show up in the path
Wy Snippets (1)
CJ Re: CR-FE-5416 repliedio i’y Joe 1hrago
Committer Mappings Yeah | could do that How does that work if this is going into a plugin?
0 _committer mappings

The table below explain the top-level tabs in the Crucible User Interface. Click on the name of a tab for more
information.

Element name Function Appears

Dashboard Tab Displays reviews and system All screens.
activity related to you.

Source Tab Displays contents of connected Only when FishEye is used with
source repositories. Crucible.
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Source Dropdown Menu Displays a list of links to Only when FishEye is used with
repositories recently visited by the  Crucible for logged-in users.
user

Projects Tab Displays reviews and content from  All screens.

specific projects.

Projects Dropdown Menu Displays a list of links to projects All screens for logged-in users.
recently visited by the user

People Tab Displays metrics on the users of All screens.
the Crucible instance.

People Dropdown Menu Displays a list of links to user All screens for logged-in users.
pages recently visited by the user

Reviews Tab Allows you to search and report on  All screens.
reviews.
People Dropdown Menu Displays a list of links to reviews All screens for logged-in users.

recently visited by the user as well
as links to the Crucible Inbox and
Outbox

Left Navigation Sidebar

The navigation bar at the left of the screen applies specific filters to what is shown in the centre pane. See the
page on Using the Dashboard for more information.

The left navigation sidebar can be hidden or displayed by clicking the blue ‘information icon @ at the top left of
the sidebar.

Related Links

Browsing Source Files

Browsing Projects

Viewing People's Statistics in Crucible
Viewing Reports

Searching Crucible

Using RSS Feeds in Crucible
Changing your User Profile

Browsing All Reviews

The instructions on this page describe how to browse all reviews on the 'Reviews' screen, by people or for
projects that you have selected as favourites. This includes reviews that you are involved with. You can also gen
erate reports on review blockers for all people.

The 'Reviews' tab is essentially a shortcut to viewing your reviews (or a custom filtered list, if you have set up a
filter). You can also view all reviews filtered by different statuses, e.g. Open, Closed.

To browse all reviews:

1. Click the arrow next to the '‘Reviews' tab at the top of the screen, and click ‘All Reviews' in the dropdown
menu. The 'Reviews' page will be displayed, showing all open reviews (‘All Open Reviews' will be
highlighted in the sidebar) unless you have previously used a custom filter. See the screenshot below.
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2. Browse your reviews, by clicking the links under the 'My Reviews' and 'My Snippets' sections in the
sidebar.
3. Browse reviews for all people by clicking the links under the 'Everyone's Reviews' and 'Everyone's
Snippets' sections in the sidebar, as follows:
0 Note, clicking any of the links below will redirect you to the 'Reviews' tab on the Dashboard. You can
click the 'Reviews' tab at the top of the screen, if you need to return to this (e.g. to access the 'Reports'
tab).
® 'Everyone's Reviews' — Click 'See reviews by state...' to expand the list of review categories in
the sidebar. You can then click any of the links to view the relevant list of reviews:
* 'All Open Reviews' — Click to view all open reviews, i.e. reviews that have not been summ
arised and closed yet.
* 'All Closed Reviews' — Click to view all closed reviews, i.e. reviews that have been summa
rised and closed.
* 'All Reviews' — Click to view all reviews, including open reviews, closed reviews and draft
reviews.
® 'Everyone's Snippets' — Click 'See snippets by state..." to expand the list of snippet categories
in the sidebar. You can then click any of the links to view the relevant list of snippet reviews, similar
to the links described above. See Browsing All Reviewsfor more information.
® 'All Open Snippets' — Click to show all open snippets.
® 'All Snippets' — Click to show all snippets, i.e. open and closed snippets.

Screenshot: Browsing all Reviews on the 'Reviews' screen

trie podon L~ QR

Dashboard Source~ Projectsi~ Peoplei~ [ IRy + Create Snippet  + Create Review
(OO .
® Review Dashboard
My Reviews N All Open Reviews [ Displaying results 1 - 50 of 563 2.3 4 5 6 7
State Review Owner Name Files Comments Age Reviewers
CWD-1549 Creating a 23
Inbox (3) Review  CR-CWD-20 - | delegated directory Shows the 7 4 ﬁfﬂnms montns 4 [
To Review (2) Tollowing. ago
CWD-1550 When creating a 23
To Summarize (1) Review  CR-CWD-21 ' user/group we have a not so 5 4 Erlgunlhs months -
InDraft(0) friendly. ago
CWD-1514 Configuration Errors . 23
Require My Approval (0) Review  CR-CWD-22 - | needto be displayed for an 18 4 B he | monts  $¥
LDAP ago
Outbox (1) QA Eng Applicant's Sel 14 "
) g ng Applicants Selenium
Out For Review (1} Review ~ CR-ATL-159 X oty 7 17 onths ;ngnunths + R
Completed (0) CWD-1793 Legacy Crowd 1 13
Review  CR-CWD-53 B inplace migration (PostgresaL 100 1 onths | MOMtNS LK
Archive (2) specific) ago
CWD-1851: Crowd's LDAP 13
Closed (2) Review  CR-CWD-54 ] RemoteDirectory 2 1 N e mons 52
Abandoned (0 ) implementations throw. ago
COMF-19050 - Allow personal " 13
Review  CR-CONF-610 ¥ sidebar lo be rendered in the 5 9 onthe monts 1@
My Snippets - correct ago
CONF-19106 Plugins can now 13 12
Review — CR-CONF-611 B provide a BandanaContext 8 14 U = |
Wy Open Snippets (0) which implements ago
SUPPORT-519 Modify email 13
My Snippets (0) Review  CR-ATL-170 ‘4 (text) response onissue 1 1 :ngnnlhs months . &
creation ago *
Everyone's Reviews - -4
13 % &
link to product specific KB in 13 |' 8
All Open Reviews (563) Review  CRATLATI & issue created email response ! B months g'vgnnntns g+
All Closed Reviews (6020 ) Ba
All Reviews (6962) 13
P = CLOV-931: XSD schema for 13
Review  CR-CLOV-119 B Glover XL reports 6 1 ronths Z'mnmns g
Everyone's Snippets - 13 oL |
Fix synchronization problem for 13
Review  CR-ATL-173 * event dispatehing 1 2 months  MoONS &
All Open Snippets (19) ago
CONF-19024 - Avoid the NPE 1 12
All Snippets (21) Review  CR-CONF-522 ¥ when requesting ai18n 1 0 months  Months &2 7
resource ago
12
Custom Filter N Changes to make Crowd 12
Revew  CR-CWD-63 o embedded Pico compatible 2 0 months g"g”n”m HE
Select a custom filter for the table CONF-19145 - Don't create the " 12
Review  CR-COMF-638 ¥ plugins-temp directary in the 3 4 N ths | monts
current ago

Notes

Related Topics

Using the Dashboard
Viewing Reports

Browsing Source Files
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@ When FishEye is installed with Crucible, you have the additional 'Source' tab available in the
navigation tabs at the top of the screen.

To browse source files:

1. Click the 'Source' tab. The 'Repositories' view will be displayed, showing summary information if you
have multiple repositories set up. See the 'Viewing all repositories' screenshot below.

2. Click the desired repository to view its contents. See the 'Viewing a repository' screenshot below.

3. Browse the repository for the desired source file using the directory tree in the left menu. Click the file that
you want to view. The file will be displayed in the main panel. See the 'Viewing a file' screenshot below.

4. You can view various information about the file, as outlined in the table below:

Sub-Tab Name Description

Revisions When viewing a file, shows the latest revisions of
the file.

Files When viewing a folder, shows the contents of the
directory.

Activity Shows recent activity on the item. There are a

number of sub-options here:

* All Activity — The default view, showing
commits, reviews and JIRA issues.

* Commits — Shows commits in the activity
stream.

* Reviews — Shows review activity in the activity
stream.

* Scroll to Changeset — Opens the changeset ID
specified in the text field (press Enter to carry out
the action).

* Filter — Applies constraints to the current
activity stream.

* Show Revisions — If this is selected, then
changeset items are automatically expanded to
show modified files.

* Earlier Activity (Left Arrow icon) — Loads a page
of earlier activity.

* Later Activity (Right Arrow icon) — Loads a page
of later activity.

Users Shows the commit history of the different users
that have committed changes on the item.

Reports Shows activity charts for the item. Various chart
options can be selected in the left navigation bar.

Source Shows the contents of the file.

Query Allows you to run an advanced search.

© To download files, firstly click through the desired file. From there, you will see a control bar directly
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above the code content which contains the 'FishEye' item. Clicking this leads to a drop-down menu
where 'Download Raw File' is available. You can use this to download the file in context only.

Screenshot: Viewing all repositories

Du v Ao Lt - CESE
Dashboard Projects  People  Reviews + Create Snippet  + Create Review
@ Repositories
State Commit History (12 Months) LoC Commits Reviews
cLov Running -l.l|||., . .|I||III.||I|,| ) 269,159 8454 201
Fe Funming II||||||||I|.IIII||IIII|I|||||I||||III|||||||I||. pesazz s s
FEP
Running I|||||||||||.||I||||||III||||.|||I.||I|II|I||I|||||| fesae 1edsz e
Repositron Running II 4277 24 1

Screenshot: Viewing a repository

D+
Dashboard

T
trunk VY23 p

[3 branches/

Priv Andrew Luii ~ (G

RLNGLE Projects People  Reviews + Create Snippet  + Create Review

& Tools ~

Search
Hide Deleted Files

Activity Files Users

Permalink  Download Archive

Reports

Es
3 buildnumber/ Name Revision Date  Author
& tags! [ branches
3 trunki
(3 buildnumber
[ tags
3 trunk

Screenshot: Viewing a file

D+8 Y- ancrew Luil - CEEED
Dashboard QELNL-W Projects People Reviews + Create Snippet  + Create Review
FE / trunk / build_xml
i
build.xml
3 branches! =T Activity Revisions Users Reports Source
o (3 buildnumberi Diff 2 selected Diff latest W Filter Include other branches Show all details & a1
2 tags/
E=trunk/ 06 Sep Nick Pellow Annotation | Changeset i~
3 idear L trunk S0
9 settings/ CRUC-4130: removing jwebunit dependency from functests. refactored how browserbased tests get
B3 admin/ selected for running
[ artworks
2 build-dependencies/ RevisionID 107905
3 bundled-plugins/ F'are.nts trunkibuild xml 107897
B3 contrib! Properties cenqua = hello
= d;d - ’ svneol-style = native
river/
svnexecutable =*
(53 dependencies! svnkeywords = Author Date |d Revision
3 doc/ less
Eetu [ 06 gep Conor Machleil Annotation | Changeset i+
fe-jar -
! frunk +1]-1
2 fecru-applinks-webitem-plugin; Revert name of target
[ fecru-gadgets-plugin/ more
[0 fecru-rest-plugin/ _ )
2 1ib/ [7] 06 Sep Conor MacNeill Annotation | Changeset @+
+8 1
2 maven-dependencies! frunk
3 plugins CRUC-3755: Validate Crucible Only using two methods rora
2 processutils/
3 products! [7] 05 gep Conor Macheil Annotation | Changeset @~
(3 salplugin/ frunk 017
3 selenium. Remove old dross from build - optimising away optimiseit
£ conan more

Using the Dashboard

The Dashboard is the first screen that you see when you log into FishEye/Crucible. It is the home page for the

instance and can be accessed by clicking the FishEye/Crucible icon , or by clicking Dashboard at the
top.
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The Dashboard sidebar displays your reviews, and activity is displayed in the main pane.

Screenshot: Viewing the Dashboard

Dashboard [EHIVGEERG

Projects | ~

People: =

"{ Dashboard
My Reviews

Inbox (12)
To Review (4)
To Summarize (1)
InDraft (7)
Require My Approval (0)

QCutbox (0)
OutFor Review (0)
Completed (0)

Archive (5)
Closed (5)
Abandoned (0)

My Snippets

My Open Snippets (1)
My Snippets (1)

Committer Mappings

0 committer mappings

Foi- prsew e - QR
Reviews : = + Create Snippet  + Create Review
3 Tools ~
m Commits Reviews Issues Show My Activity ¢'
Today
Joe 24 mins ago
Y C) Re: CR-FE-5416 replied to @ Adam Ahmed
hhmm - good question.
Seb Ruiz. 29 mins ago
C) Re: CR-FE-5285 rephedtn. Seb Ruiz
I fixed the one actual breakage
Adam Ahmed 1 hr age

2

C) Re: CR-FE-5416 commented on review
The bug was that edges would trace back to the focused changeset, but would continue the current path,
even if we already found a known unrelated changeset.

Also, my path wasn't storing the traversed path correctly, so sometimes the wrong edge would be marked
as related/unrelated, and duplicate changesets would show up in the path

D Re: CR-FE-5416 replied o 1" Joe 1hrago

Yeah | could do that How does that work if this is going into a plugin?

Using the 'My Reviews' sidebar

The 'My Reviews' sidebar contains information about reviews/snippets that you are involved with, e.g. how many

reviews require your approval. Read more about the sidebar in Browsing All Reviews.

® Click on any of the links in the sidebar to navigate to that information in the 'Reviews' tab of the

Dashboard.

® Hover your mouse over the sidebar and click the collapse icon (“) to hide any of the sections. Click the
expand icon () to expand any collapsed sections.

® Click the 'i"icon (ﬂ) to hide/show the entire sidebar.

Inbox

Click to show all reviews in 'To Review', 'To
Summarize', 'In Draft' and 'Require My Approval' stat
es:

® To Review — Click to show all reviews where you
are a reviewer and haven't yet completed your
review work.

® To Summarize — Click to show all reviews where
you are a moderator and haven't yet summarised
and closed the review.

® |n Draft — Click to show all reviews that you have
created but have not yet been moved to the
'‘Approval’ state or the 'Require Approval' state.

® Require My Approval — Click to show all reviews
where you are a moderator and need to approve th
e review.
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Outbox Click to show all reviews in 'Out for Review' and
‘Completed' states"

® Qut for Review — Click to show all reviews that
you are a participant of, that have review work that
is yet to be completed by other reviewers.

® Completed — Click to show all reviews that you
are a participant of, and have been completed.

Archive Click to show all reviews in 'Closed' and 'Abandoned’
states:

® Closed — Click to show all reviews that you are a
participant of, that have been summarised and
closed.

® Abandoned — Click to show all reviews that you
are a participant of, that have been abandoned.
You may wish to delete these reviews.

My Open Snippets Click to show all open snippets created by you.
My Snippets Click to show all snippets created by you.

Using the Activity Stream

The Dashboard has an activity stream that displays the following information:

® reviews activity — This includes the addition of review comments, opening and closing reviews, etc.

® source activity — This includes files being committed to a repository.

® jissues activity — If you have linked a JIRA server with your Crucible project, the activity stream will also
include updates to linked JIRA issues.

Your activity stream will only display information from projects, reviews, people, repositories, etc, that you have
selected as favourites as well as your own activity. For more information on favourites, see Using Favourites.

The following instructions describe how to view the activity stream and filter it to display specific information.

® Commits tab — See Browsing Source Activity only below.

® Reviews tab — See Browsing Reviews Activity only below.
*Issues tab — This tab will only display if you have connected a JIRA instance to your FishEye/Crucible
instance. See Browsing Issues Activity only below.

® Show My Activity checkbox — Untick this checkbox to filter out your activity from the activity stream
displayed. This toggle can be used in any of the tabs for the activity stream.

Browsing Source Activity only
Source activity includes files commits to repositories that you have selected as favourites.
Click the Commits tab to filter the activity stream to display only source activity (see screenshot below).

Browsing Source Activity on the Dashboard
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All Reviews Issues Expand all Show My Activity CZ'

Geoff Crain 1 hrago

[E] 24820:6307d9075/24 changed 0 files & default

merge

~ [E 24819:288d2990eae5 changed 3files & default ® CR-FE-5437 1hrago
FECRU-826: order and group comments in emails by file
+13 -14 @ Jetcidist!. /html/batch-comment-note fl
+9 10 @ [etc/dist!. /plain/batch-comment-note. fi
+33 -4 @ /srcfjaval. /CommentMessageCreatorjava
Tom Davies 2 hrs ago
[El 24815:a854afed2caf changed 0 files ¥ 2 5-FE-3028-tdavies

MNOME: abandaon branch

+ [E 24814:e3ef85/a55¢e changed 4 files Vas 3 hrs ago
FE-3028: adjustlast lines with extra gutter plugin td
+2 -2 @ [src/. JdiffRenderer-eachwholeline.tag
+11 -0 @ [srcicontent!../diffRenderer-blankline.tag

+1 -1 [ isrc/icontent.ireview/diffRenderertag

Browsing Reviews Activity only

Reviews activity includes updates to reviews in all projects that you have selected as favourites. See Browsing

All Reviews for more information about browsing reviews.

Click the Reviews tab to filter the activity stream to display only reviews activity (see screenshot below).

Browsing Reviews Activity on the Dashboard

Al Commits Issues Expand all Show My Activity L=

Today
Joe 1 min ago
g CJ Re: CR-FE-5360 replied to [l Seb Ruiz
fixed.
C) Re: CR-FE-5416 replied to [ Adam Ahmed 1hrage
hhmm - good question.
1hrago

Zeb Ruiz
CJ Re: CR-FE-5235 replied to [l Seb Ruiz

| fixed the one actual breakage

1 hrago

Adam Ahmed
+ () Re: CR-FE-5416 commented on review
The bug was that edges would trace back to the focused changeset, but would continue the current path,

even if we already found a known unrelated changeset.

Also, my path wasnt storing the traversed path correctly, so sometimes the wrong edge would be marked
as related/unrelated, and duplicate changesets would show up in the path.

CJ Re: CR-FE-5416 repliedto "+ Joe 2 hrs ago

Yeah | could do that. How does that work if this is going into a plugin?

Browsing Issues Activity only

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.

48


http://creativecommons.org/licenses/by/2.5/au/

User Guide for Crucible 2.10

Issues activity includes updates to issues in JIRA projects that are associated with your favourite Crucible
projects. For more information about integrating JIRA with Crucible, see JIRA integration in Crucible.

Click the Issues tab to filter the activity stream to display only issues activity (see screenshot below).

Browsing Issues Activity on the Dashboard

All Commits Reviews Expand all Show My Activity

Thursday 28 Apr
E Michael Heemskerk 1:17 am
X changed the FixVersion/s to '2.4.0' on CRUC-3814
¥ changed the Fix Version/s to "2 4-M5" on CRUC-3814 117 am
..] Conor MacNeill 12:34 am
-

¥ updated 3 fields of CRUC-3755

= Seb Ruiz 10:25 pm
x updated 2 fields of CRUC-3879

W changed the Fix Version/s to '2.4.0' on CRUC-3879, CRUC-3479 10:25 pm
¥ updated 3 fields of CRUC-3479 10:25 pm
E 4 dhansen@atlassian com §:28 pm

W changed the Link to This issue relates to FE-2775 on CRUC-3569

Watching an Activity Stream

You can "watch" an activity stream in FishEye/Crucible. Watching the activity stream allows you to receive
emails when updates occur in the activity stream. You can view all of your watches and configure the frequency
of your watch emails in your user profile. See Changing your User Profile for more information.

Note, the option to add a watch will only be available if the administrator has enabled watches for the repository.

To watch an activity stream:

1. Navigate to the activity stream that you want to watch.
2. Click the Tools menu and click Watch. The page will reload and a watch will be set up for the activity
stream (the watch icon will be coloured, not grey).
® |f you want to remove the watch, navigate the activity stream, click Tools then Watch. The watch
will be removed (the watch icon will be coloured, not grey).
© You can also remove watches via your user profile.

Notes

Related Topics

Browsing All Reviews
Using Favourites
Changing your User Profile

Crucible Icons

This page contains a list of Crucible icons and an explanation what each one represents in the user interface.
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Icon
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0

Searching Crucible

50

Description

View review-level comments

Go to the previous comment

Go to the next comment

Add a comment

Go to the previous file in this review
Go to the next file in this review
Expand all files

Collapse all files

A file included in this review

A directory included in this review

Crucible has a powerful search engine that allows you to find reviews. There are two methods for searching in

Crucible:

® Quick Search — The Quick Search allows you search all Crucible projects by entering a single search
string. This search is the default search and will suggest "quick nav" results (header search box only).

Results are weighted by most recent edit date.

® Filtering Reviews — An alternative method for searching for reviews is to display all reviews and apply a
custom filter to the list. This is generally slower than searching, but allows you to specify filter criteria

against a range of fields.

® Comment Search — If you want to find specific review comments, Crucible provides a powerful

comment search.

On this page:

Using the Quick Search

Filtering Reviews

Searching for Review Comments

Notes

Using the Quick Search

Before you begin:

® The Quick Search will also return changesets and files, if you are using FishEye with Crucible. For
information on searching FishEye, see Searching FishEye in the FishEye documentation.

To search Crucible using the Quick Search:
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1. Enter your search criteria in the search box in the Crucible header (Quick Nav). Crucible offers a number
of parameters and functions that you can use to refine your expected results, see Refining your Quick
Search Criteria below.

2. "Quick Nav" results will appear in a dropdown, as you type. "Quick Nav" will attempt to match against the
review name, project and user.

® If you want to use a quick nav result, use the up- and down-arrows on your keyboard and press
enter or use your mouse to select the item.

® |f the quick nav results don't have what you are looking for, press enter to run a search. Ensure
that no items in the dropdown are selected when you press enter.

3. The Quick Search results page will be displayed. You can filter your results further, as described in Filteri
ng Quick Search Results below.

Results are sorted by relevance and boosted if they were edited recently. A maximum of 10 results are
displayed per page.
® |f you have integrated your Crucible instance with a JIRA instance, you can display a summary
of any JIRA issues referenced in your search results by hovering over the issue key. For more
details, see JIRA integration in Crucible.

4. If you want to run another search, enter your new criteria in the main search box or in the search box in

the header.
Note, only the search box in the header provides "quick nav" results.

Repository FE-hg

|£| puild.xml ()
Reviews

@ CR-FE-5306 : FECRU-512; add functestforr...
@ CR-FE-5408 : FECRU-138: FINAL final versio...
@ CR-FE-5411: FECRU-138: use defaultvalue...
- @ CR-FE-5431: FECRU-762: Add throttle and d...
@ CR-FE-5467 : FECRU-798: initial implement...
- @ CR-FE-5472: FECRU-798: fixing js tests. ad...
@ CR-FE-5482 : Move shared top-level code int. ..
33433 54(@® CR-FE-5489: FECRU-762; Reduce throttle o...
@ CR-FE-5490 : FECRU-138: review rework. fa...
- 261 @ CR-FE-5492 : FECRU-816: add a message”. ..

LoC Commits

O\ Search for build xml’

- 6,51

Screenshot above: Quick Search displaying "quick nav" matches

Refining your Quick Search Criteria

The Crucible Quick Search has a number of powerful tools that you can use to refine your search criteria before
executing the search.

Search Tool Description Example
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Field Handles

Searching for Discrete Strings

Filtering Quick Search Results

Use a field handle in your criteria
to restrict your search to a
particular field. Note, you cannot
have multiple field handles in a

query.

® detai |l — Search against title,
objective, key, linked reviews
and linked issues.

® revi ewconment — Search
against review comments.

Enter a specific string within
guotation marks and Crucible will
match against the exact string.
Note, this search is not
case-sensitive.

Enter "CR- 2818" and Crucible will
only return results that match that
exact string, i.e. it will not return a
result with CR- FE- 2818 or CR- 28
189.

Once you have a set of search results on the Quick Search page, you can filter them to a subset of the original
results. The filter controls are in the left panel of the Quick Search page in the 'Source' section.

Filter

Projects

Reviews

Comments

Filtering Reviews

Description

Select or enter the name of the project that you want
to restrict your results to. For example, if you enter
'CR' then the search results page will refresh to
display only reviews in the 'CR' project.

If you are using Fisheye with Crucible, there will
be a repositories dropdown in the 'Source' section.
Selecting a FishEye repository in this dropdown will
not filter the Crucible search results. It is only used to
filter files and changesets returned in the search
results. See Searching FishEye.

Click this link to restrict your results to reviews that
have a title, objective, key, linked reviews or linked
issues that match the search criteria.

Click this link to restrict your results to reviews that
have comments that match the search criteria.

Crucible allows you to view all the reviews/snippets that you are involved with, as well as everybody's
reviews/snippets. You can filter these lists to find reviews.

To filter a list of reviews:

1. Navigate to the 'Reviews' tab.
2. Click the list of reviews that you want to start with, in the reviews sidebar of the 'Review Dashboard', e.g.

'All Open Reviews'.
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3. Click the 'Custom Filter' in the reviews sidebar.

4,

Update the filters with your search criteria (see table below) and click 'Apply Filter' to filter the reviews.

Filter Description

Title Find reviews by searching for words within the
title.

Project Find reviews under a particular project.

Author Find reviews moderated by a particular authors.

Moderator Find reviews moderated by a particular moderator
S.

Creator Find reviews created by a particular creator.

Reviewer Find reviews that are reviewed by a particular revi

ewer. This will default to the user logged in.

Reviewer Status This is reliant on the above filter and is used to
show reviews that have either been completed by
the reviewer, not completed or all reviews.

Match Roles To use all the above filters, choose 'all'. To use
any of the filters, choose 'any".

Review state checkboxes Check any of the review state checkboxes (e.g.
'Draft’, 'Pending Approval’) to filter for reviews in
those states.

Searching for Review Comments

To search for review comments:

1.
2. Enter your search criteria in the 'Comment Search’ section at the bottom of the reviews sidebar.

3.

4. The '‘Comment Search' page will display your results. You can refine your search using the search criteria

Navigate to the 'Reviews' tab.

Click 'Search Comments'.

on the page:

Project Find comments on reviews under a particular
project.

Comment content Find comments that contains the specified text.

Review Permald Find comments made on the specified review.

After Find comments made after after a particular date.

Before Find comments made after before a particular
date.
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Comment Author Find comments made by a particular user.
Search Type You can:

® Tick the 'Defects' check-box to find comments that are flagged as Defects.
® Tick the 'Comments' check-box to find comments that are not flagged as Defects.
® Tick neither check-box (or both of them) to find all . ||

Review State Find comments on reviews that are in a particular
state. See Review State Filter (above).

Ranking Find defects have been given a particular ranking
(e.g. 'Major', 'Minor").

Requires Re-Review Find defects that have been marked as requiring
re-review (or not).

Classification Find defects that have been given a particular
classification (e.g. 'Missing', ‘Ambiguous’).

Search Criteria

Search Criteria
Froject: | Any Project i
Comment content:
Review Permald:
After:
Before:
Comment Author | any W
Search Type:

DDEfEE’tE Dlicmmsnts

Review State:

[Joraft []Pending Approval [ Under Review
DEummﬂri2= DIZI::EEd Dﬂtﬂndcned
[JRejected [| Needs Fixing

Metrics:

Ranking:

|Se|ectRanking V|
Requirez Re-Review:

|Se|ectRequires Re-Review V|

Claz=sification:

| Select Classification V|

Search Comments ]
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Screenshot above: Search Comment Filter Options

Displaying Defect Metric Charts for Comment Search Results

Once you have retrieved results for a review comment search, you can click 'Defect Metrics' in the left

navigation pane to display defect classification charts.

A . £ Tools ~
Io Defact Mekics @ Crucible - Comment Search
Comment Results Displaying resuis 1- 50 of 3851 2 3 4 5 6 7
Review Hame Created  Custom Fields Content
® Unclassifie cares [ men quan 25 Feb 2008 this changes the nstance that i returned by cig.getRepostoryAmayix). Conskler the nstance before as A and the
new instance of RepostoryType as B.
® Mir
We need to look at anything that may be holding a reference fo A For example, any running repostaries. &g
ReapistaryConfiy 7 Is is il valid for them to call methods an A, or da they get 8 "disconnected from DOM” type of
exception?
| remember *somathing® ke this causing a problem before, but m not sure if this & the exact example.
H this is & problem & workaround would b to change ine 79 to something ike:
® Unclass editing = cfg.getRepAmay(rep);
. if (i JustTesting) {ediing = editing. copy(); }
\ what do u think?
CR-FES “ Matt Quail 25 Feb 2008 ‘cept that ReopsioryType is slready the perfect POJO for that? or is & perfect vis.a.vis disconnected dom crap).
Al the adrin pages suffer from this "updating hve dom object” problem. I needs to be addressed with a betier
design, but fm not sure exactly what & & and wouldn't want to introduce a second poor LSage until we werk out the
best usage (better the devil you know at this point?)
case [ watauar 25 Feo 2008 cool
i cares [ vt aust 25 Feb 2008 remove throws clause? (and propagate?)
® O1he cases [ wan auen 25 Feb 2008 dile exeaption nesdad?
cares [ et cuoi 25 Fen 2008 ‘can we remove our dep in pom.xml on this package now (2 may st be transient, but af least we shoukint declare &)
cares [ et cuoi 25 Feb 2008 retum nul instead of ™ 7
cares [ vatt uni 26 Feo 2008 Can you check (andior raise a jra) that the FishEye JRA plugin sends o “projciitey” request param?
cases [ ot auar 26 reb 2008 good stuff
caseo [l watt auat 26 Feb 2008 Ranking Winor space after comma
Search Criteria careto B et usi 28 Feb 2008 Rankng: uinor space betwesn speralnrs
careto B et ausi 25 Feb 2008 This s nice, but Im wondering if §is worth &; piacing the xira effort on each notification lo wrie two emal
generating methods.
Project: | Any Project -
Yol Ithink ks okay that if an emor occurs, the emad doesn't get sent..?
caseo [l watt auan 26 Feb 2008 this decl can be moved into try?
Review Permald CRFE-10 ﬂ Matt Quai 26 Feb 2008 It might be worth alse catching RuntimeException, in case same bit of the template (or the code i calls) throws, s4y,
_ aNFE?
That, or just catch Exception?
care-10  [J matt cual 26 Feb 2008 spaces afier comma
- °r | Matt Quail L care10 [ wat auar 26 reb 2008 this fie is empty?
- _ o care0 st ausi 26 Fen 2008 thia & why | love treemarker -)

Screenshot above: Comment Search Results

Notes

Related Topics

Searching FishEye (FishEye documentation)

Viewing people's statistics in Crucible

This page contains instructions on how to use the People tab in Crucible to see charts and activity from people

with accounts on the system.

On this page:

® QOpening the list of People
® Viewing a Person's Activity Screen

55

® Viewing charts of a person's activity

Opening the list of People

To view statistics on People in Crucible, (that is, code authors, committers and reviewers) click the People tab at
the top of the page.

The list of all people shows all users that have accounts on the system. By default, each user has a unique
avatar that is randomly formed from the text in their email address. You can add your own avatar by uploading
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an image to an external service such as Gravatar, which Crucible supports. See Changing your User Profile.

Screenshot: List of all People in Crucible (when using FishEye with Crucible)

Dashboard Sourcei~ Projects | v WEEWEERS Reviews i~ + Create Snippet  + Create Review

88 All Users

2 3 4 5 3] 7 »
Commit History (12 Months) Commits Reviews
- Aleksander |
L St fus . |I|_. o Ll R
Alex Manusu ] ]
3 Alex Wei Ill I 2530 38
A (11| Y A T
Alex Zuzin ] ]
§8  Alexander Dickson 497 153
a ...|||I|.....||| Il ..l:...__
E Alexander Hennecke | 982 13
Alexandru Lazar " I II 49 1]
f*' mi III {1 | IIIII [ |0 ] III
Alison Winterflood “. I I 1,025 57
! o !_'I..l-!!:r!— :hl!l: '

Viewing a Person's Activity Screen
Click on a username to see a listing of activity for them as well as charts showing statistics for their activity.

The right hand pane displays a list of all activity for this user. You can:

click the icons to view full commit information in FishEye
click JIRA issue nhames to open the work ticket on an item
click the long button to see the list of files in context

click the star icon to add an item to your favourites.

The left hand pane displays charts around this activity, including:

number of active reviews
charted history of lines of code
code committing activity
general statistics.

Screenshot: The People Activity Screen in Crucible
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v, Joe Xie
Activity
o About All Commits m Expand all
jxie@atlassian.com Monday 03 Dec
First commit 20 January 2008
Latest commit 02 August 2012 Joe Xie
Last Wesk  All Time . @ CR-FEP-87 finished reviewing
Commits: 0 2,789
Files changed: ] 4,718 Sunday 02 Dec
Change in LOC: o 62,845
Joe Xie
( Help with these stats ) W ) Re: CR-FEP-87 commented on review

Follow Joe Xie

Reviews

Dashboard  Source:~ Projects: = NEWlCHEg Reviews i - + Create Snippet  + Create Review

12, -
28 Tools

7:09 pm

9:03 pm

What is a ClearCacheEvent? and is it something that would ocour during normal operation in jira? Also, there

X CJ Re: CR-FEP-87 commented on review 9:00 pm
0 active reviews
if its true that only tests uses this event, then perhaps a quick comment here would be great.
Line History Monday 18 Nov
Joe Xie 11:43 pm
A N
! N e . & CR-FE-6898 finished reviewing
| Q Re: CR-FE-6898 replied to ‘E: Richard Stephens 11:43 pm
10t / f
/ | so is the problem with the way 10Utils.toString(} not using the correct encoding?
. I I ) Re: CR-FE-6898 replied to [l Richard Stephens 11:38 pm
WOW.
2009 2010 2011 2012 2013
. Committer jxie in FE Wednesday 07 Nov
Committers joe xie <jxie@atlassian.comz,
. joe xie <jxie@atlassian.com and joe xie Joe Xie 10:15 pm
<jxie@atlassian.com> in FE-hg (Line » . . )
history not available) . @ CR-FE-6862 finished reviewing
. Committer jxie in FEP !
Committer joe xie <jxie@atlassian.com= in
atlassian-hitp (Line history not available) ) Re: CR-FE-6862 replied to [l Richard Stephens 10:14 pm

. Committer joe xie <jxie@atlassian.com= in
atomicreptile (Line history not available)

these classes are copied from jira. You should check if these classes are now part of atlassian-http, and if

© Some users may not appear to have the correct number of Files Changed or LOC, despite
regularly committing. In this situation, if they have committed to a directory which is not
covered by the regexes in your symbolic definition (i.e. they have committed to a directory
that is neither trunk, branches or tags) then that directory will be counted as part of trunk.
Also note that creating tags and branches themselves does not count toward the totals.

Viewing charts of a person's activity

To see information on a person's activity charted in detail, click the headings in the left-hand pane. Each heading

will show more information on demand, when clicked. The information available and what it means is listed

below.

The charts in this section are only available when using FishEye.

Screenshot: People Activity Charts in Crucible

* About
The username section shows the email address,
then the first and latest commit dates for the person
in context.
Also displayed are data points for the previous
week and all-time. It shows number of commits,
number of files changed and number of lines
changed.
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[ *. Joe Xie

jxie @atlassian.com

First commit 20 January 2008
Latest commit 02 August 2012

Last Week  All Time
Commits: 0 2,789
Files changed: 0 4718
Change in LOC: 1] 62,845

{ Help with these stats )

Follow Joe Xie

To Review (0)
Ready to Close (0)
Out For Review (0)
Openi2)

Closed (1017)

. Counts may include data that you
cannot access.

2008 2009 2010 2011 2012 2013

B committer jxie in FE

Committers joe xie <jxie®@atlassian.comz=,
joe xie <jxie@atlassian.com and joe xie
<jxie@atlassian.com= in FE-hg (Line
history not available)

Committer jxie in FEP

Committer joe xie <jxie@atlassian.com= in
atlassian-http (Line history not available)

. Committer joe xie <jxie@atlassian.com= in
atomicreptile (Line history not available)

. Committer joe xie <jxie@atlassian.com= in

mramimithnnlees (1 ine hietnre nnt awvailahlad

® Reviews

The Reviews section shows several filters that you
can click to constrain the review items shown in the
right-hand pane. The options are To Review, Read
y to Close, Out For Review, Open and Closed.

Line History

The Line History section shows a graph with the
number of lines committed to the repository,
charted over time.

Commit Activity

The Commit Activity section shows four smaller
charts; the first showing the volume of commits
over a 52 week period; the second showing the
relative number of commits on days of the week;
the third showing the relative number of commits
by the hour of the day when they were lodged; the
last shows a commit calendar.

Committer Mappings

The Committer Mappings section displays usernam
e mappings from various systems if they have
several usernames in play.
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AL PSR i F RS R | P LW LR L

Committer joe xie <jxie@atlassian.com= in
remaote-issue-crea... (Line history not
available)

52 week commits volume

Commits by day

sun Man  Tue  Wed Thu Fri Sat

Commits by hour

0o 04 08 12

Commit calendar

J FMAMUJIJIAS OND
2012
2011
2010
2009
2008

Username jxie is mapped to:

jxie in FE

joe xie <jxie@atlassian.com= in FE-hg

joe xie <jxie@atlassian.com in FE-hg

joe xie <jxie@atlassian.com= in FE-hg

joe xie <jxie@atlassian.com: in atomicreptile
jxie in FEP

joe xie <jxie@atlassian.com= in atlassian-
http

L I I I

Browsing Projects

To browse the content in a project, click the Projects tab
at the top of the page. The 'Projects' view opens (see 'The
Crucible Projects Index' screenshot below).
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A list of projects will be shown if there is more than one. Click the name of the desired project to open it. The 'Pr
oject Activity' page opens (see 'The Crucible Project View' screenshot below). In the left navigation bar, charts

showing overall project statistics are displayed.

There are a number of sub-tabs on this page, listed in the table below.

Sub-Tab Name

Activity

Reviews

Description

All Activity — The default view.

Commits — Shows commits in the project (visible
when using FishEye).

Reviews — Shows reviews in the project.

Issues — Shows JIRA issues related to this
project. i@ Only visible if you have set up JIRA
integration in Crucible.

Show Revisions — Shows or hides revisions in the
project (visible when using FishEye).

Earlier Activity (Left Arrow icon) — Loads a page of
earlier project activity.

Later Activity (Right Arrow icon) — Loads a page of
later project activity.

Shows recent reviews in the project.

© The Projects tab is only visible in Crucible. Read more about the definition of a project.

Screenshot: The Crucible Projects Index

@ Projects

Default Project CR

Build Monitor CR-BIM

Clover Eclipse Plugin CR-CEP
Confluence Hosted CR-CH
Clover IDEA plugin  CR-CIP
Clover CR-CLOV

FishEye CR-FE

JIRA FishEye Plugin  CR-FEF
Jira Studio CR-JST

LinkChecker CR-LNKCHEK

Fourwalls FOUR

Repository
CLOV

B

CLOV

CH

CLOV
CcLov
FE-hg

FEP

JST
LinkChecker

CLOV

Screenshot: The Crucible Project View
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@ FishEye LR

Activity Reviews

i ) FishEye Commits Reviews Issues Show revisions &
Activity on this page:

CR-FE (reviews) Michael Heemskerk

FE-hg (repository)

FE (repository X' closed CRUC-4450 01:07
CGIT (repository)

¥ changed the status to To be reviewed of CRUC-4450, CRUC-4607 01:.06
Line History
W changed the status to Quality Review of CRUC-4607, CRUC-4449 01:06
| S
f 7 @ started review CR-FE-4320 01:06 G

CRUC-4449: ClearCase: error in storing repository configuration after creating new repo

<7 [ Michael Heemskerk and [l Seb Ruiz resumed reviewing CR-FE-4284 01:05

E ! Michael Heemskerk
2004 2006 2008 2010 B ¥ started progress on CRUC-4449 01:05

. Path /in FE-hg (line history not available)

B Patnsincerr ¥ closed CRUC-4442 CRUC-4399 0104
I Patn 1inFe
i Ping Lyons
Stats 5] committed 19189:a19e0b948548 to FE-hg on branch default 01:04 fhv
Total Commits 40,257 CRUC-3300: more func tests for RestReviewSenice
Last Commit: 01:04  changed 11 files
Commits this week: 293 [ fecru-rest-plugin/sre/mainijavalcom/atiassianfecrurestplugin/crucible/RestReviewService. java (+332 -444)
Total Lines of Code (LoC): 693,936 [ srcfapilsreimainiavalcomiatiassianicrucibleispi/dataiGeneralCommentData java (46 -38) A B &

Viewing Project Statistics
This page explains the layout of the Project Summary page.
On this page:

Project Name Panel

Project Line History Panel
Project Stats Panel

Project Commit Activity Chart

When you click through to a Crucible Project from the Projects Tab, the 'Project Summary' screen opens.

Screenshot: The Crucible Project Summary Page
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3T -
. i3 Tools
@ FishEye
Activity Reviews
i ) FishEye Commits = Reviews Issues Show revisions &
Activity on this page:
CR-FE (reviews) Michael Heemskerk
FE-hg (repository)
FE (repository X' closed CRUC-4450 01:07
CGIT (repository)
¥ changed the status to To be reviewed of CRUC-4450, CRUC-4607 01:.06
Line History
W changed the status to Quality Review of CRUC-4607, CRUC-4449 01:06
't
f l 7 @ started review CR-FE-4320 01:06 =~
{ /
f . CRUC-4449: ClearCase: error in storing repository configuration after creating new repo
. <7 [ Michael Heemskerk and [l Seb Ruiz resumed reviewing CR-FE-4284 01:05
ak
E ! Michael Heemskerk
2004 2006 2008 2010 B ¥ started progress on CRUC-4449 01:05
. Path /in FE-hg (line history not available}
osed - . .
. Path /in CQIT ¥ closed CRUC-4447 CRUC-4399 01:04
I Patn 1inFe
i Ping Lyons
Stats E committed 19189:a19e06948548 to FE-hq on branch default 01:04 =~
Total Commits 40,257 CRUC-3300: more func tests for RestReviewSenice
Last Commit: 01:04  changed 11 files
Commits this week: 293 [ fecru-rest-plugin/sre/mainijavalcom/atiassianfecrurestplugin/crucible/RestReviewService. java (+332 -444)
Total Lines of Code (LoC): 693,936 [ srofapilsreimainfavaicomiatiassianicrucible/spi/dataiGeneralCommentData java (+46-28) A B © &

In the right hand pane, you can see an activity stream relating to this project. In the left hand pane, you can see
various statistics charts relating to the project in context. These appear in a reduced size until you click them,
when they will expand to show more information.

Project Name Panel

This contains a short message explaining which Crucible Project and FishEye repositories are being accessed
to show the activity stream on the page.

Project Line History Panel
This panel contains a chart showing the lines of code added to the repository, graphed over time.

Screenshot: The Project Line History Panel
Line History

A TO0K
Iy RONK

[ e GO0k
| ey 400K
J 300K
T 200K

'J-" 100K

9K
ik
3k
1]
2004 2006 2008 2010

B eatnin e

Project Stats Panel

This panel contains a chart showing numerical data for commits, files changed and lines change, graphed over
time.
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Screenshot: The Project Stats Panel

Stats
La=st Week Al Time
Commitg: 137 16,033
File= changed: 543 69,896
Lines changed: 33,043 504,583

Project Commit Activity Chart
This panel contains a number of charts:

Chart

Commit Activity

52 week commits volume

Commitz by day

Sun Maon Tue  Wed Thu Fri Sat

Commitz by hour

i

0o 04 08 12 16 20

Commit calendar

J FM AMJI J A 5 0O N D
oo N
2003
2007
2006
2005
2004
2003
2002

Viewing Reports

Description

52 week commits volume
This chart shows the amount of commits, shown by
week over a one year period.

Commits by day
This chart shows the amount of commits, graphed by
day over the past week.

Commits by hour
This chart shows the amount of commits, graphed by
hours over the past day.

Commit calendar

This chart shows the amount of commits (shown as
darker colours to indicate more commits) graphed by
month, over years that the repository has been
running.

This page contains instructions on how to use the Reports tab in Crucible to see lists of people whose action is

required on open reviews. These are known as 'blockers'.
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FishEye Reports (on this page):

* Viewing the 'Review Blockers' report
® Viewing the 'JIRA Blockers' report
®* Viewing the Review Coverage Report

Viewing the 'Review Blockers' report
To view a list of people who have open reviews assigned to them,

To view the 'Review Blockers' report:

1. Click the dropdown arrow next to the 'Reviews' tab at the top of the page and select 'Reports' from the
dropdown menu.
2. Click the 'Review Blockers' link under the 'Reports' sub-tab. The 'Review Blockers' report will be
displayed.
® Click a user's name to go to their ‘Activity' screen.
® Click a number in the 'To Complete' or "'To Summarize' column to go to the list of reviews waiting
to be completed/summarised by the user.

Screenshot: '‘Review Blockers' Report
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Reports

Heviews Reports

JIRABlockers  Review Blockers

Review Blockers Report

User To Complete To Summarize
Matthew Watson 16
Anna Buttfield 4
Craig Sharkie
Felix Schmitz

Tim Pettersen
Michael Studman

b L O = [

8
4
2
4
Giancarlo Lionetti 3
Joe Xje™ G
4
4
2
2
1
3

Andraw Lui

Conor MacHeill
Brendan Humphreys
Don Brown

[ S

Edwin Wang

Geoff Crain

Rosie Jameson -
Andrew Myers -
Edwin Dawson -
Jake Causby 1
Marek Went 1
Matt Cuail 2
Fierre-Etienne Poirot -

P T TR i R % B W |

Ross Rowe -
Seb Ruiz 2 -
Slawek Ginter 1 1

Viewing the 'JIRA Blockers' report

The 'JIRA Blockers' report shows you a list of users whose action is required on open reviews, for a particular
set of JIRA issues. The reviews must be explicitly linked to a JIRA issue or mention a JIRA issue key in the
summary or the objectives.

To view the 'JIRA Blockers' report:

1. Click the dropdown arrow next to the 'Reviews' tab at the top of the page and select 'Reports' from the
dropdown menu.
2. Click the 'JIRA Blockers' link under the 'Reports’ sub-tab.
3. Enter the details of your JIRA server and project, and click the 'Go’ button. The 'JIRA Blockers' report will
be displayed with the following information:
® Alist of JIRA issues for which one or more Crucible reviewers has not completed their review.
® A list of users who have an incomplete Crucible review that relates to a JIRA issue.
® Alist of open JIRA issues for which a Crucible review is closed, and vice versa.
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Screenshot: 'JIRA Blockers' Report

Reports

Reviews Repaorts

JIRA Blockers  Review Blockers
JIRA Blockers Report

Selectthe JIRA instance to retrieve datafrom  jac =

JIRA project key FE
The key for the project you want to find review-blodeed JIRA issues from.
JIRA projects version 240

The version for your selected project that you wish to find issues from.

JIRA "Under Review™ workflow step: Under Review
The name of the workflow step from your JIRA instance that indicates an issue is under review.

Issue Review Incomplete Reviewer Incomplete reviews
FE-1073 CR-FE-3635 Conor MacMeill Conor MacMeill 2
FE-2656 CR-FE-3644 Conor MacMeill Joe Xie™ 1
Tim Pettersen Michael Heemskerk 1
FE-2665 CR-FE-3839 qu Hie Tim Pettersen 1
Michael
Heemskerk Tom Davies 1
Tom Davies
Issue Severity Problem ?
FE-2656 m Issue resolved, reviews are
still open
FE-2751 i Issue unresolved, reviews are
closed
FE-2751 T Issue unresolved, reviews are
completed by all reviewers
FE-2702 T Issue unresolved, reviews are
closed
FE-2702 T Issue unresolved, reviews are
completed by all reviewers
FE-2504 n Issue unresolved, reviews are
closed
FE-2504 i Issue unresolved, reviews are

Review Coverage Report

Crucible has useful reports that show you detailed statistics on review activity. The ‘'review coverage' report
allows you to see how much of the code in your repository has been reviewed, which files and when. You can
also access the reviews.

© This feature requires FishEye integrated with Crucible.
On this page:

Opening the Review Coverage Report

Using the Summary Panel

Using the Review Coverage Overview

Using the Individual Committer Statistics Panel
® Using the Changesets Coverage Panel

Screenshot: The Review Coverage Report
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| =

Activity  Files Users Reports Search
Charts ~ Code Metrics ~ Review Coverage

“« 19/10/2010 b Owesk ®Day

No code to be reviewed

0 reviews 0 comments 0 defects
Olines 0 commits 0 committers

O unreviewed lines 0 under review lines Oreviswed lines

0 lines unreviewed for every line in review

Individual Committer Stats
Click an entry to view changesets only by that committer.

Name Reviewed Lines

All 0% 010

Review Coverage Overview
Achangeset is only considered reviewed if all revisions are in review.

Lines Changesets Revisions
100%

7%
50%

25%

2 Loading history... 21% 0%
Nov 2009 Jan 2010 Mar 2010 May 2010 Jul 2010 Sep 2010

Changesets in FE on /
Unreviewed In Review Reviewed

Changeset Committer Files +/-Lines Date Reviews

Mo Changesets in FE on / under date range

Opening the Review Coverage Report

To open the Review Coverage Report:

1.
2. Select your repository. The repository you've chosen will set the scope for the Coverage Coverage report.
3.

4,

5. Select 'Review Coverage Report' from the list of reports in the upper panel.

Click the 'Source' tab.

If desired, navigate down the tree to the desired path you want to view coverage on.
Click the Reports tab in the secondary toolbar.

© You can view coverage of any path by navigate down the tree to the desired path you want to view coverage
on, before clicking on the 'Reports’ tab.

Using the Summary Panel

The summary panel shows some choice metrics from your Crucible instance. The following information from
your repository is arrayed:

Overall review coverage percentage.

Change in review coverage percentage since the last reporting period.
Total number of reviews.

Total number of comments.

Total number of reported defects.

Total number of Lines of Code (LOC).

Total number of commits.

Total number of committers.

Total number of unreviewed lines.

Total number of lines under review.

Total number of reviewed lines.

A ratio of the number of lines unreviewed against reviewed Lines of Code (LOC).

Screenshot: Summary Panel in the Review Coverage Report
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4 20/04/2010 b week Day [ Teday |

30% of code is reviewed
A up 24% from previous week ¥ down -T0% from next week

1 restew 18 comments 1 defect
1,547 lines T COmmits 2 commithers

1,079 unrevi ewed lings 0 under restew lings 468 reviewed lings

lines unreviewed for every line in review

Using the Review Coverage Overview

The Review Coverage Overview shows a timeline of reviews, compared against their percentage of coverage.
Hover your mouse cursor over the data points on the graph to see granular information and click through to a

detailed weekly report.

You can click the tabs to view the coverage expressed as a percentage of lines of code, changesets or

revisions.

Screenshot: Overview Panel in the Review Coverage Report

Review Coverage Overview

Lines Changesets Revisions

100%

T5%
@ 63.4% Reviewed

@ 36.6% Unreviewed

Jul 2008 Sep 2008 Mow 2009

22/11/2000 - 29/11/2009

63% Reviewed
View Report

Jan 2010 Mar 2010

Achangesetis only considered reviewed if all revisions are in review.

May 2010

Using the Individual Committer Statistics Panel

The Individual Committer Statistics window lets you choose a user from your Crucible instance and see all the

changesets by that committer.

Screenshot: Individual Committer Statistics in the Review Coverage Report
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Individual Committer Stats
Click an entry to view changesets only by that committer.

Hame Reviewed Lines
15t mwatson 100% 84/84
2nd alyons 100% B7I67
ard amyers 100% 212
dth Sruiz 97% 1,140/ 178
ath nvenegas 32% 2661326
Gth ahempel 61% 84155
Tth csharkie 91% G647 31
ath mguail 0% 0/154
oth abuttfield 79% 659333
10th crmacneill 1% 2187
11th gerain 58% 408706
12th tdavies 26% 306,182

All B 3,692/5 605

Using the Changesets Coverage Panel

The Changesets Coverage Panel lets you see changesets from your Crucible instance (for the time period of the
report), and their level of review coverage. This information can be sorted by the columns in this view and uses
colour coding to denote review coverage (listed in the table below).

Colour Key
Colour State
dark green reviewed
light green in review
red not reviewed

Screenshot: Changesets Coverage panel in the Review Coverage Report
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Changesets in FE on /trunk
Unreviewed In Review Reviewed

Changeset Committer Reviewed Files Date Reviews

54106 tdavies [N 16 +2977-308 1Feb 4’

54110 sruiz I 12 +387/-106  1Feb @ CR-FE-2071

54199 csharki... 5 +192/-161 2Feb & CR-FE-2082

54249 Sruiz I v +134/-136 2 Feh @ CR-FE-2071

54322 csharki... G +174 -G8 3Feb & CR-FE-3082

54228 nvenega.. [N © +731-82 2Feb @ CR-FE-2090

54155 mauail [ +151 /-1 1Feb

54555 abutifi... G +83/-63 5Feb @ CR-FE-2073

54390 gerain N 3 +721-73 4Feb @ CR-FE-2009

54125 abuttfi.. [ ° +7T{-62 1Feb & CR-FE-3054

54321 tdavies [N 12 +79/-59 3Feb @ CR-FE-2079

54244 cmacnei.. NG +67 [ -67 2 Feh

54307 abuttfi.. [ G +63/-71 3Feb @ CR-FE-2095

54191 gcrain I ¢ +86 /-46 2 Feh

54330 Sruiz I G +711-50 3Feb @ CR-FE-2096

54159 tdavies [N 1° +89/-25 1Feb @ CR-FE-2079 2

Changeset discussions

When using Crucible with FishEye, you can have threaded discussions with other users, on any changeset. To
start a discussion, you simply start by adding a comment to a changeset.

@ You need to be logged in to create changeset comments.

Adding comments to changesets

To add a comment to a changeset:
1. Click on a changeset on the Commits tab for the repository. Display comments by clicking Discuss at

the upper right corner, or the speech bubble icon » in the left margin.
2. Click Add a comment (under the repository details near the top left).
3. Type your comment. If required, you can tag your comment as being a defect note by clicking Defect.
4. Click Post.

Once submitted, others can respond to your comment by clicking Reply. Replies are threaded as separate
comment discussions. You can right-click on the permalink icon to copy a link to the comment. The
comment author can edit or delete their own comments.

=]

To hide the changeset comments, click the page icon . You can display the comments panel by clicking the

speech bubble icon Q again.
As you compose a comment, it will auto-save periodically.

Screenshot: Opening Changeset Discussions
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@+ 8  Dashboard Source Projects People Reviews tr ~ Edwin Dawson ~ & I

r—1 N
|.=.| 49555 ‘ Tom Davies

MNONE: revert to dav hitps for deployment

te-pomcfartifactld>

=distributiondanagenent>
<rapository>
<idraclassian-m2-reposicory</id>

Screenshot: Composing a Changeset Comment

® + M  Dashboard Sao
l’ FE » 49555

=]

Why are we reverting
O exactly?|

|| Defect| Post |

Turning changeset discussions on and off

You can turn off changeset discussions in the Admin area:

In the Admin area, click Repositories (under 'Repository Settings' on the left).

Find your repository and choose View from the 'cog' menu in the Actions column.
Click Other Settings in the left panel.

Under 'Changeset Discussions' clear the Allow changeset discussions checkbox.

rPowbdPE

By default, changeset discussions are on.

Notifications

® Comments show up in the activity stream,
® The author of the changeset will get email notifications when comments are added,
® Comment authors will get email notifications when someone replies to their comments.

Changing your User Profile

See Changing your User Profile in the FishEye documentation for instructions on how to change your user
profile.

Roles and Status Classifications

This page explains the roles & status classifications in Crucible.

® Roles in Crucible
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Author
Creator/Moderator
Reviewer

User

® Status Classifications in Crucible
® Draft

Under Review

Summarized

Closed

Abandoned

Roles in Crucible

Author

The page author does not exist.

Creator/Moderator

The creator is the person who creates the review. In most cases this person will also act as moderator. The mod
erator is the person responsible for creating the review, approving the review, determining when reviewing is
finished, summarising the outcomes and closing the review. By default, the moderator is the creator. See also au
thor, the person whose changes to the code are to be reviewed.

Reviewer

A reviewer is a person assigned to review the change. Reviewers can make comments and indicate when they
have completed their review. The moderator and author are implicitly considered to be participants of the review,
but are not reviewers.

User

A user is a person using Crucible.
Status Classifications in Crucible

Draft

Draft Reviews are not yet completed or released to the reviewers.

Under Review

Reviews Under Review are either waiting for attention by reviewers or waiting to be summarized.

Summarized

Summarized reviews are past the reviewing phase. The moderator can still add conclusions or comments.

Closed

Closed reviews are complete.

Abandoned

Abandoned reviews are 'in the trash'. Reviews must be Abandoned before they can be deleted.
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See also the Glossary of terms used in Crucible.

Conducting a Review

This page contains links to instructions how to create a review and manage the workflow through its various
states to completion. Click on the desired topic to see more information.

Creating a Review

Selecting the Files for the Review
Adding Reviewers

Issuing a review

Performing the review

Summarising and Closing the Review
Transitioning JIRA issues

Moving a Review to Another Project
Deleting a review

For an overview of how to apply a workflow to Crucible, see Defining your Workflow.

For an explanation of the different roles that people play in a review, see Roles and Status Classifications.

Creating a Review
This page explains how to create a Crucible review.
There are a number of ways to create a review. Choose from the list below:

Creating a Patch Review
Creating a Review within Crucible
Creating a review from FishEye
Creating a review from JIRA
Creating a Review from a URL
Creating a Snippet Review

Whichever way you choose, the overall process looks like this:

Select a Choose Add Start the
Froject Files Reviewers Review

© Note that only people with the '‘Create’ permission can create a review.

Review creation considerations

Review effectiveness

Based on our own experience of over 13000 reviews, we have found that reviews with fewer files and reviewers
are more effective. We have seen effects such as:

® Time spent reviewing decreases as the number of files increases.
® Reviewers spend less time reviewing as the number of reviewers increases.
® Reviewers find fewer defects as the number of reviewers increases.

This suggests that reviews should be created with care to get the best value from them:
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® Avoid overloading the review. Reviews should be focussed on a few necessary files.
® Avoid overcrowding. Reviewers should be selected with care, and should be guided individually on what
to look for.

Crucible performance
The performance of a Crucible instance can be seriously degraded if very large reviews are created.

To prevent a user from accidentally causing this, Crucible has a limit on the review content size when creating
reviews. The limit is 800 file revisions.

Creating a Patch Review

This page includes instructions on uploading patch files from your repository, how to load them into Crucible to
be reviewed and use Crucible's Patch Anchoring to retrieve more lines of context from the original file.

On this page:

® Using Crucible Patch Anchoring to Automatically Add Full Context
® Creating a Patch File From Your IDE

® Creating a Patch File in IntelliJ IDEA 7.0

® Creating a Patch File in Eclipse 3.3.1.1

® Creating a Basic Patch File From The Repository Command Line
® CVS Patch Creation On The Command Line

Subversion Patch Creation Via The Command Line

Perforce Patch Creation Via The Command Line

Mercurial Patch Creation Via the Command Line

Git Patch Creation Via the Command Line

® Creating Patches That Include All Lines of Code
® Creating a Patch in CVS With All Lines of code
® Creating a Patch in Subversion With All Lines of Code
® Creating a Patch in Perforce With All Lines of Code

Crucible allows you to review a change before it has been committed. To do this, you upload a patch file to the '
Patch' tab (or paste it in as text) when creating a review. You must first generate this patch file from your
repository, using either commands built into your IDE, or via the repository command-line tools.

To create a patch in Perforce, you must ensure you have set PADIFF to point to a
GNU-compatible diff program.

By default, patch files will only show a few lines of code surrounding each change, rather than the entire file and
its changes. Crucible's patch anchoring feature overcomes this limitation.

Using Crucible Patch Anchoring to Automatically Add Full Context

Crucible's Patch Anchoring feature allows you to add a regular patch to a review (showing only a few lines of
context. Then, Crucible will automatically search for the relevant file content in the connected repositories. When
it finds the files, it will seamlessly add in more context from the file so that you can view all of the lines of code
(greatly enhancing the review process).

To use patch anchoring:

1. Create a new review. From the 'Tools' menu in Crucible, select 'Create Review'.

2. Click 'Pre-Commit - Upload a patch file to be reviewed'. The 'patch upload' dialog appears. Click 'Bro
wse', locate your file, then click '‘Upload'. Crucible will now search for matches in the files in its database.
Crucible will analyse all the paths in the patch, find the branches containing all those paths, then anchor
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the patch to the trunk or the branch with the most recent commit activity.

© Crucible makes a 'best guess' in its processing — you should check that it has anchored the patch to the
correct location in your repository.

Screenshot: Crucible Patch Anchoring

Add Content to Review TEST-56

Upload Method: @ Select file from file system (max file size: 10MB)
O Ppaste text from clipboard
Charset: US-ASCII

Existing Patch Files:

E CRUC-2777__Ul_to_anchoring_patches.pat

@ srcfjavalcom/icenqualcruciblefactionsicreate/A
sro/contentWEB-INFfjspicrucible/create/anchorP atchResp jsp
srofjavalcom/cenqualcruciblefactionsicreate/AnchorPatchAction java
sro/contentWEB-INFfjspicrucible/createlcreate_selectPatch jspf
srofjavalcom/cenqualcrucibleiview/PatchDO java
srofjavalcom/cengualcruciblefrevision/s ource/PatchSource java

24 sro/contentWEB-INF/classeshwork-crucible xml

[ Add More Content ] [ Edit Details ] [ Abandon Review ] [ Start Review ] [ Done ]

1. You can click 'Edit' to change the anchoring, by choosing a new match or removing the anchor. You can

change the anchoring later, after the review is live.
2. Start the review. When viewing the diffs, you will be able to choose more than three lines of context from

the 'View' menu.

Screenshot: Editing Patch Anchoring Settings
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Author & Moderator Reviewers
L 3 —
[ [#] (@ v  Prefsv % Filter ¥ 2m
Details
Participant Role Time Spent Comments
z Edwin Dawson Author & Moderator 2m
. Geoff Crain Reviewer - 0% complete
Total 2m 0
Files: 7
Fatches:
CRUC-2777 Ul to anchoring patches.patch: (anchored fo| FE
|trunk h |,I Cancel | Remove Anchar
Objectives Eoit
Flease ensure you add an acceptance test to your review comments

Screenshot: Viewing more than three lines with Patch Anchoring

@ [l B + Prefs~ Y7 Filter (& 8n

|£| Jerc/content/ .../ /classes/xwork-crucible.xml Changed
49400 working copy read
Mo Context
151 151 2 Lines
152 152 <action name="edit-patch' class="col 20 Lines te.A
153 153 <interceptor-ref name="filellpls
154 154 <param name="n:axin:1.u|:Size ~ 100 Lines
155 155 </interceptor-ref> Full Context
156 15& <interceptor-ref name="noValida
157 157 <result name="success' type="di Show All Whitespace e/cr|
158 158 <result name="successBedirect' p 1/ed
* i i i ihi
159 159 </result> " Hide Insignificant Whitespace
160 1&0 <result name="errcr' type="disp Hide All Whitespace Ccrea
161 1&1 <result name="AccessError' type: cikbl
O </actlon> + Ignore Blank Lines
av - el 9 =11 — 1 =T
- 1la4d <action name="anchor-patch' class .  Unified Diff leate
165 <result name="success' type="di e/ cr|
166 <result name="error' type="disp Side by Side Diff Crea
1&7 <faction> e
168
A 164 1&9 <action name="edit-upload' class="com.cengua.crucible.actions.create.
165 170 <interceptor-ref name="filelpload'>
166 171 <param name="maximum3ize'>10455760</param>

Creating a Patch File From Your IDE

Creating a Patch File in IntelliJ IDEA 7.0
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To create a Patch File under IntelliJ IDEA, do the following:

'> 'Create Patch'. The following window appears:

Select a parent folder, sub-folder or file that you have altered in the Project tool window. Select 'Version Control
Screenshot: The IDEA Create Patch window
Create Patch

SR RCYE Y - |

E % Zhange list:
Changed Files Summary
= W 55 FishEyve (2 files) Files  sShown  Incloded
él— [ =7 Cihal_EdiSYM checkouts)fisheyeliter ation2isro\contentWEB-INF (2 files )
[ 7 classes (1 fil=)
[¥] = jspladmin (1 Fil=) -
Deleted: i} i}
L W (3 addadvancedinker jsp -
Takal: z z
Before Commit
[] ©ptimize imparts
[] Reformat code
Comrnent
FE-176: Fdasd kahsdk kahdk asdk hasdkh

[#] Perform code analysis for affecked Ffiles

[ Create Patch, .. ] | Cancel
If You Do Not Have the Create Patch Command Available Under IDEA

Click 'Create Patch'. Choose a location to save the patch file and click 'Ok'.

use the following steps to create a patch file in IDEA:

If you have not configured version control in IDEA, you may not have the 'Create Patch' option available. If so,
choose 'Local History' > 'Show History'.

1. Select a parent folder, sub-folder or file that you have altered in the Project tool window, right-click it and
Screenshot: The IDEA Show History dialog
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C:fal_Ed/SYHN checkouts/fisheyefiteration2fsrc/co. .. E'

Maodified Added I Deleted

= ﬁ Rewvert
28818 - B
Dake Rewy
4/03(08 15:36 Praject ap 42} show Changes Ori -

15/01/03 09:00 m (2) Help b

2. In the Local History view, right-click the revision number, and choose 'Create Patch'.

Screenshot: The IDEA Create Patch dialog

o=t W WG EHR 251 Bl S checkoutsifisheyeliter ation2Ylocal_history. patch

Create Patch [z|
(-]

[]Reverse patch

[ 8] 4 II Cancel ]

3. In the Create Patch dialog, choose a location for the patch file and a file name, then click 'OK".

Creating a Patch File in Eclipse 3.3.1.1

To create a patch file under Eclipse, do the following:

Find the parent folder, sub-folder or file that you have altered, right-click it and choose 'Team' > 'Create Patch'.

Screenshot: Instigating a Patch in Eclipse
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& Java - Animal Guessing Game/guessing_game. html - Eclipse Platform

In the Create Patch window, choose a location on your computer and type an appropriate file name (the file

format is plain text).

Screenshot: The Eclipse Create Patch dialog

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.

File Edit Source Refactor Mawvigate Search Project Run Window  Help
5~ E -0 EHEE @O i
ED Synchronize with Repository
£:5 Package Explar &3 'Eg Hierarchy = O m HelloitorldEUTL java A Commit...
@ BS & Y| shuml> i Update
=Tz Animal Guessing Garne [myproject ftrunk] cheadr<titlexl b ake Patch. ..
‘:ﬁ <HBCRTPT lanmua aonly Patch
- T L4 PRty FaLch. ..
[} README.T; _ _
=7 Hello world G, Open F3 &= Show in Resource History
Open With v | 5%, Show Annotation
Show In Alk+3Shifk 4+ L4 G} Show Properties
=] Copy Chrl+C @' Set Property. ..
add Kewvwords. .
=1
[[£ Paste Chrl+y
¥ Delete Delete
i Lock
Build Path ¥ T BranchiTag. ..
Refactor Alt+Shift+T k| EBL Swikch,..,
gl
£ Import... ¥ Merge
A Show Local Hiskory
£ Expart...
=y Copy...
.;;éh Refrash F5
) ) Efil Export...
Assign Working Sets. .,
Walidate
RUM As p| 5 Rewert..,
Debug As L4
Team r
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& Create Patch |Z|@@
e

Run and save S¥YN diff results in a file
The resulks of the SYM diff command can be used as an input file For the Apply Patch wizard, ==
+
W=
{)5ave To Clipboard
(%) Save In File System

| cilal_edipatchl23.bxt | [ Browse. .,

() Save In Workspace

Select a folder then type in the file name:

=
-

File name:

7 Mext = ] [ Finish l [ Cancel

Creating a Basic Patch File From The Repository Command Line

CVS Patch Creation On The Command Line

To create a patch in CVS, use the cvs di ff - Nu command from your workspace. For example:

..............................................................................................................................................................................

cvs diff -Nu > patch. txt

Note that patch files created with this command will only include around three lines of code, before and after
each change. It will include revision information by default, so if you have FishEye, you may be able to anchor
the patch to get full context.

Subversion Patch Creation Via The Command Line

To create a patch in Subversion, use the svn di ff command from your workspace. For example:

..............................................................................................................................................................................

svn di ff does not print any information about files copied in the workspace.

Note that patch files created with this command will only include around three lines of code, before and after
each change. It will include revision information by default, so if you have FishEye, you may be able to anchor
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the patch to get full context.

Perforce Patch Creation Via The Command Line

Use p4 di ff -dcu to generate a patch for changed files. For example:

p4 diff -dcu > patch.txt

The "-dcu" option provides a combination of "context format" and "unified format". It provides the diff in a
standard unified diff format (which we need to parse the diff) as well as revision information (which we need to
anchor to FishEye).

Since Perforce diffs do not include added and deleted files so you should then do a p4 opened to find such
files. For added files, in UNIX you can append them individually to the patch using GNU diff:

diff -u /dev/null path_to_added file >> patch.txt

In the example above, replace pat h_t o_added_fi | e with the actual path of your added file. You can follow a
similar procedure with deleted files using p4 pri nt to extract the previous version of the file.

Note that patch files created with this command will only include around three lines of code, before and after
each change. It will include revision information by default, so if you have FishEye, you may be able to anchor
the patch to get full context.

Mercurial Patch Creation Viathe Command Line

Use hg di ff to generate a patch for changed files. For example:

hg diff > patch.txt

This will include 3 lines of context. It will also include revision information, so if you have FishEye, you may be
able to anchor the patch to get full context.

Note: if you use git style diffs (--git), the revision information will not be provided. This means that we cannot
anchor the patch to a FishEye repository.

Git Patch Creation Via the Command Line

Use git diff to generate a patch for changed files. For example:

git diff > patch.txt
This will include 3 lines of context. It will also include revision information, so if you have FishEye, you may be
able to anchor the patch to get full context.

Creating Patches That Include All Lines of Code

To create a patch file that shows all lines of code as well as the changes, use the following commands from your
repository command-line tools.
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Creating a Patch in CVS With All Lines of code

To create a CVS patch that shows all code (not just the changes and surrounding code), use this command:

..............................................................................................................................................................................

cvs diff -N -U 10000 > patch. txt

© The '10000' number refers to the number of code lines included in the patch, before and after each change.
Patch.txt' represents your desired name for the new patch file.

Creating a Patch in Subversion With All Lines of Code

To create a patch in Subversion that shows all code (hot just the changes and surrounding code), use this
command:

..............................................................................................................................................................................

svn diff --diff-cmd diff -x "-U 10000" > patch. txt

® The in-built diff feature in svn di f f does not support specifying lines of context, so you must tell
Subversion to use an external diff command.

® The second "diff" in the command above needs to be the name of your external diff command. You might
need to specify the full path to that command, such as / usr/ bi n/ di ff.

® On the Windows platform, you may need a Unix-like emulator such as Cygwin, and install the optional diff
command for that.

Creating a Patch in Perforce With All Lines of Code

Unfortunately, Perforce does not directly support creating patches that include all lines of code. A
workaround is to checkout 'before' and 'after' versions of the file, and use GNU Diff to create a patch between
the two files. That file could then be loaded into a Crucible review.

Creating a Review within Crucible

Choose Add Start the
Files Reviewers Review

This page explains how to create a review from the Crucible interface.

On this page:

Create a new review

Choose where your review files will come from

Add content to the review

Edit the review details

Adding an entire directory's contents to a Crucible review

Create a new review

Within Crucible, create a review by opening the Tools menu at the top right of the Reviews screen, then clicking
Create Review. You will be prompted to select the Project for the review (if you have multiple projects). Choose
a project and click 'Create Review'.
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Screenshot: The create review dialog

Select Project for New Review

Select Project

 Testing Project ‘v

Create Review ] [ Cancel

Choose where your review files will come from

The 'Add Content to Review' screen appears, where you will now be prompted to choose where your review
files will come from. Choose one of the options by clicking. See Selecting the Files for the Review for details.

Screenshot: The content menu for Crucible reviews

Add Content to Review TEST-53

F—7 Browse Changesets
L=Jd Browse recent changes for revisions to add to this review

P Explore Repositories

Use a directary tree ta find files

Search for Files
Use Crucible's search to find rewvisions to add to this review

1 Pre-commit
{4 Upload a patch file to be reviewed - diffs of files will be extracted

Antachments
Upload a file to be reviewed

Add content to the review

Once you select where your review files are coming from, you are prompted to select the files to be reviewed.
Check the boxes next to any files you want to add.

Screenshot: Adding content to your review
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Add Content to Review TEST-53

Repository CLOV
Author w
Branch W T8}
Add io Review as 11 w|| R all 1 FE
Filexs in CLOWS
= branches/ v & MNAME
o ol

] CloverCompilerfdapter.java

= sroy

comy

¥ orgd apache/tools ant/ task

Qroovyy
dea7/

D/
perfmon

plugin-corey

ccala)
scala 3

[ Add Mar

e Content

REV

46083 by mstudman ¥

gt Detads | [ Abandon Review | [ Start Review |

Edit the review details

Once you have selected the files, click Done to go to the Edit Review Details screen, as shown below.

Screenshot: Editing review details

Edit Review Details TEST-54

Project Testng Projed

Tite: Quick Review for Compliance

¢ Edwin Dawson Moderator Edwin Dawson
Revewe " Allow anyone
B ceonc
_:.’_l’_:'_..-:_'» A spot check for compliance purposaes.

Add Content

) Stan Review

On the Edit Review Details screen, you can choose a title, reviewers, objectives, due date, linked reviews and

issues. Once you're finished, click 'Done'.

Screenshot: Editing review details
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1™ ing Project * TE = . 4
/7 Testing Project * TEST.54 ,_/; Edit Details @ Stant Review 88 Tools
K‘ "/ Quick Review for Compliance
Diraft for a few minutes Author & Moderator  Reviewers
TEST-54 FHE| O BE EB - pes- ¥ Fier &
™ This review is in edit mode Details

Afiles alre i
to rem Sl Participant Raole Time Spent Comments Latest Comment
# Click the ‘Add Revisions” menu item in a file’s
Edwin Daws: " Uadarato i
toalbar fo add newer {or older) revisions x Edwin Daws Author & Modcerator im
Details . el Crain Reviewer - 0% completa
Tstal im L]
B trunk
2] build.xmil x
>atches
Objectives o
A Spol check for Compliance: pUrpoSes
Please ensure you add an acceptance test to your review comments

General Comments

There are no general comments on this review. Add 3 general comment

The review will open in a preview form. Here, you can check all the details and click to edit any that aren't
correct. Once you click Start Review, the review is live.
Adding an entire directory's contents to a Crucible review

To add an entire directory's contents to a Crucible review, you will need to search to find all the files. For
example, using "select revisions from dir /some/dir where is head", or similar logic.

© 1tis currently not possible in Crucible to add all the contents of a directory to a review with one click.

Creating a review from FishEye

Choose Add Start the
nie d> Files ﬁ> Reviewers ﬁ> Review

This page explains how to create a Crucible review from FishEye.

On this page:

1. Open the FishEye Source view
2. Start the review
3. Choose a project

1. Open the FishEye Source view

To begin, the code author sets up the review. There are other ways to do this, but for this example, the author
starts from the FishEye Source view of the file he or she wants to have reviewed.

To navigate to the Source view for a file:

1. On the Source tab, click the name for a repository.
2. Click the name of the file to be reviewed.
3. Click the Source sub-tab.
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2. Start the review

To start the review:

®* From the FishEye Source view, choose Reviews > Create Review.

Screenshot: Opening a review from the FishEye Source view
FE ! trunk
build.xml

Activity Revisions Users Reports Source

[« 107905 ~ 107905 - Changeset Raw  Annotation Highlighting~  Columns =/ DR TR

Tom Davies <project name="fisheye" defanlt="code’

Create Review

Matt Quail 2
t' Conor MacHeill <!-— See https://extrancst.atlassian.chm/displav/BFECAL
Seb Ruiz 4 <property name="bunild.release.num" value="2.4.0-M5"/:

Conor MacNeill
[E] Matt Quail
Conor MacNeill
Matt Quail
Matt Quail

6 <property name="jvm.level" value="1.5"/>
<property name="=zource.level" value="1.5"/>
B <property name="compile.booteclasspath" loecation="1liky

3. Choose a project

In the Edit Review Details dialog, choose the project for this review, and add reviewers. Now click Start Review.

Edit Review Details TB-2

thﬂ1ﬁ§ -

L1} Toolbox

______

Title:

Creating areview from JIRA

Choose Add Start the
: d> Files ¢ Reviewers @ Review

This page describes how to create a Crucible review directly from an issue in JIRA, the Atlassian issue-tracking
application.

JIRA must be integrated with Crucible before you can do this. See JIRA integration in Crucible for information on
how to set this up.

To create areview from within JIRA:

1. Goto the issue in JIRA that relates to the work to be reviewed.
2. Under 'Activity', click the Source tab.
3. Either:
a. Click the '+'icon to the right of a changeset to create a new review for that changeset.
b. Click Create crucible review to create a review for all the changesets in the list.
4. If a similar review already exists, you can add the changesets to that; otherwise click Create New Review

5. In edit mode for a review:
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The content of the changeset becomes the content (i.e. files) to be reviewed.

The author of the changeset becomes the author of the review, if Crucible is aware of this user.
Otherwise the creator of the review becomes the author.

The creator of the review becomes the moderator.

® The commit log message is used as both the Title and Statement of Objective.

6. Choose Tools > Start Review when you are ready.

The next step is to add reviewers.

Screenshot: Adding a review from within JIRA

Activity

Al Comments Log History Activity Commits | Source | Reviews Builds

Create crucible review for all 2 changesets in | FlshEEe | C!

Nick Pellow <npellow@atlassian.com> submitted changeset 0fb2b03335f92dc3c2edcb7d98bEbfeat5132386 to default in FE-hg (1 file) - 14/0ct/10 o
12:29 AM
@ CR-FE-4309 @ CR-FE-6716

CR-FE-4266: review rework.

@ srcfjavalicomicenguafisheye/utlThrottlejava (+1-1) AB O 4
npellow <npellow@atlassian.com> submitted changeset 9b9d264f4e1f6eb44f193fbcE36fa7b2f56bad 73 to 2.8 in FE-hg (1 file) - 04/Sep/12 8:55 PM o
@ CR-FE-6717 @ CR-FE-6733

FE-4266: using a HashSet over a TreeSet like other BatchCreators do since Motification does not implement Comparable.

[ sroifjavafcom/cengualcrucible/notification/batchicreators/PluginBatchCreatorjava (+2-2) A B ® &4

Screenshot: Review edit mode in Crucible

FishEye , CR-FE-6741 ¢ EditDetails [ Share (@ Join Review s} Tools ~

CR-FE-4266: review rework

Draft for a few seconds (due in 1 day) Author
CR-FE-6741 = @] ~  Prefs + 7 Fiter
~ This review !s in edit modfz ) Details
Here you can edit files already in your review
+ Click the red 'x's to remove files and Participant Role Time Spent Comments Latest Comment

revisions X
« Click the 'Add Revisions' menu item in a file's H Nick Pellow Author
toolbar to add newer (or older) revisions.
¢ ) Total om o
Details
Objectives Files: 1

General Comments
Objectives Lo

[E= sreijavaicomicenqualfisheye/util 0fb2b0333592dc3cedch7doBbEDI 132386: CR-FE-4266: review rewark
[] Throttie java x
Commits
Commit  Author Date Comment
0fb2b03 Nick Pellow <npellow @ atlassian.com= Thu Oct 14 00:29:56 CDT 2010 CR-FE-4266: review rework

. General Comments

There are no general comments on this review. Add a general comment.

Creating a Review from a URL

Choose Add tart the
H N u— q>. s~

You can set up a URL which you can then click to create a Crucible review.
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The format of your URL is as follows:

http://1 ocal host: 8060/ cru/ creat e?csi d=9%2F%R2F& epo=a¥®?F1234&csi d=%2F%2Fr epob%2F758

3

The parameters are as follows:

Parameter Description

csid The changeset ID. You can
specify one or more, of the form
/lrepol/csid (where '%2F' is the
URL-encoded form of is /')

repo The name of your repository.

title The title of your new Crucible
review.

description The description of your new

Crucible review.

Required?

Yes

Yes (unless supplied in the csid)

No

No

When you click the URL, you will be prompted to select the relevant projects if more than one project exists) in
which to create your review. A new draft review will then be created, including the following information:

® The content of the changeset becomes the content (i.e. files) to be reviewed.
® The author of the changeset becomes the author of the review, if Crucible is aware of this user. Otherwise

the creator of the review becomes the author.
® The creator of the review becomes the moderator.

® The commit log message is used as both the Title (unless you have explicitly defined a title in your URL)

and Statement of Objective.

All aspects of the review can be changed. To edit any of the above settings, click the title to see the 'Edit details

' screen. Or you can click the Manage Files tab.

The next step is to add reviewers.

Creating a Snippet Review

This page explains how to create a simple code review using the Crucible Snippet Review feature. Snippet

Reviews are designed to be lightweight ad-hoc code reviews.

To create a snippet review:

1. Copy the code to be reviewed from the source to your system clipboard.

2. Click Create Snippet in the Crucible toolbar.
3. Enter details for the snippet review:
® Paste the code into the panel, where indicated.

® Click on Click to add title near the top to enter a title for your review. If you don't specify a title,

one will be automatically created for you.
® Select a project from Project.

® Select a programming language from Syntax Highlighting.

4. Click Save to create the snippet review.
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5. Invite anyone that you want to participate in the snippet review by sending them the link to the review.
The link is the review key, just above the review title. Anyone who is allowed to view the snippet is
allowed to comment on it, and can close it.

6. Click Reply on any comments to respond.

7. Choose fro the Tools menu to either close or delete the snippet review. Anyone can re-open, re-review or
close snippet reviews. However, only the creator of a snippet review can delete it.

Screenshots: Creating a Snippet Review (click to view larger images)

tappans - Crews SYppa

g ke i - iy

* +! Biink Java Example Review '
W A L 11 Gagtem i1 2411 L 1 11 a5

| Frmn -  ega Tostbeg Pt

i i
Uk

Step 1 Step 2

Selecting the Files for the Review

Select a Add Start the
Project Reviewers Review

This page explains how to select files/changesets that will be included in a Crucible review.
On this page:

Selecting Changesets for Review

Selecting Files for Review by Exploring Repositories

Selecting Files for Review using the Crucible Search

Using the Suggestions Feature When Adding Files to a Review
Adding Pre-commit Patch Files to a Review

Adding Attachments to a Review

To add content to areview:

1. Log in to FishEye/Crucible and either;
® Create a review, as described on Creating a Review, or

® Open an existing review, which you are the creator or moderator of, and click the Add Content ()

button.
2. The 'Add Content to Review' dialogue will be displayed (see screenshot below). Select the method you
want to use, to find the content for your review:

®* 'Browse Changesets' — Allows you to choose changesets from a Source Code Management
(SCM) repository to add to a review. See Selecting Changesets for Review.

®* 'Explore Repositories' — Allows you to browse for files from a Source Code Management (SCM)
repository to add to a review. This option only appears when FishEye is installed. See Selecting
Files for Review using by Exploring Repositories.

® 'Search for Files' — Allows you to search a Source Code Management (SCM) repository for files
or changesets to add to a review. This option only appears when FishEye is installed. See Selectin
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g Files for Review using the Crucible Search.
® 'Suggest Files' — Analyses the list of files in the current review and makes suggestions based on
certain logic (for example, suggesting a newer version of a file if one exists). This option only
appears when FishEye is installed. See Using the Suggestions Feature When Adding Files to a
Review.
® 'Pre-commit' — Allows you to upload patch files to a review. See Adding Pre-commit Patch Files
to a Review.
® 'Attachments' — Allows you to upload any file to a review, including binary files and files outside
of a Source Code Management (SCM) repository. See Adding Attachments to a Review.
3. Follow the appropriate instructions in the sections below to add content to your review.
4. Click the 'Done' button to finish adding content to the review.

Screenshot: The Add Content menu for Crucible reviews

Add Content to Review TEST-53

F_T Browse Changessts
L—J Browse recent changes for revisions to add to this review

r’L Explore Repositories
Use a directory tree to iind files

sarch 1o find revisions to add to this revew

Search
Use Cru

i 1 Precommit
1,4 Upload a patch file to be reviewed - diffs of files will be extracted

Amtachments
Upload a file to be reviewed

Selecting Changesets for Review
Click the 'Browse Changesets' option on the 'Add Content' dialogue to add changesets to your review.

Screenshot: The Browse Changesets View in the Add Content dialogue
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Add Content to Review CR-FE-2977

Repository: FE - Author: Geoff Crain -

Branch: - Tag:

Add to Review as: | Diffs 7?_' Remove all revisions from review

& Earlier Changesets Go to changeset: Later Changesets B

Changes in FE/
(] 106744 committed by Geoft Crain 05:33
CRUC-4052: merge r 106740 from trunk

changed 82 files

® 106742 committed by Geoff Crain 05:22

CRUC-4006: remove console.log

106740 committed by Geoff Crain 05:02

CRUC-4052: add a faster selector for creating an inline comment

modified review-event.is

/ Add More Content \ / Edit Details ) / Abandon Review \ (Start Review \ / Done \

By default, Crucible presents a list of the author's changesets in reverse chronological order. You can see other
changesets by changing the options at the top of the screen.

Click the checkbox next to a changeset ID to add the entire changeset. Note,

® You cannot add individual file revisions to a review, although you can remove them once the changeset is
added. Click 'Remove all revisions from review' to remove all.

® You cannot add changesets that are entirely svnprops changes (i.e. it has no non-metadata changes).
For details, see How do | force reviews to include SVN property changes?.

Options for adding changesets:

® 'Repository' — This is a list of the repositories that contain the files that can be reviewed. If the repository
you require is not in the list then it has not been added to FishEye. Please contact your Crucible/FishEye
administrator.

® 'Author' — This contains a list of all the authors who have made changes within the repository. When
creating a review, this will default if possible to the username of the user authoring this review and will
therefore show their changesets.

® 'Branch'— This will only show files and recent changes on that branch from the repository set above.

® 'Tag' — This will only show files and recent changes tagged.

® 'Add to Review As' — Choose the form of the review. See Choosing the way files are added to the
review below.

® 'Go to Changeset' — Allows you to jump to a particular change set by entering its title and pressing
Enter.

Choosing the way files are added to the review:

When adding files to a review, you can set the form of review taking place in the 'Add to Review as' drop-down
menu:
* ‘Whole Files' — Adds the entire file with all content, rather than just a diff with context.
* 'Diffs' — This is the default behaviour. This allows you to add multiple revisions of a file to one review and
compare them in-review, in context with the change history.
® 'Diffs to Last Reviewed Version' — This adds files with a diff to the last reviewed changeset.
® 'Diffs to... (a particular revision)' — This allows you to specify the file to show the differences between
two specific versions of a file.
® 'Diffs to Last Branch Point' — This adds files with a diff to the revision each file was last branched.
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Click the 'Done' button once you have finished selecting the desired files. The files will be added to your review
and your review will be displayed.

Selecting Files for Review by Exploring Repositories

Click the 'Explore Repositories' option on the 'Add Content' dialogue to browse repositories for files to add to
your review.

Screenshot: Browsing for files to add to a review

Add Content to Review TEST-99
Repositary: Antlr -
Addto Review as: | Diffs E Remave all revisions from review
Files in Antlr/
= antlr-ant/ NAME REV
= main/ & antibmi 5779 [
[ antlr3-task/ -
5 antir3-sre/ C  ANTLR3.java 5779 =]
= org/
= apache/
[E= tools/
E ant/
E= antlr/
[3 antlr3-maven-archetype/
3 antlr3-maven-plugin/
3 gunit-maven-plugin/
I gunit/
[ runtime/
3 tool/
| Add More Content | [ Edit Details | [ Abandon Review | [ StartReview | [ Dene

® To find a file, browse the folders by clicking the relevant folder. The folders by default are sorted by path
name but can sorted by last-commit or first-commit.

® To choose a file for reviewing, click the checkbox to the left of the flename and if required the revision
number.

® To select a particular revision of a file, open the revision number list and select the option "Load Full
History...". This will refresh the available options in the list.

© Please note the following information when browsing files to add to a review:

* Empty folders will be greyed out.

® If the folders contain empty folders then a toggle option called 'Hide Empty" will
appear under the 'Sort' options.

® To see orignore deleted files, you can click the 'Hide' and 'Show' options located
above the file names on the left.

Choosing the way files are added to the review:

When adding files to a review, you can set the form of review taking place in the 'Add to Review as' drop-down
menu:
* 'Whole Files' — Adds the entire file with all content, rather than just a diff with context.
® 'Diffs' — This is the default behaviour. This allows you to add multiple revisions of a file to one review and
compare them in-review, in context with the change history.
® 'Diffs to Last Reviewed Version' — This adds files with a diff to the last reviewed changeset.
® 'Diffs to... (a particular revision)' — This allows you to specify the file to show the differences between
two specific versions of a file.
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® 'Diffs to Last Branch Point' — This adds files with a diff to the revision each file was last branched.

Click the 'Done' button once you have finished selecting the desired files. The files will be added to your review

and your review will be displayed.

Selecting Files for Review using the Crucible Search

Click the 'Search for Files' option on the 'Add Content' dialogue to use the Crucible search to find files to add

to your review.
The 'Search'’ view is only available when using FishEye with Crucible.

Screenshot: Searching for files to add to a review

Add Content to Review CR-CLOV-187

Repository. CLoV -

Addto Review as:  Diffs E Remove all revisions from review

Search in CLOV/

Search Results
(Swiitch to Advanced Search)
Add revisions on this page | Add all 33902 revisions

Search Criteria

Search all directories
Y| Only most recent versions
Comment: clover 7921 by no_author (7 years and 11 months ago) | show diffs

Contents: This commit was manufactured by cvs2svn to create branch 'clover'.

Added _ _
text: [l branches/clover 7921 @& & (+0) new
text:
File [ branches/clover/src/main/com/cenqua/clover/reporters/jffc 7921 @& & (+0) new

name;

(Use Ant-globs ) ) branches/clover/src/main/com/cenqua/clover/reporters 7921 & % (+0) new

Search

Author, Tags, Branch, Date, and more [ Ak ]

[l branches/clover/src/main/com/cenqua/clover 7921 & & (+0) new

[_! branches/clover/src/main/com/cenqua 7921 & & (+0) mew

Author(s): andrea

Andrew Prentice (aprentice)
Brendan Humphreys (bhumphreys)
Brendan Humphreys (brendan) =
Branch: [_! branches/cloverfsrc 7921 @ & (+0) new

O branches/clover/src/main/com 7921 & & (+0) new

i »

[l branches/clover/src/main 7921 & & (+0) new

Tag: [l branches/clover/src/util/cloverutil/users/LicenseGen.java 7921 & & (+165) new
After:
Before:

(YYY¥-MM-DD ? )

T

| branches/clover/src/util/cloverutilfusers 7921 & & (+0) new

! branches/clover/src/util/cloverutil 7921 @& % (+0) new

Deleted [l branches/clover/src/main/com/cenqua/clover/reporters/jfc/jfc_res 7921 @ % (+0) new

[ Add klore Content ] | Edit Details | | Abandon Review ‘ | Send to Moderator |

m

Done

If you are not certain about which changesets/revisions/files to include in a review, use the Search view to find
them. Adjust the search filters to find the files you need. If the simple filters are not enough, read about EyeQL

queries in the FishEye documentation.

Read the FishEye documentation for more information about the searching your repositories.

Choosing the way files are added to the review:

When adding files to a review, you can set the form of review taking place in the 'Add to Review as' drop-down

menu:

* 'Whole Files' — Adds the entire file with all content, rather than just a diff with context.
® 'Diffs' — This is the default behaviour. This allows you to add multiple revisions of a file to one review and

compare them in-review, in context with the change history.

® 'Diffs to Last Reviewed Version' — This adds files with a diff to the last reviewed changeset.
® 'Diffs to... (a particular revision)' — This allows you to specify the file to show the differences between

two specific versions of a file.

® 'Diffs to Last Branch Point' — This adds files with a diff to the revision each file was last branched.

Click the 'Done' button once you have finished selecting the desired files. The files will be added to your review

and your review will be displayed.
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Using the Suggestions Feature When Adding Files to a Review

Click the 'Suggest Files' option on the 'Add Content' dialogue to view and add files suggested by Crucible to
your review. You need to have already added some file(s) to review for Crucible to suggest additional files.

Images: Viewing and adding file suggestions to a review

Add Content to Review TEST-99

Addto Review as:  Diffs |z| Remove all revisions from review

ions in all repositories.

Changesets containing similar files

B 35536 cestea by studman oa 12 May 2009, 15.47.15 0500 (3 days sgo}
CLOV-378: Making back refs fransient in lower-level model objects and pushing datal.ength field to Methodl
-8% db file size, +5 Stre...

2 Mrunidcorelsrcicom/cenqualclover/registry/Branchinfo java 35536 ® & (+10 -3) diffs

Mrunk/core/sicicomicenqualclover/registry/Methodinfo java 35536 & # (428 -2) diffs

® Rrunkicorelsreic omicenqua/clover/registry/Statementinfo.java 35536 & @ (+10 -2) diffs

] Nrunkicore/src/icom/cenquaiclover/registry/Elementinfo java 35536 & & (+0 -9) diffs

® Arunidicorelsrclc omicenqua/clover/registry/Classinfo java 35536 @ ¥ (+10 -0) diffs

[ Add More Content ] I Edit Details I Dane

Crucible can make intelligent suggestions when you are creating a review. The Suggestions feature logic is
based around the following:

® Most recent versions: If a newer version of a file exists, Crucible will suggest that you add it to the

review.
* Similar files: Files with a similar filename may be of relevance to your review; Crucible will show them to

you.
Choosing the way files are added to the review:

When adding files to a review, you can set the form of review taking place in the 'Add to Review as' drop-down

menu:
®* 'Whole Files' — Adds the entire file with all content, rather than just a diff with context.
® 'Diffs' — This is the default behaviour. This allows you to add multiple revisions of a file to one review and

compare them in-review, in context with the change history.

* 'Diffs to Last Reviewed Version' — This adds files with a diff to the last reviewed changeset.

® 'Diffs to... (a particular revision)' — This allows you to specify the file to show the differences between
two specific versions of a file.

* 'Diffs to Last Branch Point' — This adds files with a diff to the revision each file was last branched.

Click the 'Done' button once you have finished selecting the desired files. The files will be added to your review
and your review will be displayed.

Adding Pre-commit Patch Files to a Review

Click the 'Pre-commit’ option on the 'Add Content' dialogue to add pre-commit patch files to your review.

Screenshot: Adding pre-commit patch files to a review
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Add Content to Review TEST-100
Upload Method: @ Select file from file system (max file size: 10MB)
Paste text from clipboard
Charset: US-ASCII &
File: Browse:
Upload
[_Add More Content | [ EditDetais | | Done

For a full explanation of the 'Patch View' functions, read about creating a patch review.

Click the 'Done' button once you have finished selecting the desired files. The files will be added to your review
and your review will be displayed.

Adding Attachments to a Review

Click the 'Attachments' option on the 'Add Content' dialogue to add attachments to your review.

Screenshot: Adding attachments to a review

Add Content to Review CR-FE-2977

Charset: US-ASCII

File {max 10MB)

. <
|_Browse... )

Base of DIff File

I 5
[ Browse. .. |

/ Upload \
Existing Attachments:

¥ cru-changelog.png (1) gerain

You can upload additional files to be used in the review, including binary files, images or code files that are not

stored in a version control repository. The 'Upload’ view contains various controls to help you do this. These are
listed below.

Choose the 'Upload Method' as either 'Select file from the file system’ or 'Paste text from clipboard":

® Displays if 'Upload method' is 'Select file from the file system':

® 'Character Set' (if any) — Click the edit icon (£) to choose the character set being used. ' US-AS
Cll " is the default.

®* 'File' — Click 'Browse' to find the file that you want to add to the review.
® Displays if 'Upload method' is 'Paste text from clipboard':
® 'Patch text' — Paste your copied text in this text area.

Click the 'Upload' button, when you have made your selection. Once complete, a list of uploaded files is

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
http://en.wikipedia.org/wiki/ASCII
http://en.wikipedia.org/wiki/ASCII

User Guide for Crucible 2.10 96

displayed at the bottom of the screen. To add another iteration of a file, make changes to the file and upload it
again with the same filename. It will be added as a new version.

Click the 'Done' button once you have finished selecting the desired files. The files will be added to your review
and your review will be displayed.

Ilterative Reviews

Crucible allows you to review several revisions of a file within one review, seamlessly switching between them.
Comments are linked and relative to a specific revision. This allows you to review every change that has
occurred on a code file within a given period of time. This lets you see the evolution of the file through various
revisions (within one Crucible review).

Screenshot: Iterative Reviews
8o CR-BAM-383 BAM-4027 One big renaming fest, splitting LocalAwsManager into... - Under Review =
B.Ti;m“mn:w. an ) @ g W https://atlaseye-qa.atlassian.com/atlaseye/cru/CR-BAM-3B83#CFR-31925 WY

the handles h :
Pret - Filter =
f 5 [ (] misplay Preterences ~ 7 Filter

- @ ElasticFunctionalityFacadelmplTest.java vooreo & EditReview @ Complete ¢ Tools -
Revisions: 92218 x 82370 x 92643 x [ Edit Revisions )
Comments: 1 2 1

Numbers ® File View~  FishEye ~

indicate the . : .

comments that 51 35 public void testAdjustHumberOfAgentsworksForwhenAgentsArestarted() throws Exception

refer to each e LI

ision A setup
Sy 354 final HashMultimap<ElasticImageConfiguration, RemoteElasticInstance> map = _getThreeRem

354 +

final HashMultimap<ElasticImageConfiguration, RemoteElasticInstance> map = _getThreeRem:
35E 56 when{elasticInstanceManager.getAllElasticAgentsAsMap()).thenReturn(map);
final AtomicReference<Collection<ElasticimageConfiguration>> returnedreference = MocKSt.
359
360 360 A axecute
Gutter markers 361 = facade.adjustElasticAgentumbers(new ElasticInstanceScheduleImpl{"0 35 % 7 * =", elastis
show which 361 + facade.adjustElasticInstanceNumbers(new ElasticInstanceScheduleImpl(”0 35 % 7 * *", ela:
revisions this E Mark Chalmungkalanent says: 13:10

comment
refers to

Are we calling it instance not agent now?

*+  Reply Edit Delele Add Favourile

363 363 A werify
64 364 final Collection<ElasticImageConfiguration> startingUp = returnedreference.get();

370 370 publie veid testadjustlumberOfigentsWorksForwhenAgentsieedToBeStopped() threws Exceptlion
3 {

372 372 /4 setup
ara - final HashMultimap<ElasticImageConfiguration, RemoteElasticInstance> map = _getThreeRemi..
371 + final HashMultimap<ElasticImageConfiguration, RemoteElasticInstance> map = _getThrasRem
JTq4 374 ¥
e | y 210

Allassian FishEye repository viewer with Crucible code review. (Version:2.0.0 Build build-410 2009-08-239) - Administration - Page generated 2009-08-30 12:47 +1000 4

Adding Reviewers

IM ‘$I Choose ‘**IM‘

This page explains how to add reviewers to a new review, after it has been created.
See Creating a Review for information about creating reviews.

On this page:

® Entering Basic Information
® Adding Reviewers
® Adding Users to a Review

® Crucible Suggests Reviewers
® |nviting Non-Registered Users to the Review

® Checking the Draft and Starting the Review
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® Next Steps

Entering Basic Information
Once a review has been created, the Edit Review dialog opens.

Screenshot: The Edit Review dialog

Edit Review Detalls TEST-164

Projecy TEST

we: TEST: Please create multiple comments and threads on this review

Authar: Seb Ruiz Mogerator: Seb Ruiz

Raviewers: + | Suggest Revewers.. @ Allow anyone fo join

B Eeendan Humaheeys Geol Crain

BB tick Pesow § Mahew Watsan

Please onsure you add an acceplance Sest 0 yOUT review comments

Due Dale

Liniked Revien

In the Edit Review dialog, the author enters information needed for the review. This includes entering a title and
description for the review, a due date and the key for a related JIRA issue (if any). The project, moderator and
author are pre-selected (for this example, the author should select himself as a moderator.

You must also select reviewers.
Adding Reviewers

Before a review can be issued to reviewers, you must decide who can review it. When adding reviewers, you
can add registered users immediately. The usernames will auto-complete, showing partial matches before you
finish typing. You can quickly select one of the matches shown with the keyboard arrow keys, pressing Enter or
Tab to add them to the review.

In addition, you can easily invite external users who do not yet have accounts in Crucible to take part by typing
their email address into the Reviewers field.

Adding Users to a Review

Select users by typing names into the text field under Reviewers. Crucible will show a list of matches. Press
Enter to select one after each entry.

Clicking the 'Save' button will save the review as a draft for later issue.

You can also decide to allow any registered user to add themselves as a reviewer in the review. To enable this
option, put a check next to 'Allow anyone to join'.

Crucible Suggests Reviewers

Crucible will automatically suggest reviewers, by analysing the users that have contributed to the files you've
selected and also don't have a lot of open reviews. You can easily pick reviewers from the list of suggestions by
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clicking.
Inviting Non-Registered Users to the Review
You can invite users who don't have a Crucible account to join a review.

There are two prerequisites:

1. FishEye's SMTP server must be configured and capable of sending email.
2. The setting 'Built-in Public Sign-up' must be set to 'ON'. This setting can be accessed by opening the 'A
dmin Menu', then clicking 'Security' under 'Global Settings' on the left navigation bar.

To invite an external user to a review:

a. Create a new review.

b. On the 'Create New Review' screen, simply type the user's email address into the 'Reviewers'
field, then press Enter to select.

Click Save to save the draft review. The users are not sent any information at this time.

When you click 'Start Review', this is when all email invites and naotifications are sent out.

e. The external user will receive an email address from the Crucible server, containing a special URL
that they can visit.

f. When the user loads the URL they received via email, they are taken to a special Crucible log in
screen. On this screen, the user can create a new account that will be linked to the current email
address. (If they already have a Crucible account under another address, they can simply sign-in
with that username and password.)

g. When the user has successfully created a Crucible account, they will be able to access the
review(s) associated with their email address and take part.

Qo

© You can enter multiple addresses separated by commas, allowing you to paste in a list of email addresses
from your favourite email application.

When finished, the author clicks 'Save'. The review will now be created in a draft form.

Checking the Draft and Starting the Review

The draft review opens. In the draft stage, the author can check the contents of the review files to ensure they
are correct and put in any notes for reviewers as comments. During the draft phase, no notification email is sent
out to reviewers. Once the author is finished with the draft phase, he clicks 'Start Review'.

The review will now be started and notification email will go out to all participants. Crucible will now send out an
email notification to all the participants. This lets them know that the review is under way and prompts them to
take action, providing a URL for direct access to the review. (You can also subscribe to an RSS feed.)

Screenshot: A newly created Crucible review
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Next Steps

You can now begin Performing the review.
If you have a moderator controlling your review process, you can move onto Issuing a review.

Issuing a review

Select a Choose Add
Project Files Reviewers

On this page:

® Starting a review
® Editing a review once started

Starting a review
Issuing a review simply means formally starting it and inviting people to take part.
Once you have selected the reviewers, the next stage is to notify the reviewers and the author (if different to the

moderator) that they can start reviewing. The review has been in 'Draft' state until this point. Only the moderator
has the permission to start a review.

To start the review:

® |f you are the moderator of the review, click Start Review.
® If you are not the moderator of your review, click Send to Moderator. This changes the state to 'Requires

Approval' and notifies the moderator. The moderator can change any aspect of the review before starting
it.

Once the review has been started, the review state becomes 'Under Review'.
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Screenshot: Starting a Review

TEST-27 test _ _ . _
Draft Author & Moderator; Rosie Jameson f =N (B Start Review -
Draft for: 64 seconds Digplay Preferences « ?Filterv
Comments: 1
Review Objectives
Reviewers: . .

documentation testing

) Review Comments 1

QR0

© Note that only people with the 'Approve' permission can start a review.

Editing a review once started

You can quickly add files to, or remove files from, the content of a review at any time:

® Add files to a review by clicking the 'Add content' button.
®* Remove files by clicking the 'Edit' button in the left navigation panel, then clicking the red cross icons
beside files to be removed.

You can edit all the details of a review, including the content, by clicking Edit Details near the top right of the
review.

Screenshot: Launching Edit Mode

Testing Project * TEST-54
Quick Review for Compliance

Under Review for 30 hours Author & Moderator Reviewers

TEST-54 @ (€] B] ~ P

Details |E-:|it the content in this review h
Ohjectives
General Comments Participant

Edwin Dawsan

[== trunk
|£| build.xml . Geoff Crain

Screenshot: Crucible Edit Mode for Review Content
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Testing Project * TEST-54
Quick Review for Compliance

Under Review for 30 hours Auth

TEST-54 [ [#] (@

This review is in edit mode D
Here you can edit files already in your review
# Clickthe red %'s to remove files and revisions
# Clickthe "Add Revisions' menu item in a file's
toolbar to add newer (or alder) revisions

Details
Ohjectives
General Comments

[=trunk
|<_;| build.xml x

Performing the review
This page describes how to find and manage the Crucible reviews that relate to you.
On this page:

Browse your reviews on the Dashboard
Browse all reviews on the 'Reviews' tab
When files change during a review

Next steps

© Deciding what needs to be reviewed

The 'Statement of Objective' is a brief description of what the review is intended to achieve.
Crucible does not dictate how or what to review. It simply provides a mechanism to record
comments.

Browse your reviews on the Dashboard

When you first start Crucible, the Dashboard is displayed, which shows your current reviews and other activity
related to you.

Use the Dashboard to manage your reviews. Read the overview on filtering your view.

Active reviews are listed on each reviewer's dashboard under the default To Review filter. Reviews are listed
under Out for Review until all reviewers indicate they are complete. The reviews then move to the To

Summarize list.
Read more about using the Dashboard.
Browse all reviews on the 'Reviews' tab

All reviews that involve you in any role are listed when you click Inbox or Outbox under the Reviews menu. For
example, choose Reviews > Inbox to see reviews that don't require further action from you, but are still active.

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
https://confluence.atlassian.com/display/CRUCIBLE/reviewer

User Guide for Crucible 2.10

If email notifications are enabled (see SMTP settings in the FishEye documentation), reviewers will receive an

email with information about the review. Click the link within the email to go directly to the review.

When files change during a review

If a file in the repository changes during a review, Crucible will visually alert you by showing the File Outdated m

enu, when viewing the file:

r"—‘“ﬁ FishEye * CR-FE-3238
I\.._-f" CRUC-3180: Clean up User Preferences :iialog
Closed on 24 Mar Author Reviewers
Or G @ O
CRFE-1238 44 D & EHB- eese ¥R
rirmiEneG 7
f g 25934
o B | I e

Changed

3

View =

able clagd="dialog-table

From the File Outdated menu, you can choose to view the latest revision of the updated file, or add the latest

revision to the review:

Screenshot: 'File Outdated' menu

Changed| 3 View= FishEye =

42040

le class="dialog-takle" cellspacing="0">

Next steps

Adding comments

Flagging Defects

Creating JIRA issues from the review
Completing your review

Sending a review's comments via Email
Using JIRA Integration in Crucible Reviews
Using the Review History Dialog

Tracking Crucible Review Metrics

Adding comments

Comments can be added at the level of a review, revision, or line. You can also reply to a comment.

On this page:

® | ocating existing comments
® Adding comments
® Draft comments

Locating existing comments

The number beside a filename, in the left-hand panel of a review, indicates the number of comments on that file.
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(The number of unread comments, if any, is shown in brackets.)

Screenshot: Comments

Comments: 4

|_5| Branchinfo.java
[#] classinfojava

|<_5| build.xml
10
11

10
11

CR-CLOV-136 Test Review for Documentation

Under Review  Author & Moderator; Edwin Dawson & EditReview @ Summarize £ Tools ~
&
Under Review for: 45 days Display Preferences ~ 57 Filter ~
OIS BB O Elementinfo.java wooiries

Reviewers: Revisions: 32288 35536 36696 Edit Bevisions
O O

O Review Comments Comments: 4 4 1}

E= trunk [+] ) 3 () Fileview~ FishEye v File Outdated +

E= corelsrefeomicenguaiel | [©] /trunk/core/sre/com/ cenqualclover/registry/Elementlnfo.java

[2] Elementinfo.java 4 7 - |public abstract class ElementInfo extends SourceRegion impleme
I<_>'| MethodInfo.java g = private Contextiet context;
I<_§| Statementinfo.java 9 private int relatiwveDatalndex;
[ ideaTisrclcomitengual Edwin Dawson says:
[#] WeaTestFilter.java what is this relative to?
[E= sreitutarial +%  peply Edit Delste sdd Favourite

Geoff Crain says:
the speed of light

! Leave Unread

Edwin Dawson says:
&“ |5 this variable name sensihle?
*%  Reply Edit Delete Add Favourite

Geoff Crain says:

ithink o - may not be complex enough, though

|

+ o+ o+

import cow.cengua.clover.context.Contextliet;
import cow.cendgua.clover.context.NanedContext;

private int datalength = 1; ¢/ by default an element occup
private int complexity:

Leave Unread

import jawva.io.Serializable;

public ElementInfo |
BazeFileInfo containingFile, int relatiwveDataIndex, Co
SourceRegion region, imt complexity) {
super (containingFile, region):
this.relativeDatalndex = relativeDatalndex:
public abstract class ElenmentInfo<T extends SharedElementInfo
protected BaseFileInfo containingFile;
protected Contextiet context;

Adding comments

There are various types of comments that you can add in Crucible:

To comment on...

The whole review

A source file under review

Click General Comments (in the left-hand panel),
then Add a general comment (in the 'General
Comments' section).

Click on the file in the left-hand panel, then click Add
a file comment at the top of the file.
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Lines of code Click on a line of code in the displayed source file of
a review.

® You can click and drag to select multiple lines, and
click individual lines to select or deselect them. The
comment will appear in the source at the last line
selected.

® Hover over the comment to see the lines to which
the comment applies.

® To select text on the page without adding a
comment, hold down the Alt key while dragging the
cursor.

A revision or changeset See Changeset discussions.

To reply to a comment, click Reply at the bottom of the comment.

Only people with the 'Comment' permission can add comments.

© Read about flagging defects too.

Screenshot: Adding a Comment

s this variable name sensible?

L) Defeu:t[ Post ” Save as Draft ” Cancel

Draft comments

You can save your comment as a draft and then edit it later. When you complete the review, you will be
prompted to post, discard or edit any remaining draft comments.

Screenshot: Draft comments

Edwin Dawson says:
&“ I this variable name sensible?

+ ¥  Reply Edit Delete Post [BIgL

Flagging Defects
Comments in Crucible can be used to flag a defect in the code under review.

To do this, simply check Defect when adding a comment and select a category from the drop-down list.

Screenshot: Defects
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|5 this variable name sensihle?

L) Defect Minor v || Select Requires Re-Review ¥ |: Select Classification v Fost ” Cancel
" fl Geoff Crain says: Missing
—_— ' Extra (superiuous)
ithink 50 - may not be complex enough, though Ambiguous
rara Inconsistent
— Leave Linread Improvement desirable
i . : — Mot conforming to standards
7+ |].nport, java.io.derializable; Risk—pmne
13 = public ElementInto| Factually inconect
14 = BazeFileInfo containingFile, int re No_tlm_plementable context,
15 = SourceRegion region, int cowmplexity Editarial

You may want to mark comments as defects to associate defect classifications, or simply to highlight to the auth
or or moderator that the issue you raised in your comment requires attention.

© Crucible intentionally does not mandate how defects are to be used. The Crucible administrator can customis
e the defect classifications.

© You can only use the defect classifications on comments that are not a reply to an existing comment.

Creating JIRA issues from the review

From any review comment (general, file, inline) in Crucible, you can create a JIRA issue directly from the
comment. This requires that Crucible is integrated with JIRA, version 5.0 or later, and is disabled if you have an
earlier version of JIRA.

Inline issue creation allows:

® Tracking of the status of the comment
® A faster way to pull out incidental suggestions raised in reviews as JIRA issues
® A quick link back to the comment from the JIRA issue, using Remote Issue Links.

You might find this useful when:

1. Tracking the status of a review:
a. The 'Issues Raised from Comments' section in the review shows the open/closed status of related
issues.
b. Raising related issues enforces dealing with subtasks before the review can be closed.
2. Closing off a review:
a. You can create JIRA issues, unrelated to the current review, to track matters to be dealt with later.

Creating a JIRA issue

To create a JIRA issue from a review, click Create Issue in an existing comment. Note that you need the
'‘Comment’ permission in Crucible to see the Create Issue link.
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General Comments

Paul Watson says:

The title of the target page for the help link should be "Setting the REST APl token™
This is it: hitps2confluence atlassian.com/display/FISHEY E/Setting+the+REST+API+token

+¥
Beply Edit Create Issue

Lukasz Pater says:
T Done, linked hitps-fconfluence.atlassian.com/display/FISHEYE/Configuring+Commit+Hooks from the updat

Reply [ Leave Unread Create Issue

Add a general comment.

Crucible suggests a JIRA instance, project and issue type, but you can choose from the available options. You
can choose Sub-task from the JIRA Issue Type list if a JIRA issue is already linked to the review.

Crucible only displays required fields for the issue type; these can be configured in JIRA by your administrator.

Create issue

Ti
-

JIRA Project* | FishEye Crucible Development

JIRA Issue Type™ [ Bug -+

*
Summary”  The title of the target page for the he

Description |The title of the target page for the help link should be "Setting the REST API token"
This is it:
https://confluence.atlassian.com/display/FISHEYE/Setting+the+REST+AP|+token

Once the issue is created. the comment displays a link to the issue in JIRA, and in JIRA, the issue displays a link
back to the comment in Crucible. The 'Issues raised from comments' section of the review displays links to the
JIRA issues.

See Using JIRA Integration in Crucible Reviews for more information.

Completing your review

Once each reviewer has added comments to the review and has nothing further to add, the next step is for them
to complete their individual review.

To complete your individual review, go to the review and click Complete at the top of the screen, next to the Too
Is menu:

® Complete

@ Only people with the 'Complete’ permission can complete a review.
This notifies the moderator (via email if configured) that you have completed your review.

Reviewers can still continue to add comments until the moderator summarises the review. The moderator does
not have to wait for all reviewers to complete their individual reviews before summarising.
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If you have any draft comments, you will be prompted to post/discard/edit any comments before completing the
review.

Screenshot: Draft comments

Warning

You have draft comments
Draft comments that aren't posted will be deleted.
Wiew drafis

Delete drafts
Faost drafts

[ Complete Anpway ] [ Cancel

Screenshot: Review complete
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Review Complete

You have marked TEST-27 as completed.
The following reviewer is naot yet finished:

B Geoff Crain

ou can continue to add new comments and reply to comments until the moderator
(¥ Rosie Jameson ) summarizes the review.

Reviews requiring your attention:

Task Review Owner Due
Rewview CR-FE-2170 L 03 Jul
Summarize TEST-11 - =

Dazhboard ] [ Cloze ]

Sending a review's comments via Email

You can send all of the comments from a review to anyone you want via email. You may wish to do this to allow
a person outside the review to quickly scan the content of the comments, or oversee the review activity.
Alternatively, you may wish to send all participants this information to let them read the current status of the
review and its comments in full.

Before you begin:

® Users who are not logged in cannot send email, but they can view the text content of the review's
comments by clicking View Text that replaces Email Review in the Tools menu.
® Emails of reviews are only sent in plain text, not HTML. HTML emails are only available via watches.

To send all of areview's comments via email:

1. In Crucible, navigate to the review in question.
2. Choose Tools > Email Review (see Screenshot 1 below).
3. Specify the email recipients:

To You can enter multiple email addresses,
separated by commas.

Recipients You can type usernames from your Crucible
instance, to add them to the distribution list.

Send to Review Participants Send the email to all reviewers.

4. Click Next.
5. You can modify both the Subject and Message parts of the email if required.
6. Click Send when you are ready. The 'Status' page confirms that your email has been sent.
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Screenshot 1: The Email Review option in Crucible

2 Eitreien © surmanze [EIEER]

@ Create Blank Review

Download Review as Text

Summarize

Ahandon

kevboard Shortcuts

Screenshot 2: The 'Recipients’ Screen in Crucible

Email Review Comments

o Specify recipients

Recipients

Specify the people who should receive the comments of this review. You can specify a list of comma separated email
addresses andfor specify one or more Crucible users.

To: |

Recipients:

[ Send To Review FParticipants

Screenshot 3: The 'Message' Screen in Crucible
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Email Review Comments

@ Wessage details
Message Details

This is the message as itwill be sent. You can modify both the message content, as well as the subject of the email
before sending it

Subject: [TEST-27] test: All Comments

Message: Subject: [TEST-27] Review: test L
This iz a list of all commwents for TE3T-27.
Review Summary: No swanary
ID: TEST-27 https://extranet.atlassian.cow/crucible/cru/TEST-27
Title: test —

Statement of Objectives:
documentation testing

State: Review

Author: Rosgie Jameson —

Moderator: Rosie Jamweson ~
- v

Cancel ] [ Previous ] I'SEI’\d‘I

Screenshot 4: The Email Confirmation Screen in Crucible

Email Review Comments

@ Status

Message Sent Successfully
Mail sent successfully

Cancel ] [ Previous ] IEE\nsegl

Using JIRA Integration in Crucible Reviews
This page describes ways that you can use JIRA integration with Crucible reviews.

On this page:

1. Create a JIRA issue for your review
2. Create your review and link it to a JIRA issue

3. Comment, or flag a defect, on the review
4, Create a JIRA issue from a comment

O Before you begin, both your Crucible and JIRA instances must be configured to use make use of these JIRA
integration features. The Crucible project requires a linked JIRA project before issues can be linked to reviews.

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Read more.
1. Create a JIRA issue for your review

To use JIRA integration, you must begin with a JIRA issue that you will use as the parent issue for the review.
Crucible will create and resolve sub-tasks belonging to this parent issue. Once your parent issue is created,

make a note of its issue key, e.g. FE- 1968.

2. Create your review and link it to a JIRA issue
When creating, or editing, your review, Crucible will suggest a JIRA issue that can be linked to the review, if a
JIRA issue key is found in the review title. You can:

® click the suggested JIRA issue key, to link it to the review
® delete the suggested JIRA issue, and then
® specify a different issue key and click Link to save it.

Screenshot: Selecting a JIRA issue when creating a review

Edit Review Details CR-FE-6139

Project: CR-FE

Title: CRUC-5879: Set default due due to duration rounded to nearest half hour instead of exact duration fror

Author: Adam Ahmed

Reviewers: l:l Suggest reviewers... & Allow anyone to join
m Seb Ruiz

. Tim Pettersen

Obijectives: | d3484b 12205343745 : CRUC-5879: Set default due due to duration rounded to nearest half hour instead of exact
«duration from now. This matches the Ul options and avoids random due date changes when editing details and dumb-looking due dates
showing up in the Ul (‘Due at 3:14:15 tomorrow' looks dumb)

Due Date: 07/09/2011 12:00 AM
Linked Reviaa | Link |
Linked Issue: @ CRUC-5879 - Review due and reminder dates that change by < second are tracked

| Add Content | | Done |

3. Comment, or flag a defect, on the review

You can add a comment to the review. Check Defect when creating the comment to flag this as a defect.

General Comments

Paul Watson says:

The title of the target page for the help link should be "Setting the REST AP token™
— This Is it: hitos:iconfluence atlassian.com/displav/FISHEYE/Setting+the +REST+AP +ioken
Reply Edit Delete Create Issue

Qo |

This is my new comment. \

0 1 Dol o) Ckep 2 s ) (oscrs )

4. Create a JIRA issue from a comment

Click Create Issue in a comment to create a JIRA issue. Crucible suggests the JIRA instance, project and issue
type, but you can modify these. This requires JIRA 5.0, or later, and is disabled if Crucible is integrated with an

earlier version of JIRA.
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Create issue

JIRA Project* FishEye Crucible Development ?

JIRA |ssue Type* | Bug ?

*
Summary” | The title of the target page for the he

Description |The title of the target page for the help link should be "Setting the REST API token”
This is it:
https://confluence.atlassian.com/display/FISHEYE/Setting+the+REST+API+token

s b Y -
Create Cance

Using the Review History Dialog

The Review History dialog shows a chronological list of interactions within a review. You can see rich information
about those interactions and control their display. You can sort the information by date, actor, or action.

To open the Review History dialog:

1. Open areview in Crucible.
2. Click 'Tools' > 'Review History' at the toolbar at the top right corner of the screen.
3. The Review History dialog opens.

This information can also be displayed in the new timeline mode, a graphical visualisation that shows events on
a horizontal graph over time (click the 'Timeline' tab at the top of the dialog to switch from 'Details' to timeline
view). Click and drag inside the timeline view to scroll the graph left and right. You can also click on the section
showing months to scroll over a greater time scale.

Additionally, you can get access to the entire review history through the 'CSV export' link in the upper right hand
corner, allowing for easy data import into a spreadsheet or other application.

Screenshot: The Crucible Review History Dialog
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History of Review CR-FE-3347

Details = Timeline

Dates  User %
0222 MNick Pellow

0222 MNick Pellow

Hick Pellow

Hick Pellow

3 Nick Pellow

Nick Pellow

Hick Pellow

Hick Pellow

Action

crealed the review

added files to the review

changed the review's description

changed the review’s due date

added a reviewar
added a reviewer
added a reviewer

added a comment

% Details

trunk/build xmi 57860 58036

trunk/srol micenquafisheyeiwebffiters/RestFilter java 39885 58036

i Export as CSV

trunkisrofavalcomicenguaffisheyetweblutiWrappedRequest java 30423 58036
& ome v Test java 27654 58036

From:
review this code

(1158036
CRUC-1220: allow the format parameter 1o specify the result format of
anyREST requests

NONE: added -Dgwic skip property for faster devspeed

To:
review this code

[1)58038:

CRUC-1220: allow the format parameter 1o specify the result format of
any REST requests

NONE" added -Dgwic skip property for faster devspeed

[1] hitps Hiextranet allassian.comicrucibleichangelogiF E/7cs =58036

From:
2010-04-13T07:22.26. 012

Tom Davies
Mall Quail
Erikvan Zijst
Comment 29547
First cut of CRUC-1220 - go nuts, tear it to shreds ¢lc elc

m

[1] hittps Wextranet atlassian comicrucible/changelogFE/7cs=58036

To:
2010-04-13T07 22:26.00Z

Screenshot: The Crucible Review History Dialog, Timeline View

History of Review CR-FE-3347

Details  Timeline

[E8] Export as Csv

Under Review
Drat

[ick Pellow changed the review's state

[ ick Pellow added a comment
[ ¥ick Pellow changed the review's description
[ Vick Pellow changed the review's due date
Jvick Pellow added a reviewer
.I\Lk Pellow added areviewer
[ Vick Pellow added a reviewer
[ lick Pellow added files to the review

[ Vick Pellow created the review

Tracking Crucible Review Metrics

Crucible tracks each participant's percentage completion through each review and the total time they have

spent.

JREk van Zijst aaded a comment

To learn about these features, see the following pages:

® Using Progress Tracking

® Using Time Tracking

Using Progress Tracking

This page contains instruction on how to use progress tracking in Crucible.

On this page:

How progress tracking works in Crucible

Viewing the progress tracking totals

How to adjust progress tracking on a review

Adjusting settings for progress tracking

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.
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How progress tracking works in Crucible

As you work your way through the files in a review, Crucible tracks the ones you have viewed. Whenever you
open a file for review, Crucible will automatically mark it as read.

When participating in iterative reviews, progress tracking also takes lines of code and revisions into account.

Viewing the progress tracking totals

The 'Details' view shows a summary of the progress of each participant through the files in the review.
© 1f there is only one file in the review, then the progress tracked will either show 0% or 100%.

Screenshot: Viewing the Progress Tracking Totals

i . Y + - i
;: a = | Lol Prels = W Filler = o) 21 minutes
Details
Participant Role Time Spent Comments Latest Comment
Edwin Dawson Author & Moderator 21 mins i This could resull in 3,000 thistles

3 mins

Reviewer - 88 % completla

lotal £4 mins 1

How to adjust progress tracking on a review

You can mark a file as unread by clicking on its name to view the file's contents. In the source view, you have an
option at the top left of the screen, 'Leave Unread'. If you select that, then the file you are looking at will not be

added to your progress percentage.

Screenshot: Marking a File as Unread

’:‘_‘ Testing Project * TEST-50 & Edit Details © Summarize £ Tools ~
"X/ Essential Review

Under Review for 16 hours Author & Moderator  Revewers
— w 1 L n
TEST-50 AF B £ B:= - = alg - W B T RE

| fguessing game.html Addec
3 g .: ll? j.l.rl.l.—;‘ -.:I"'“"' : I .

27 quessing_game.html b

3
o
b

3

Adjusting settings for progress tracking

Progress tracking is a configurable user preference that can be changed in the 'User Settings' menu, in the 'Re
views' sub-section. 'Auto-mark files as read' is on by default. When 'Auto-mark files as read' is set to '‘No’,

marking files as read or unread is left to the user to manually manage.

Screenshot: Adjusting the Progress Tracking User Settings
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Settings

Dhsplay Seltngs
Review Page View

Revdew page e (= O filg wisible O AN fles visible

Auto-mark files as ‘read’

7 Mo :;_: mirmediale

2 :;; mmediale ) Batch
I y O No & mmediate C
: O nNo & mmediate O Bate
CNo & immediate O
Cr Mo O immediate
®Yes o

O Yes & Ho

{emails sent o edawson@atiassian.com)

Further reading

You may also want to learn about Crucible's Time Tracking feature.

Using Time Tracking

This page contains instruction on how to use time tracking in Crucible.

On this page:
® How time tracking works in Crucible
® How to adjust the time tracked on a review
® Viewing the time tracking totals
® JIRA integration
[ ]

Further readin

How time tracking works in Crucible

Crucible will automatically track the time you spend in a Crucible review. When you open a file for review, a
counter in the Review Details panel starts. The time is added to your total when you leave the review screen.

Screenshot: Crucible Time Tracking

®+M  Dashboard  Source  Projects  People  Reviews
Testing Project » TEST-47
Theopolis Thistler Review

Under Review for a few seconds Author & Moderator Reviewers
&
TEST-47 (@] ~  Prefsv V7 Filter
Details Details

How to adjust the time tracked on a review

You can click and type in the time tracking control to adjust the time you have spent during the session.

Viewing the time tracking totals
The 'Details' view shows a summary of the progress and time tracked on each file.

Screenshot: Crucible Tracking Totals
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O B3 EHBl~ pPetse  Vriters & 20 mines
Details
Participant Role Time Spent  Comments Latest Comment
I_ Edwin Dawson Author & Moderalor 21 mins 1 This could resultin 3,000 thistles
. Geoff Crain Reviewer - 88 % complela
Total 24 mins Bl

JIRA integration

Using Crucible when integrated with JIRA, you can update time tracking from the following locations:

® The confirmation dialog for a reviewer completing a review,
®* The confirmation dialog on closing a review,
® The regular toolbar location in Crucible.

Screenshot: JIRA Time Tracking Integration

) Om Mark all comments az read
Submit time to JIRA
Time Spent | 15m il
p Comment Review by Edwin Dawsor|
Submit
et — . N

Further reading

You may also want to learn about Crucible's Progress Tracking feature.

Summarising and Closing the Review
Summarize is an optional step before closing a review.

To enable or disable the Summarize step, you will have to configure the permission in your Permission Scheme.
Crucible ships with two permission schemes:

® 'Agile’ - the summarize step is disabled for all users
® 'Default' - the summarize step is enabled for the moderator

You can choose to either summarize a review or close a review at any time, given that your Permission
Scheme allows it. You can skip the summarize step by directly clicking the 'Close' button.

© Normally, we recommend that you wait for all reviewers to complete their reviews.
The reviews that the reviewers have completed will be in your Ready to Close menu on the Dashboard.

To summarize a review,

® Click Summarize at the right of the screen.
® Optionally enter a summary of the review.

® |f you have no further comments to add, click Close Review; otherwise, click Continue Without Closing.

Screenshot: 'Summarize' button

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.
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TEST-27 test .

Under Review Author & Moderator: Rosie Jameson f Edit Review KTt £ Tools ~

&
Under Review for: 102 minutes Display Preferences ~ 57 Filter =
Comments: 1 . A .
) Review Objectives
Reviewers: . -
documentation testing
Geoff Crain
@

The above review is not yet complete

We can see that Geoff Crain has still not finished reviewing, because there is no green tick
next to his name.

On clicking Summarize, the user may be prompted to confirm the action if there are incomplete reviews or draft
comments in the review.

The requests for confirmation are warnings only

The review can still be summarized and closed.

Once the review is in the 'Summarize' state, the moderator can optionally add a review summary, i.e. describe
the outcomes/tasks/etc.

Screenshot: Summarize Review

Summarize Review

Summarize the review outcomes (optional)
Testing successful. Thanks for your time, everyone.

[ Continue 'without Clozing ] [ Cloze Review

Screenshot: Review Closed
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Review Closed

Review Summary
Testing successful. Thanks for your time, everyone.

Reviews requiring your attention:

Task Review Owner Due
Review CR-FE-2170 L Y 03 Jul
[ D ashboard ] [ Cloze ]

The summary is sent to all participants and displayed at the top of the closed review.

® Reviews in the 'Review' or 'Summarize' state can be closed.
® Reviews in the 'Summarize' or 'Closed' state can be re-opened. Re-opening changes the review's state
back to 'Under Review', allowing all participants to add comments.

Re-opening a review is not the recommended way to 're-review'. You should create a new
review with the reworked changes and link it to its parent review (create a hyperlink back to
the original review in the new Review's Objectives field).

Note that you need the 'Summarize', 'Close’ or 'Re-Open’ permission to summarize, close or re-open a review.

Transitioning JIRA issues

For Crucible reviews that are linked to JIRA issues, you can now advance their JIRA workflow from within
Crucible.

In the Close Review dialog, Crucible will now display any available workflow transitions for the linked issue.

Transitioning a linked issue

To transition a linked issue:

® In the Review Summary screen, choose Access: Review > (Summarize or Close) > Close Review. The
possible transitions appear as buttons below the transition.
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CR-FE-6163 Closed

Linked issue

Issue:  [§] FECRU-1401 — Add a review action in the Ul to send manual reminder...

Status: 9 To be reviewed
Transition issue: Close

Log work: (¥ Submit 43m

You're done!

You have no outstanding reviews to attend to right now.

Dashboard Close

Screenshot above: Transitioning a JIRA issue in Crucible.

Notes

* JIRA administrators can activate or deactivate JIRA issue transitions (the workflow) from the JIRA
administration interface.

® Only the transitions accessible by the user are displayed.

® The list of available transitions only appears if the user has visibility to any available workflow transitions.

© This feature does not support editing fields on the issue, only setting the resolution field if required by the
transition.

Related Links

® Using JIRA Integration in Crucible Reviews
* JIRA integration in Crucible

Moving a Review to Another Project
You can move reviews between projects once they have been created.

To move a review between projects:

1. Open the review. Click the 'Edit Review' button at the top of the screen.

2. The 'Edit Review' window will open, allowing you to change various aspects of the review.

3. Under 'Project’ click the drop-down menu. This will allow you to select a new parent project for the
review.

4. Click the 'Done' button at the bottom of the screen.

Screenshot: Changing a Review's Parent Project

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Edit Review

Review Details Title:

Rewiew Content ‘ Atast review
Change Sets

Project: Moderator:
Files | Testing Project jl Rosie Jameson

Search

I~ Start typing the reviewsrs name fhen
auggeshons press enter fo seleod.

Geaff Crain
O miiow anyone to join

Get Reviewer SUWH stions:

I Suggest Beviewers i

Patches

Uploads

Due Date: ) Linked JIRA |ssue:

lz5ue key:
Linked Review

Reewiew Key: |
Statement of Objectives:

Teat moving m review to another project.

Deleting a review

To delete a review you must first abandon the review. To do that, follow the instructions below.

/L Deleted reviews cannot be retrieved.

Author:
| Rosie Jamesan

Related page:

® Deleting hung reviews manually

To abandon and then delete a review:

1. Open the review.
Choose Tools > Abandon.

arwbd

Screenshot: Deleting a review in Crucible

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.

Now, on the Crucible dashboard, click My Abandoned Reviews in the left-hand navigation bar.
In the list of abandoned reviews, click the name of the review you wish to remove.
Once the review details are displaying, choose Tools > Delete. The review will be instantly deleted.
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f Edit Review @ Fecover DeaM

e
Display Preferences = 57 Filter =

Review Objectives
Testing the deletion of & review

W

L) Review Comments
There are no files in this review

@ Create Blank Review
Diwenload Review as Text
Email Review

Recover Dead Review

keyboard Shortcuts

Defining your Workflow

This document describes several forms of Crucible Workflow in detail. Depending on the size of your team, there
are four different ways that a development team could use Crucible for code reviews. Choose the workflow

which suits your team.

Lightweight Code Commenting with Crucible (individual)
1.
2.
3.

Lightweight Code Commenting with Crucible (individual)

One-to-One Reviews (Agile Pair)

One-to-Many Reviews Without a Moderator (Agile Team)

Formal Group Reviews (CMM Team)

Author commits new work.

Author creates the review, and adds comments using the easy web interface.

Author summarizes and closes the review, saving the code comments in Crucible's database, which is

stored outside the repository.

Diagram: Workflow for Lightweight Code Commenting

Authaor agdusthn?r:m
{:rezm_as ." comments
the review to review

Authaor

closes
review

One-to-One Reviews (Agile Pair)

1.

Nogk~wDd
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Author creates the review.

Author invites reviewer to take part in the review.
Reviewer creates comments on the code.
Author responds to reviewer comments.
Follow-up comments are made if necessary.
Reviewer finishes own review process.

Author summarizes and closes the review.

Diagram: Workflow for One-to-One Reviews
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Author Reviewer(s)
creates ——P  comment ——P>

the review on the code

Author
responds
to the
comments

Author
closes

—P e

review

For more information on one-to-one reviews, see The Crucible workflow. The workflow process in Crucible is

covered in detail within this document.

One-to-Many Reviews Without a Moderator (Agile Team)
1. Author creates the review.

Author invites reviewers to take part in the review.

Reviewers make comments on the code.

Reviewers complete their reviews.
Author summarizes and closes the review.

o0k wnN

Diagram: Workflow for One-to-Many Reviews

Author responds to reviewer comments, follow-up comments are made if necessary.

Author Reviewer(s)
creates —." comment —b'
the review on the code

Author
responds
to the

comments

Author
closes

—» e

review

Formal Group Reviews (CMM Team)

1. Author creates the review.

Moderator invites reviewers to take part the review.
Reviewers make comments on the code.

Author responds to reviewer comments.

Follow-up comments are made if necessary.

Each discussion point is settled by the Moderator.
Moderator summarizes and closes the review.

Noogk~wbd

Diagram: Workflow for Formal Group Reviews

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.

122


http://creativecommons.org/licenses/by/2.5/au/
https://confluence.atlassian.com/display/CRUCIBLE/authors+in+Crucible
https://confluence.atlassian.com/display/CRUCIBLE/reviewer
https://confluence.atlassian.com/display/CRUCIBLE/authors+in+Crucible
https://confluence.atlassian.com/display/CRUCIBLE/moderator
https://confluence.atlassian.com/display/CRUCIBLE/reviewer

User Guide for Crucible 2.10 123

Moderator
invites

Moderator

Author Reviewers. Author Discussion

i summarizes

creates —_— . ——p| comment » responds to — points are —_—
the review [RRiD on the code comments settled by and closes
the review Moderator the review

To see a simple example of how to use Crucible with two people, see The Crucible workflow.

Viewing Your Favourites

This page contains instructions on how to view, rename and remove your existing favourites in Crucible. You
can select code reviews, changesets, files, people and repositories as favourites in Crucible. This allows you to
personalise the information that you see in your activity stream.

See Using Favourites for instructions on how to add new favourites.

On this page:

® Viewing your Existing Favourites
® Renaming a Favourite
® Removing a Favourite

Viewing your Existing Favourites

To view your favourites,

1. Click the favourites icon ( ~ ) in the header.
The code reviews, changesets, files, people and repositories that you have selected will be
displayed in a list on the dashboard (see screenshot).

2. Click the favourites icon ( ) next to a favourite to show the dialogue for renaming (i.e.

changing the 'Label’) the favourite or removing the favourite. See Using Favourites for more
information.

Tip: You can add favourites wherever you see star icons next to code reviews, changesets, files,
people and repositories, not just on this screen.

Screenshot: Viewing favourites
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You have 13 favourites.

FE (SVN repository)

Clover Eclipse Plugin

Confluence Hosted

Clover IDEA plugin

JIRA FishEye Plugin

Jira Studio

LinkChecker

A Good Marketing ploy

Build Manitor

Default Project

Clover

Testing Project

FishEye

Renaming a Favourite
To rename a favourite,

1. Click the favourites icon ( ~ ) in the header.
The code reviews, changesets, files, people and repositories that you have selected will be
displayed in a list on the dashboard (see screenshot).

2. Click the favourites icon ( - ) next to a favourite to show the 'Update favourite' dialogue (see
screenshot below).

3. Enter the new name for the favourite in the 'Name' field and click the 'Save label' button. The
favourite will be renamed on the dashboard.

Screenshot: The 'Update favourite' dialogue

JIRA FishEye Plugin
Update favourite

Name

Describe your favourite

I Remove ‘ I Save label

Removing a Favourite

To view your favourites,
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1. Click the favourites icon ( ~ ) in the header.
The code reviews, changesets, files, people and repositories that you have selected will be
displayed in a list on the dashboard (see screenshot).

2. Click the favourites icon ( - ) next to a favourite to show the 'Update favourite' dialogue (see
screenshot below).

3. Click the 'Remove' button. The code review, changeset, file, person or repository will be
removed as your favourite (the icon will be greyed out) and will not display the next time you
view your list of favourites.

Tip: You can remove favourites wherever you see star icons next to code reviews, changesets,
files, people and repositories, not just on this screen, not just on this screen.

Screenshot: The 'Update favourite' dialogue

JIRA FishEye Plugin
Update favourite

Name

Describe your favourite

| Remove || Save label

Using Favourites

This page contains instructions on adding favourites in Crucible. You can select code reviews, changesets,
files, people and repositories to be added to your favourites. This allows you to personalise the information that
you see in your activity stream. We suggest you select items that you are currently working on as favourites, to
create a more relevant personalised view.

See Viewing Your Favourites for instructions on how to view your existing list of favourites and how to rename
and remove favourites.

On this page:

Adding a Review to Your Favourites

Adding a Review Comment Thread to Your Favourites
Adding a Project to Your Favourites

Adding a Person to Your Favourites

Adding a Changeset to Your Favourites

Adding a File or Folder to Your Favourites

Adding a Repository to Your Favourites

Adding a Review to Your Favourites

To add a review to your favourites, hold the mouse cursor over the review name when it appears in a menu
screen. The Review Hover menu appears. At the top right of the Review Hover menu, click the small grey cog
icon that indicates the 'Tools' menu. The Tools menu opens. In the Tools menu, click 'Add Star'. This will add it
to your favourites.

Screenshot: Adding a Review To Your Favourites
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)
/ .."l.

Micolas Venegas
() commented on CR-FE-2121

Main fixes: CRUC-1616: P
. : period and r
- sensible polling inactivity...

- reset inactivlity State Re

- stop polling wh Author &
Moderator: Y

Download Review as Text
Email Review
Jaoin Review

@ started review CR

CRUC-1616: Pro payiew Details

Description: 38809: CRUC-1616: Proper
polling period and resetting of
inactivity period.

@& summarized and Froject: FishEye

Created: 23:01

Matt Quail

Mo summary. _
Reviewers: W Sebastian Ruiz
_ ) R Erik van zijst
Erik van Zijst B Geoff Crain
“ W changedthe statL B Peter McNeil

() commented on CI%—I—I:—:J‘I‘IH

Adding a Review Comment Thread to Your Favourites

To add a review comment thread to your favourites, click the link 'Add Star' next to the grey star icon at the
bottom of the first comment of the thread. From then on, new comments will be shown in your favourites activity

stream.

Screenshot: Adding a Review Comment Thread to Your Favourites

3880

&
Display Preferences > 7 Filter =

Review Objectives

© &

C.) Review Comments

9. CRUC-1616: Proper polling period and resetting of inactivity period.

+ ¥

Hicolas Venegas says:

Main fixes:

- sensible polling periods and backoff

- reset inactivlity timer when youre actively using the review
- stop polling when window loses focus

Add Star

Adding a Project to Your Favourites

To add a project to your favourites, click the 'Projects' tab. The Projects view appears. Here, simply click the
grey star icon that appears next to the desired project name. The star icon will turn yellow, showing that it is

selected as a favourite.
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Screenshot: Adding a Project to your Favourites

R l%‘ Projects

Project name

Default Project
Confluence Hosted
Jira Studio
FishEye

Clover

Clover IDEA plugin
Testing Project

Clover Eclipse Plugin

Latest Activity
= on 24 Jun 2009
@ on 25 Feb 2000

@ on 22 apr2008

¥ on 24 Jun 2009

Bl on 24 Jun 2009
= on 24 Jun 2000
€. on 23 Jun 2009

Bl on 24 Jun 2009

Adding a Person to Your Favourites

To add a person to your favourites, simply hold the mouse cursor over their username wherever it appears. The
User Hover menu will appear. In the User Hover menu, click 'Follow'. This will add the person to your favourites.

Screenshot: Adding a Person to Your Favourites

t Erik van Zijst
Bl Erik van Zijst

7 erik@atlassian.com

*  Follow Maore =

- Sebastian Ruiz

() repliedto ' Micolas Venegas in CR-FE-2082

Adding a Changeset to Your Favourites

To add a changeset to your favourites, firstly open the changeset desired from the 'Source' tab. Once the
changeset is open in Crucible, simply click the grey star icon that appears next to its name. The name appears

in the breadcrumb links at the top of the screen.

Screenshot: Adding a Changeset to Your Favourites

Revisions Activity Users Reports Source

om * atlassian * crucible * activity * review * CoalescingActivityltemProviderBase. java

<>| CoalescingActivityltemProviderBase.java
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Adding a File or Folder to Your Favourites

To add a file to your favourites, firstly open the file or folder desired, from the 'Source' tab. Once the file or folder
is open in Crucible, simply click the grey star icon that appears next to its name. The name appears in the
breadcrumb links at the top of the screen.

Screenshot: Adding a File or Folder to Your Favourites

com * atlassian * crucible » activity * review

* =7 review

Adding a Repository to Your Favourites

Adding a repository to your favourites (requires FishEye), click the 'Source' tab. The the 'Source' view appears.
Here, simply click the grey star icon that appears next to the name of the desired repository. The star icon will
turn yellow, showing that it is selected.

Screenshot: Adding a Repository to Your Favourites

Repository State Commit History (12 Months)

FE Running

cLov g b Al Soobl bl

Using Keyboard Shortcuts in Crucible

Crucible provides a number of keyboard shortcuts, allowing you to quickly carry out certain actions without the
mouse. Keyboard shortcuts are available for most of the commonly-used functions in Crucible.

To see a list of available shortcuts, firstly navigate to a review in Crucible. Now open the 'Tools' drop-down
menu at the top right corner of the screen, and select the 'Keyboard Shortcuts' option.

See the tables below for full details:

General Shortcuts

Key Function

? Opens reference list of keyboard shortcuts.

escape Closes reference list of keyboard shortcuts.

alt Hold down then click and drag to select source line
contents.

shift + f Toggle full screen review mode.

Custom Navigation
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Key Function

, (Comma) Go to the previous element, which can be a
file, comment or defect, depending on your current
context.

(Period) Go to the next element, which can be a file,
comment or defect, depending on your current

context.
Comment Navigation Shortcuts
Key Function
n Go to next review comment.
p Go to previous review comment.
shift + p Go to first review comment.
shift + n Go to last review comment.

I Go to next thread (skips replies).

h Go to previous thread (skips replies).
] Go to next unread comment.

[ Go to previous unread comment.

r Reply to a comment.

m Toggle comment read/unread status.

File Navigation Shortcuts

Key Function

i Go to next file.

k Go to previous file.

shift + k Go to first file.

shift + j Go to last file.

u Go to next unreviewed file.

i Go to previous unreviewed file.

y Set file reviewed and go to next unreviewed file.
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shift +y Toggle file reviewed/unreviewed status.
e Expand current file.

c Collapse current file.

shift + e Expand all files.

shift + ¢ Collapse all files.

Using RSS Feeds in Crucible

Subscribing to an RSS Feed
In Crucible, all pages with an activity stream and any page which has a list of reviews will have an RSS option.

To access the RSS feed for a page, open the 'Tools' drop-down menu at the top right corner of the screen, then
click the 'RsS' & option.

This will open a page with the RSS feed displayed; you can also paste the URL from that page into your RSS
reader of choice.

Using Wiki Markup in Crucible
Crucible supports Wiki Markup text formatting in comments and review descriptions.
The text markup notation on this page is a reference showing the available formatting commands.

@ When using FishEye, you can also render Wiki Markup in commit messages.

Headings

Notation Description

h1.Biggest heading Turns text into a heading at size 1.
Biggest Text

h2.Bigger heading Turns text into a heading at size 2.
Bigger heading

h3.Big heading Turns text into a heading at size 3.
Big heading

h4.Normal heading Turns text into a heading at size 4.

Normal heading
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h5.Small heading

h6.Smallest heading

Text Effects

Turns text into a heading at size 5.

Small heading

Turns text into a heading at size 6.

Smallest heading

Text effects are used to change the formatting of words and sentences.

Notation

*bold*

_italic_

+underline+

??citation??

-strikethrough-

Asuperscript®

~subscript~

{{ronospaced}}

bg. Block Quote

{quote}
here is quoteable
content to be quoted

{quote}

{color:red}
look ma, red text!
{color}

Description

Makes text appear bold.
Makes text appear in italics.
Makes text appear underlined.

Makes text appear in citation form.

Makes text appear struek-through.
Makes text appear in SUPerscript

Makes text appear in subscript:

Placing double curly-brackets around text makes it
appear nonospaced.

To make an entire paragraph into a block quotation,
place "bg. " before it.

Example:

| Some block quoted text

Quote a block of text that's longer than one
paragraph.

Example:

here is quoteable
content to be quoted

Changes the color of a block of text.

Example: look ma, red text!
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Text Breaks

Wiki Markup allows you to insert breaks or different kinds of hyphens and dashes.

Notation

(empty line)

\\

Links

Creating links is easy with Wiki Markup.

Notation

[Crucible Review CR-FE-100|CR-FE-100]

[Atlassian Crucible|http://atlassian.com]

Description
Produces a new paragraph

Creates a line break.

Creates a horizontal ruler.

Produces em dash — symbol.

Produces en dash — symbol.

Description

Creates a link to a Crucible review or FishEye artifact
using the internal key reference for the item.

Creates a link to an external resource, special
characters that come after the URL and are not part
of it must be separated with a space. External links
are denoted with an arrow icon.

Examples:

® http://www.atlassian.com/crucible

® Atlassian Crucible
Note: The square brackets [, ], around external
links are optional in the case you do not want to
use any alternate text for the link (i.e. just display
the raw URL).
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[mailto:mail@example.com] Creates a link to an email address.
Example:
mail@example.com

[file:/llc:templ/foo.txt] Creates a download link to a file on your computer or

[file:/liz:/filelon/network/share.txt] on a network share that you have mapped to a drive.
To access the file, you must right click on the link and
choose "Save Target As".

{anchor:anchorname} Creates a bookmark anchor inside the page. You can
then create links directly to that anchor. So a link like
this: [My Page#here] will link to wherever in "My
Page" there is an {anchor:here} macro, and the link
[#there] will link to wherever in the current page there
is an {anchor:there} macro.

Lists

Lists allow you to present information as a series of ordered items. Use asterisks * for bulleted lists and hash
symbols # for numbered lists.

Notation Description

* A bulleted list Examples:
* Second item

** indented item 1
** indented item 2

® A bulleted list
® Second item
®* indented item 1

# A numbered list ® indented item 2

# Second item 1. A numbered list
## indented item 1 2. Second item
## indented item 2 a. indented item 1

b. indented item 2

Images
Images can be referenced from remote sources only.

Notation Description
Ihttp://www.host.com/image.gif! The image will be displayed from the remote source.

Ihttp://www.host.com/image.giflalign=right, vspace=4! For any image, you can also specify attributes of the
image tag as a comma separated list of name=value
pairs as shown in this example.

Tables
Tables allow you to organise content in a rows and columns, with a header row if required.

Notation Description

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

User Guide for Crucible 2.10

||heading 1||heading 2||heading 3|| Makes a table. Use double bars for a table heading
|col Aljcol A2|col A3| row.
|col B1|col B2|col B3|

The code above produces a table that looks like this:

heading 1 heading 2 heading 3
col Al col A2 col A3
col B1 col B2 col B3

Advanced Formatting

This section covers panels, code windows and showing plain text with no formatting.

Notation Description

{noformat} Makes a preformatted block of text with no syntax
highlighting. All the optional parameters of the
{noformat} macro are valid for the {panel} macro as

well.
Example:
This is a no-formatted piece
of text,
so *no* formatting_ is done
her e.
{panel} Embraces a block of text within a fully customizable
panel. The optional parameters you can define are as
follows.

® title: Title of the panel

® borderStyle: The style of the border this panel uses
(solid, dashed and other valid CSS border styles)

® borderColor: The color of the border this panel
uses

® borderWidth: The width of the border this panel
uses

® bgColor: The background color of this panel

¢ titleBGColor: The background color of the title
section of this panel
Examples:

Some text in a basic panel

My Title

Some text with a title
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{code}code goes here{code} The code macro displays a preformatted block for
showing code with syntax highlighting. All the optional

{code:title=Bar.java|borderStyle=solid} parameters of the {panel} macro are valid for {code}.

/l Some comments here The default language is Java but you can specify

public String getFoo() JavaScript, ActionScript, XML or SQL.

{

return foo; Examples:

}

{code} Java with a title bar:

{code:xml} i

<test> Bar.java

<another tag="attribute"/>

/1l Some comments here
<[test> . .

public String getFoo()
{code} {
return foo;

}

A basic display with XML code:

..............................................................................

<t est>
<anot her tag="attribute"/>
</test>

Miscellaneous Markup Features

Emoticons and often-used images can be easily embedded with the following Wiki Markup Syntax:

Notation Description

\X Escape special character X (i.e. {)

D), i( Graphical emoticons (smileys): &/, (=) .

Notati ) ( P :D ) () (n) () 0] (x) 0]
on

Image = - = = > I I i ]

Notatio  (+) ¢ ) (on) (off) ) (" (*9) (*b) y)
n

Image & @ (2] ) ; * * *

Using gadgets in Crucible

This page explains how to add a Crucible gadget to a JIRA dashboard. The process is similar for adding a
gadget to a Confluence page.
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On this page:

Overview of Crucible gadgets
1. Add JIRA to FishEye as an OAuth consumer
2. Add the Crucible gadget to JIRA's Gadget Directory

3. Add the Crucible gadget to a JIRA dashboard

Overview of Crucible gadgets

As of the release of Crucible 2.3, you can display Crucible data in other Atlassian applications, such as JIRA and
Confluence, by using Crucible gadgets.

Crucible bundles the following gadgets by default:

Gadget Name Description and Gadget URL Screenshot

Hassle Review Blockers This gadget shows you who you Crucible: Hassle Review Blockers

are still waiting on; in other words,

which reviewers haven't completed = reviewer 1D Name

your reviews. B CR-1 FE-1234:

The URL for this gadget is: H CR-1 FE-1234-
CR-4 FE-4567:

http:// HOSTNAME: 8
060/ rest/ gadget s/
1.0/ g/ com at| assi
an. fecru. fecru-ga
dget s- pl ugi n: over
dueRevi ews/ gadget
s/ hassl e. xm

Where HOSTNAME: 8060 is the
hostname of your Crucible
instance.

Created by Atlassian in 2012. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

User Guide for Crucible 2.10

Overdue Reviews

Review Inbox

This gadget shows you reviews
that are yet to be completed in the
project, across all authors. This is

useful for managers or team leads.

The URL for this gadget is:

...............................................

htt p: // HOSTNAME: 8
060/ rest/ gadget s/
1.0/ g/ com at| assi
an. fecru. fecru-ga
dget s- pl ugi n: over
dueRevi ews/ gadget
s/ over dueRevi ews.
xm

Where HOSTNAME: 8060 is the
hostname of your Crucible
instance.

This gadget is a list of Crucible
to-do items including reviews to
do, comments to read or reviews
to summarise.

The URL for this gadget is:

...............................................

htt p: // HOSTNAME: 8
060/ rest/ gadget s/
1.0/ g/ com at| assi
an. fecru. fecru-ga
dget s- pl ugi n: over
dueRevi ews/ gadget
s/t odo. xm

Where HOSTNAME: 8060 is the
hostname of your Crucible
instance.

Crucible; Overdue reviews in All Pro|

I Hame
CR-3 | FE-3456: Make stuff nicer

CH-4 FE-4567: Disentangle states

Crucible: Review Inbox

state [n] Hame

Summarize CR-3 FE-3456:
Respond CR-1 FE-1234:
Review CR-2 FE-2345:
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Review Coverage

This gadget shows content from
the innovative Review Coverage
report, letting you investigate how
much of your codebase has been
under code review.

The URL for this gadget is as
follows:

...............................................

http:// HOSTNAME: 8
060/ r est/ gadget s/

1.0/ g/ com atl assi

an. fisheye.revi ew
-cover age-report/

gadget s/ recent - ch
angeset s. xni

Where HOSTNAME: 8060 is the
hostname of your Crucible
instance.

1. Add JIRA to FishEye as an OAuth consumer

Firstly, you need to set up an application link from FishEye to JIRA:

Changeset Review Coverage

Past 7 days Full Report

FE/
[ user
[
.
Y
O @
[
OB
£ 8
OB
e
N
i
O @
09
09

Message
Remove System.out.printl

Avoid NPE in eyeql with nt
MOME: If the 500 page thr
MOME: fix tests

Remove TODO in error my
CRUC-3529: Fix MPE linki
Fix checkstyle
CRUC-3529: Revert RSS
CRUC-3529: Rewrite /sni)
CRUC-3543; fix bug wher
branch for 2.3.x
CRUC-3548: fix Crucible i
CRUC-3445: snippet com
CRUC-3440: review rewol

1. In the FishEye admin area, click Application Links (under 'Global Settings') in the left navigation bar.
2. Click Add Application Link and complete the wizard. Leave the Also create a link checkbox selected.
Choose the These servers fully trust each other option.

Created a two-way link to "Paul's JIRA" using OAuth

Configure Application Links @

Name Application Application URL

¥ PausJRA  JIRA

Incoming Authentication (2

hitp://localhost:8080

Outgeing Authentication (2)

OAuth

2. Add the Crucible gadget to JIRA's Gadget Directory

Actions

=P Add Application Link

Configure | Delete | JIRA Settings

As a JIRA administrator you allow the use of these gadgets by adding them to the Gadget Directory. You'll need
the URL listed in the table above for each gadget that you want to add.

See the JIRA documentation for details on this process.

3. Add the Crucible gadget to a JIRA dashboard

As a JIRA user, you can add gadgets to a JIRA dashboard that you have created.

Once added, the gadget will appear on your JIRA dashboard and display information drawn from Crucible and

FishEye.

You can also add Crucible gadgets to the Confluence dashboard. See the General Gadgets Documentation for

more information.
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Using Review Reminders
Crucible will automatically send reviewers a reminder email one working day before the deadline.

Review authors and moderators can also do the following:

® Send manual reminders to reviewers whose work is still pending.
® Configure preset reminders for reviews that have a deadline.

Reminders are only sent if Crucible's SMTP server is configured. Please see Configuring the SMTP server.

Preset Reminders

When a review has a deadline (due date), Crucible (by default) will send a preset reminder to all of the pending
reviewers, one working day before the deadline.

To edit the timeframe for the reminder, firstly edit the review, then click Remove next to Send Reminder.
Now, set the day for the reminder email to be sent (a number of working days before the deadline).

© The Send Reminder setting is only available if the review has a due date set.

Manual Reminders
Crucible can send manually-initiated reminders to all the reviewers that have not yet completed their reviews.
To do this, click Tools > Notify Pending Reviewers. The reminder message will be sent immediately.

© This capability is only open to those participants who are authorised to summarize the review.
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